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Introduction

General Ledger includes Financial Reporter—a powerful tool that uses Microsoft Excel to read,
manipulate, format, graph, and print general ledger data.

Depending on your purchase agreement, some features described in this guide may not be available
in your product.

The Financial Reporter User's Guide contains all the information you need to design and print financial
statements for your business. It contains the following chapters:

» Chapter 1: Financial Reporter Overview

This chapter provides an overview of Financial Reporter, including some basic concepts, and explains
how Financial Reporter works with Microsoft Excel to extract and print your General Ledger data.

» Chapter 2: Financial Reporter Tutorial

This chapter guides you through the design of a basic financial statement using the G/L Statement
Designer. The lessons will familiarize you with the product before you begin working with specification
files.

» Chapter 3: Designing Financial Statements

This chapter includes detailed information about using the G/L Statement Designer to create custom
financial statements.

» Chapter 4: Printing Financial Statements

This chapter includes information about using the G/L Print Financial Statements screen to print
financial statements.

* Appendix A: Sample Financial Statements

This appendix provides information about the sample specification files included with Sage 300, and
about the financial statements they produce.

» Appendix B: FR Menu Commands
This appendix lists menu commands that appear on the FR menu in the G/L Statement Designer.
» Appendix C: Account Reference Syntax and Examples

This appendix lists syntax and examples for account references you can use in the G/L Statement
Designer to retrieve information from General Ledger.
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* Appendix D: FR Function Reference

This appendix lists the Financial Reporter functions you can use in spreadsheets to retrieve data from
General Ledger, including transaction and optional field information.

» Appendix E: FR Field Reference

This appendix lists the account master fields and transaction fields from which you can retrieve data
using FR functions.

» Appendix F: FAQ and Troubleshooting

Use this appendix to find information on the error messages you may encounter when using Financial
Reporter, as well as some suggestions to resolve the most common types of problems.
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Chapter 1: Financial Reporter Overview

Financial Reporter is a powerful reporting tool that you can use to manipulate, format, graph, and print
general ledger data. You can use Financial Reporter to create financial statements and statement
specifications in Microsoft Excel that display data from Sage 300 General Ledger.

Financial Reporter includes the following screens for working with financial statements:

« G/L Print Financial Statements. You use the G/L Print Financial Statements screen to print
financial statements.

Note: All Sage 300 financial statements are Excel spreadsheet files that contain the functions
required to read general ledger data.

You can print using one of the sample statements that come with General Ledger, or you can use a
custom report specification that you create using the G/L Statement Designer.

For more information about the sample statements that are included with General Ledger, see "Sample
Financial Statements" (page 79).

For instructions on printing financial statements, see "Printing a Financial Statement" (page 71).

» GI/L Statement Designer. The G/L Statement Designer is an add-in program that works with
Microsoft Excel. You use it to create customized statement specifications, and you can use it to
generate the statements.

When you open the Statement Designer from the Financial Reporter folder, and then click Start, Excel
opens with the Financial Reporter functions automatically loaded. These functions let you retrieve and
work with data from your Sage 300 company database.

Note:
The spreadsheet add-in is available only when you start Excel from the Statement Designer screen in

Sage 300.

Microsoft Excel is not included with Sage 300 General Ledger. If you want to use Excel to create
financial statements, you must purchase it separately. (You can install Excel before or after installing
General Ledger.)

For more information, see "G/L Statement Designer" (page 28).

After you create a report using the Statement Designer, you can print it at any time using the Print
Financial Statements screen or using the FR View command from the FR menu in Excel.
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Note: There are some differences when printing a statement using the Print Financial Statements
screen compared with using the Statement Designer. For more information, see "Printing Financial
Statements" (page 70)

Important! You must purchase and install Microsoft Excel separately before you can use the
Statement Designer.

Key Financial Reporter Concepts

Financial Reporter is based on a few concepts:

» Excel Worksheets with Financial Reporter functions. Financial statements are Microsoft Excel
spreadsheets that use special functions to extract data from the Sage 300 company database.

You can place Financial Reporter functions anywhere in a spreadsheet. The spreadsheet program
looks up the General Ledger values when it recalculates the spreadsheet. For information on Financial
Reporter functions, see "Financial Reporter Functions" (page 94).

You can also use any other spreadsheet functions you want to further manipulate that data.

» Financial Statement Specifications. A financial statement specification is a structured description
of a statement you want to produce. Financial Reporter creates a report based on the statement
specification and the options you select when you print or view the final statement.

Statement specifications allow you to assign default functions and formulas to columns of the
spreadsheet, and to specify whether a range of accounts will be expanded to many rows on a final
statement.

Statement specifications make statements easier to create and more flexible, but you do not have to
use them. You can view an account balance just by inserting a formula in a single cell, and then
recalculating the worksheet.

It is our assumption that most of the statements you create will be generated from statement
specifications.

For more information about financial statement specifications, see "About Financial Statement
Specifications" (page 24).

» Flexible Data Selection. Financial Reporter lets you choose and restrict data at print time by
account segment range, account group, fiscal period, and by fiscal set (actual or provisional
amounts).
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Notes:

» When designing statements, keep in mind that a generalized financial statement can be
printed with the actual or provisionally-posted amounts of any particular department or
division. However, the transaction-related commands, FRTRN, FRTRNA, FRTRNDR,
and FRTRNCR, do not handle provisional amounts. If you use these commands, only
actual amounts are included in the report.

« If you include rollup accounts, be sure you designed the rollup group in such a way that
you do not end up with doubled amounts in the report.

» When creating a financial report, you can enter formulas that allow you to drill down to
associated transactions in the resulting report.

Producing Financial Statements

Producing financial statements from General Ledger data involves three broad processes:

1. Designing the chart of accounts.
2. Creating a financial statement specification.

3. Printing the financial statement.

Designing the Chart of Accounts

When you set up the ledger, decide on an account-numbering and classification scheme to suit your
financial reporting needs. A well-designed chart of accounts will simplify the job of designing and
maintaining financial statement specifications.

Important! Make sure that the account segment is the first segment in the account structures you
create. Financial Reporter can select accounts more easily when the account segment is first.

For more information on designing the chart of accounts, see "About Designing Your General Ledger" in
Chapter 1 of the General Ledger User's Guide.

Creating a Financial Statement Specification
A financial statement specification defines the format and contents of a financial statement.

Financial Reporter includes several sample report specifications that you can use to print standard
financial statements.

If you want to create special statements for your company, we suggest that you customize one of these
standard statements.

For an overview and a few short lessons on creating financial statements, see the "Financial
Reporter Tutorial" (page 7).
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For more detailed information on creating specifications, see "Designing Financial Statements" (page 23).

Printing Financial Statements

After creating specifications, use the Print Financial Statements screen to select the specification you
want to print.

To print a statement, you select the report you want to print, select from a variety of print options, and
then click Print. Excel gets the data, prints it, and returns you to the Company Desktop.

For more information about printing financial statements, see "Printing Financial Statements" (page 70).
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Chapter 2: Financial Reporter Tutorial

In this tutorial, you will learn:

1. How to use the Financial Statement Designer to construct financial statements.
2. How specification files generate financial statements.

3. How to use tools such as FR Paste and FR View.

Before you create new statements or modify existing specification files (such as those included with
General Ledger), read and perform the exercises in this tutorial to familiarize yourself with the product.

Note:
¢ The lessons in this tutorial use sample data included with System Manager. For information
about how to install and refresh sample data, see the System Manager help and documentation.

¢ The lessons in this tutorial assume that you are using Microsoft Excel 2007 or later.

About the Statement Designer

You use the Financial Statement Designer to create, edit, and test financial statements and financial
statement specifications. It provides add-in programs that you use in Microsoft Excel to retrieve and
manipulate Sage 300 data.

Note: Financial Reporter relies on the capabilities of Microsoft Excel to create financial statements
using Sage 300 data. For more information about using Excel, refer to the Excel help or
documentation.

The Financial Statement Designer can interpret a "report specification" (a set of instructions for creating a
report) and generate a financial report. When you open the Financial Statement Designer, Sage 300
opens an Excel spreadsheet using a macro that adds Financial Reporter commands and functions.

For more information, see "G/L Statement Designer" (page 28).

About Report Specification Files

A report specification file is a spreadsheet with specific commands and functions that Financial Reporter
uses to produce a financial statement. For example, it can specify the following information:
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+ Datatoinclude in each column of a financial statement.

» Which accounts will be reported in each row or group of rows.

e Print layout for the statement.

Statement specifications are generalized, so the same specification file can be used over and over again
to produce financial statements for different departments and different time periods. For example, a
single specification file can print balance sheets for any department in your company as of the last day of
any fiscal period in your fiscal year. For more information, see "Financial Reporter Overview" (page 3).

Lesson 1: Using Formulas to Retrieve G/L Data

This lesson introduces Statement Designer functions and demonstrates how to construct basic
statements that extract financial data from your general ledger.

Before You Start

1.

Sign in to a sample company database.

Sage 300 includes two sample databases you can use: SAMINC and SAMLTD. SAMINC has a single-
currency general ledger with a US dollar functional currency. SAMLTD has a multicurrency general
ledger with a Canadian dollar functional currency.

a. Open Sage 300.
b. Select SAMINC or SAMLTD.
c. Enter ADMIN in the User ID and Password fields, and then click Open.

Open the Statement Designer.

a. Open General Ledger > Financial Reporter > Statement Designer.

b. On the screen that appears, click Start to open a new Excel spreadsheet.
Turn off spreadsheet recalculation in Excel.

If spreadsheet recalculation is on, Excel will query the Sage 300 database every time you enter a
formula in the worksheet or navigate away from the FR View screen.

a. Click File > Options.
b. On the Formulas tab, in Calculation options, select Manual.

c. Click OK.

Note: To update the worksheet with information from Sage 300, press the F9 key.
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Exercise 1: Adding Basic Account Information

In this exercise, you will enter formulas manually in a spreadsheet to create a basic financial statement
with account numbers, descriptions, and balances.

Tip: To avoid losing your work, click File > Save As, enter a file name, and save the file. Remember to
save your work often as you work through the lessons in this tutorial.

1.

o o A~ W

10.

11.

In cell F1, type
When you press or select another cell, the company name appears in F1.

In cell E3, type

Note: If the content of a cell begins with a letter, the Statement Designer interprets that content as
text. However, if you want to enter a number (such as 1999), you must type , S0 the program
can interpret it correctly.

In cell F3, type
In cell G3, type
Select cells E3, F3, and G3.

bottom border.

In cell E5, type

Note: This is an account number, so you must enter it as a text string so the cell contents can be
inserted in other formulas and interpreted correctly by Financial Reporter.

In cell F5, type

The cell displays the account description for the account listed in cell E5.
In cell G5, type

The cell displays the current balance for the account listed in cell E5.
Press -9 to update the worksheet.

You have now created the beginning of a statement, with the headings for three columns and the
information from one General Ledger account. Each formula you enter retrieves one piece of
information from the General Ledger database. You can save the spreadsheet, and then view updated
information the next time you open it.

In cell E6, type
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12. Select cells F5 and G5, and then click and drag the bottom right corner of the selection border to
copy the contents of F5 and G5 into F6 and G6.

Account Description Balance
1000 Petty cash 0
1100

The Statement Designer updates the copied formulas so they use account 1100 (cell E6) instead of
account 1000 (cell E5).

13. Press F9 to update the information in the copied formulas.

14. Save your work.

The statement now appears as follows:

E F G
Sample Company Inc.

Account Description Balance
1000 Petty cash 1]
1100 Accts receivable, intercompany 259781.86

Exercise 2: Adding Column Totals and Formatting Columns

In this exercise, you will add column totals and format columns to prepare your financial statement for
review and printing.

1. Select cell G7.
2. Onthe Home tab, in the Editing group, click the Autosum X button.
Excel selects cells G5 and G6.

3. Press Enter.

Cell G7 displays the sum of cells G5 and G6.

4. Select cell G7 again.

and then click Top Border.

6. Atthe top of the spreadsheet, click column G to select all cells in that column.
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7. Right-click the column header for column G, and then click Format Cells.
a. Onthe Category list, click Accounting.

b. Accept the default selections for decimal places and currency symbol, or specify different
settings if you prefer.

c. Click OK.

Amounts in column G are formatted as currency, using the decimal places and currency symbol you
specified.

8. Click and drag the edges of column headers to adjust the width of columns as needed to display
information.

9. Save your work.

The statement now displays two lines and the total balance for those lines, with balances formatted as
currency:

E F G
Sample Company Inc.

Account Description Balance

1000 Petty cash 5

1100 Accts receivable, intercompany 5 259,781.86
5 259,781.86

After creating your financial statement

» Continue to experiment with formatting commands by formatting and aligning column labels.

¢ Click File > Print to see a preview of the printed statement.

Lesson 2: Using FR Paste to Insert Formulas

This lesson introduces FR Paste, an extremely useful command that you can use to quickly create
formulas, look up account numbers, or define account selection criteria.

Exercise 1: Applying the FRACCT Function

In this exercise, you will use the FR Paste Function screen and the FRACCT function to search a range
of accounts for words appearing in the account description.

Sage 300 2023 Financial Reporter User's Guide

11



1. Select cell F10.
2. Onthe Add-Ins tab of the Excel ribbon, click the arrow beside FR, and then click FR Paste.
3. Onthe FR Paste Function screen, specify a range of account descriptions to search.

a. Onthe Functions list, click FRACCT.

The syntax for FRACCT (field name, account reference, criteria, formatted) appears to the right
of the Functions list.

b. On the Field Name list, select ACCTDESC(Description).
c. Inthe Account Reference group, select the Account Range option.
d. Specify a range of accounts.

i. Inthe firstfield in the Account Reference group, enter

ii. Inthe second field in the Account Reference group, enter

e. Leave the Formatted option selected.

You have now created a formula that instructs Financial Reporter to scan the descriptions of every
account in the range you specified, and to return any words that are common to all account descriptions
in that range. (In this example, the word that appears in every account description is "Sales.")

The formula to be pasted into the spreadsheet appears below the Functions list.

F !
w FR Paste Function I&J

Functions FRACLCT] field name, account reference, criteria, formatted |

FRACCT
FRAMT Field Mame ACCTDESCIDescrption] ﬂ

FRAMTA,
FROEBIT
FRCREDIT
FRPOST
FRTRM

FE¥EHSH ™ Account Mumber |1|:IEIIJ a

EETHNEH {+ Account Range |'||:|23 @
FRFISCAL

FEESEEE Selection Criteria. . |

Account Reference

v Formatted

<account ref>
Loriteria

Cell $F$10:
FRACCT["ACCTDESC","1000:1023")

M et B ow | M ewt Colurnin |

Paste

| Cloge Help

Pres B ow | Prew Coluran
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Click the Paste button to paste the formula into cell F10.

Click Close to close the FR Paste Function screen.

In the spreadsheet, the word "Sales" appears in cell F10.

Save your work.

Exercise 2: Applying the FRAMT Function

In this exercise, you'll use the FR Paste Function screen to create a formula that uses the FRAMT
function to calculate the net change for the second quarter of the current year so you can view sales for
the quarter.

1.
2.
3.

Select cell F10.

On the Add-Ins tab of the Excel ribbon, click the arrow beside FR, and then click FR Paste.

On the FR Paste Function screen, click the Next Column button.

The cell reference (below the Functions list) changes to

Specify a range of amounts to search.

a.
b.

C.

f.

On the Functions list, click FRAMT.
In the Field Name field, select NET#QTD(Net Quarter # to Date).
On the Fiscal Designator list, select A (for Actual monetary figures).
In the Account Reference group, select the Account Range option.
Specify a range of accounts.

i. Inthe firstfield in the Account Reference group, enter

ii. Inthe second field in the Account Reference group, enter

If any accounts in the range are members of a rollup group and you want to view rolled-up
amounts, select the Use Rolled Up Amounts option.

The formula to be pasted into the spreadsheet appears below the Functions list.
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m FR Paste Function @

Functions FRAMT( field name, account reference, criteria, curmency |

FRACCT
E Field Mame |NET#QTD[Net Quarter # to Date] B el

FRAMTA,

FEE&EHIT Fizcal Designator & - rear -
FRFOST
FRTRM
FRTRMA
FRTRNDR
FRTRMCR
FR
FRFISCAL

FEESEEE Selection Criteria... |

Account Reference

" Account Mumber |'l g Q
* Account Range |1 023 Q,

Currency Options...

<account ref>
ecriterias [~ Uze Rolled Up Amounts

Cell $G310:
FRAMT[MAMETIQTD", M 000:1022"]

Mt Bow | Mext Column |

| Cloze Help

. #

Pres Bow | Pres Colurin

5. Click the Paste button to paste the formula into cell G10.

6. Click Close to close the FR Paste Function screen.

In the spreadsheet, the net quarter to date amount appears in cell G10. (You may need to press 9 to
recalculate.)

7. Save your work, and then close Excel.

Lesson 3: Creating a Financial Report Specification

This lesson introduces the FR Paste Function screen, and demonstrates how to use it to create a
financial report specification and then generate a report that compares current assets to current liabilities
in the sample General Ledger.

Exercise 1: Adding a Comment

Enter a comment to explain the purpose of the report.

1. Inthe Excel spreadsheet you used for the previous two lessons, click File > New > Blank
workbook.

2. Selectcell A1.
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3. Type , and then press

Note: Information in column A preceded by two periods is treated as a comment and does not appear
in financial reports.

Exercise 2: Creating a Default Specification Row

Most financial reports contain the same kind of information in each row of the report. To make it easier to

define statements in Financial Reporter, you can define a default row specification that will be used
throughout the report. The default row specification stays in effect until you define another default row
specification.

In this exercise, you will create a default row specification that will produce a report with two columns:
one containing account descriptions, the other containing the current account balance.

1. On the Formulas tab, in the Formula Auditing group, click the Show Formulas button.

Instead of calculated values, the spreadsheet now displays formulas you enter.

Tip: To toggle between showing formulas and calculated values, press + (the grave accent key,
located to the left of the number 1 key at the top left corner of the keyboard).

2. Incell A2, type

Two backslashes indicate that the spreadsheet row contains default column functions to be used in
subsequent rows.

3. Incell D2, type D, and then press

D instructs Financial Reporter to print the details of each account on a separate row of the spreadsheet.

4. Selectcell E2.
5. Onthe Add-Ins tab of the Excel ribbon, click the arrow beside FR, and then click FR Paste.
6. Onthe FR Paste Function screen, select the account description.

a. Onthe Functions list, select FRACCT.

b. Inthe Field Name field, select ACCTDESC(Description).

c. Click Paste, and then click Close.

Cell E2 displays this formula:
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Note: This formula does not refer to a specific account number. Financial Reporter will add account
references when it uses this default specification to view the report.

7. Select cell F2.
8. On the Add-Ins tab of the Excel ribbon, click the arrow beside FR, and then click FR Paste.
9. On the FR Paste Function screen, select the current period balance.

a. Onthe Functions list, select FRAMT.

b. Inthe Field Name field, select BALP(Balance Current Period).

c. Click Paste, and then click Close.

Cell F2 displays this formula:

You have now created the default specification row.

A B C|D E F
1 ..Thisisashort financial report
2 |\ D =FRACCT("ACCTDESC") =FRAMT("BALP")
3

Exercise 3: Adding Column Headings

To create column headings (or any text that you want in the final report), simply leave cell A of the row
containing the headings blank. This row will appear "as is" on the report.

1. Incell E3, type

In cell F3, type

Select cells E3 and F3.

On the Excel ribbon, on the Home tab, in the Font group, click the Underline button.

Click the column heading for column F to select the column.

S

On the Excel ribbon, on the Home tab, format the selected cells.
a. inthe Alignment group, click the Underline button.

b. Inthe Number group, on the Category list, select Accounting.

Note: If you are viewing formulas, the content of the selected cells does not appear right aligned. You
can press + to toggle between viewing formulas and calculated values (which appear right
aligned).

Sage 300 2023 Financial Reporter User's Guide



Your report specification now includes default row formulas and column headings.

A B C|D E F
1 .. Thisisashort financial report
2\ D =FRACCT("ACCTDESC"}) =FRAMT("BALP")
3 Account Description Balance

Exercise 4. Adding Account Reference Lines to the Statement

In this exercise, you will add five reference rows to display the following information in the report:

Current asset accounts
Total current assets
Current liability accounts
Total current liabilities

Net of assets and liabilities

To add reference rows:

1.

In cell A5, type
is a "wildcard" account reference that instructs Financial Reporter to query all accounts.
In cell BS, type

This expression restricts the accounts to the account group for Current Assets.

Note: The account group code for Current Assets is 1in sample data, but may be different for your
company.

In cell ES, type \.

A backslash instructs Financial Reporter to use the current default formula for this column with the
account number specified in column A (subject to the criteria specified in column B).

In cell F5, type \.

In cell E6, type
In cell F6, type

This instructs Financial Reporter to expand cell F5 on the report to include as many rows as there are
Current Assets accounts.

This cell reference (F5) will refer to all of the generated rows.
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7. Incell A8, type
8. Incell B8, type

This expression restricts the accounts to the account group for Current Liabilities.

Note: The account group code for Current Assets is 5 in sample data, but may be different for your
company.

9. Incells E8 and F8, type \.
10. Incell E9, type

11. Incell F9, type
12. IncellE11, type

13. Incell F11, type

Your report specification now includes five reference rows.

A B C\D E F
1 ..Thisis a short financial report
2 \\ D =FRACCT({"ACCTDESC") =FRAMT("BALP")
3 Account Description Balance
4
5 %% (ACCTGRPCOD=1) \ \
6 Total Current Assets =SUM(F5)
7
8 %% (ACCTGRPCOD=5) \ \
9 Total Current Liabilities (ACCTGRPCOD=5)
10
11 Assets Minus Liabilities =F6-F9

Exercise 5: Setting the Spec Range for the Statement

Financial Reporter processes all columns and rows of a spreadsheet within a range you specify, called
the "Spec range." Before you can print a financial report, you must define the Spec range for the report.

To define the Spec range:
1. Select cells A1 through cell F12.

The entire area of the specification you created is selected.

2. Onthe Formulas tab, in the Defined Names group, click Define Name.
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The New Name screen appears.

3. Inthe Name field, type

- N
Mew Mame @I—]-l
MName: Spec
Scope: Workbook IZI
Comment: -
Refers to: | _gheeti1sag1:6F§12 B
QK ] l Cancel I
. A
4. Click OK.

5. Save the report.

You have now created a simple statement specification and are ready to generate the report.

Exercise 6: Generating the Statement

Use the FR View command to generate a financial statement from the specification you created.
You can use FR View to generate two kinds of final reports: one with values and one with formulas.

e Values. If you generate values, Financial Reporter uses the formulas in the specification to extract
the appropriate data from the General Ledger, and inserts the data in the cells on the final report.

* Formulas. If you generate formulas (by selecting the Formulas check box), Financial Reporter
creates all the rows required by the report, but places a formula in the spreadsheet for each piece
of data required from the General Ledger.

This provides you with a report that is dynamically linked to your general ledger. At any time, you can
see updated versions of a report with formulas simply by recalculating the spreadsheet.

To generate a statement:
1. Onthe Excel ribbon, on the Add-Ins tab, click the arrow beside FR, and then click FR View.

The G/L Financial Statement Designer screen appears.
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M G/L Financial Statement Designer I&

Fizzal Option R eport Type Report &z [niziude

[ Report Optionz
Year/Period EiEL-12 3 f* Actual " — audit Informati

udit Infarmation
" Provizional {# Conzolidated  Fomulas

[v DrillDravery Information
Sort By
= Account Mo, |-"-“-'3'3'2"-4r1t j
fe Segment BT | Q,
" Account Group Ta |ZZ'ZZ Q

[ Select Account Groups By Sort Code Range

From ccount Group | Q,
To Account Group T Q
Segment Narne | & From | QA Ta | Repart 4z
Diivizion 5L Conzolidated
Reqgion s Conzolidated

ok Help Cancel

e, A

2. Click OK to accept the default print options.
The report is generated and appears in the worksheet.

3. Todisplay values instead of formulas in the worksheet, on the Formulas tab, in the Formula
Auditing group, click the Show Formulas button.

4. To preview the document, click File > Print.

5. Save your work and close the statement.

More Suggested Exercises

Now that you have produced a simple financial report, here are a few other ways to explore the
capabilities of Financial Reporter:
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« Restrict the range of accounts.

Use the FR View screen to restrict the range of accounts in the report.
» Specify a range of accounts.

On one of the rows of your report, enter a range of accounts
» Use wildcards to specify criteria for accounts.

Use the % wildcard character to replace one or more characters in an account number, or use to
replace one or more segments.

(Remember that you previously used to specify all accounts, and used column B of the report
specification to restrict the range of accounts to a single group.)

Example: Try entering to specify all accounts starting with 4000 (no matter how many
segments they have), or try

+ Add a new column.

Add an additional column G to the report. To do so, use FR Paste to insert a formula in the default row
specification. Select FRAMT, and remove all but the first parameter (including quotation marks) after
pasting the formula in cell G2.

Note: Remember to type \ in the rows of your report specification (for example, G5, G8, and any
other rows you have added).

» Explore options on the G/L Print Financial Statements screen.
Experiment with selecting different options. For example, you can:
¢ Change the fiscal year and period for the report.

« Specify whether to print actual or provisionally posted figures (unless one is specifically
selected in the spec).

» Specify the order in which records are sorted in the report.
» Specify whether to create a consolidated report or separate reports by account segment.

 Select the Audit Information option so you can see which account numbers Financial
Reporter selected.

» Restrict the report to ranges of accounts, based on account groups, account segments, or
account numbers.
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Where To Now?

Now that you are familiar with the Statement Designer and financial report specifications, read "Chapter
3: Writing Report Specifications" for more information about using Financial Reporter to create financial
report specifications.
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Chapter 3: Designing Financial
Statements

You define a financial statement using a report specification. The specification tells Financial Reporter
what data is included on the statement, and how it should be formatted.

Because the specification is a Microsoft Excel spreadsheet, you can use standard worksheet formulas,
formatting commands, and graphing abilities to modify the report, and you can create multidimensional

models to perform further analysis on the data.

Note: Financial Reporter includes a set of standard report specifications that are compatible with any
chart of accounts that uses the standard account group classifications and user-defined account
groups. You can print financial statements using these standard reports, or you can customize them.

Information Included On Financial Statements

Financial statements can include as many columns of data as you need, and can contain the following
account and other information:

» Current or historical balances for a single account or range of accounts.
» Net changes for a fiscal period, quarter, half-year, or year.

« Balances or net changes in functional currency or any of the source currencies defined in a
multicurrency ledger.

» Balances or net changes in the reporting currency (if you specified the euro as your functional
currency and selected a reporting currency in the Company Profile).

» Comparative figures from complete or to-date time periods.

e Budget figures from fiscal sets.

e Quantities.

» Company information, such as the name, address, telephone number, and company contact.
» The start and end dates of a given fiscal period.

e The exchange rate, given a particular currency, rate type, functional currency, and date.

Note: Accounts with zero balances are not included on the report.
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You can select a variety of options for printing a financial statement, including:

e Thefiscal year and period.

» Whether to print separate reports for each individual segment or account group, or a single
consolidated report.

e Whether to include provisionally posted transactions and rollup amounts.

Data Selection Criteria

Financial Reporter not only gives you access to data, it allows you to select data at print time using a
number of powerful features.

The first set of criteria you can use is in the report specification itself.
* You can restrict the accounts specified on a financial report by using selection criteria.

For example, you can select only those accounts in a specified range that have ACCTTYPE="Income"
AND ACTIVESW="Yes".

Alternatively, you can select only those accounts with a debit or credit balance.
¢ You can exclude report lines based on their contents.

For example, you could remove a line from your reports if the value in each column on the line is zero, or
you could exclude a line if it represents less than 5% of the total of column G.

* You can use the FRPOST, FRTRN, FRTRNA, FRTRNDR, FRTRNCR commands to select by
posted fields. For more information, see "Financial Reporter Functions" (page 94).

Consolidating Accounts

Financial Reporter lets you specify whether particular accounts or groups of accounts are listed
separately, consolidated, or subtotaled whenever the value of a particular account segment changes.

About Financial Statement Specifications

A financial statement specification is a structured description of a statement you want to produce.
Financial Reporter creates a report based on the statement specification and the options you select when
you print or view the final statement.

Statement specifications allow you to assign default functions and formulas to columns of the
spreadsheet, and to specify that a range of accounts will be expanded to many rows on a final statement.
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Note:

You do not need to create a statement specification to extract and print information. You can extract
and print balances from General Ledger by placing a few formulas in a spreadsheet, recalculating the
spreadsheet, and then printing from Excel.

You can also save the spreadsheet, and then use General Ledger's Print Financial Statements screen
to print the values in future. If the worksheet does not contain a statement specification, Financial
Reporter simply recalculates the spreadsheet, and prints it out.

Layout of a Report Specification

Spreadsheets that contain statement specifications have two separate regions:

» The Spec range is the region containing the report specification.

» The Report range is the region containing the financial statement produced from the report
specification.

The Report range contains a third range called the Print range, which excludes all audit information that
can be generated in the first columns of the Report range.

Tip: Statements that are not generated from specifications have no Spec range, but you can set a
print range to restrict the size of the worksheet for printing.

The statement specification and the report it creates both reside in a single worksheet.

When you generate a financial statement from a specification, the Financial Reporter processes all the
specification information in the Spec range, and creates the final report in the Report range.

If you opt to create a separate report for each account segment when you generate the report, Financial
Reporter inserts a separate worksheet for each segment into a new workbook.

Rules for Defining the Spec Range, Report Range, and Print Range
The following principles apply to the ranges in a financial statement specification:

» The Spec range can occupy any columns. A specification can begin in any column of a spreadsheet.
The only requirement is that the first column of the Spec range must be the first column of the
specification.

For more information about the Spec range, see "About the Spec Range" (page 65) and "Setting the Spec
Range" (page 67).

» The Report range is created when generating the report. The Report range is generated from
the Spec range when you print the financial report. It contains data that is generated by the report,
as well as data extracted from the General Ledger.
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» The Report range starts in column E. The first four columns of the Spec range (A through D) are
reserved for control information for Financial Reporter. All other columns form a template that
determines the appearance of the report and the kinds of data that will appear.

« The Print range starts in column E. The control information in the first four columns of the specification
is replaced by audit information in the report range when you use the FR View command.

Financial Reporter prints a smaller area of the worksheet than the Report range because it excludes
columns Ato D.

» The Print range is set by the Spec range.

About Generating Reports from Specifications

If you print a financial statement using the G/L Print Financial Statements screen, you do not see the
report specification. Instead, Financial Reporter opens the financial specification in Microsoft Excel,
processes the specification commands in the Spec range of the spreadsheet, and prints the report.

In contrast, if the spreadsheet contains no Spec range, Financial Reporter recalculates the spreadsheet
for the ranges of accounts, account groups, or segments specified on the G/L Print Financial Statements
screen, and then prints the whole spreadsheet, or the print area defined in the spreadsheet.

Depending on the print destination you specify on the G/L Print Financial Statements screen, you can:

» Preview the report before you print it.
» Send the report via e-mail to a recipient.

» Print directly to a printer, or print to a file.

Generating Statements Using the Financial Statement Designer

When you edit a report specification (using the Statement Designer), you can also test the statement
specification you are editing.

To generate the final report, use FR View. For details on using FR View, see "FR Menu Commands" (page
85).

FR View generates the report using the same print options that you use to print a report from the Print
Financial Statements screen. However, it provides two additional Include options:

» Audit information. If you select this option, Financial Reporter lists the results of the account
number references in column A of the report range of the spreadsheet. This information allows you
to check the numbers of all accounts included in your statement (as long as you enter D in column
D of the report).

« Formulas. If you select this option, Financial Reporter inserts a formula in each cell of the final report
where you need to insert General Ledger information. You can then update the report at any time by
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recalculating the spreadsheet.

Important! Spreadsheets with formulas are much larger than standard report specifications.
Generating statements that include formulas also takes longer, because Excel calculates the value of
each formula as it generates them.

After you generate a report, you can preview it by clicking File > Print in Excel.

About Using Selection Criteria

You can specify selection criteria on a default specification line, on individual specification lines, and in
formulas. With all these possibilities for account selection, you must be very clear which criteria are
actually in effect.

Important! Accounts must meet restrictions and criteria specified on the FR View screen.

The first restriction you place on account selection is with the FR View screen (or with the G/L Print
Financial Statements screen). Report-level account range filtering is in effect for any account reference
that specifies a range of accounts.

For more information, see "About Selection Criteria for Filtering Accounts” (page 57).

Overriding Account Ranges
You can override FR View screen ranges in two ways:
» By specifying segment codes that are outside the ranges defined on the FR View screen.

« By using the S prefix in individual account number references.

Unless you override the FR View screen, accounts must both fall within the specified range and meet
other criteria specified on the FR View screen.

If you specify any selection criteria in column B of a default specification line, that criteria is in effect
unless you override it.

You can override the criteria on a single line by placing a new criteria expression in column B. The criteria
expression is in effect only for the line on which you define it. If you specify a criteria for a single formula in
the line, the line criteria is ignored.
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G/L Statement Designer

To Open this Screen

1. Open General Ledger > Financial Reporter > Statement Designer.

2. Click Start.

Related Tasks

e "Setting the Spec Range" (page 67)

¢ "Printing a Financial Statement" (page 71)
Overview

Use the Statement Designer to create or edit a report specification for generating financial statements.

When you open the Statement Designer screen and then click the Start button, Sage 300 starts Microsoft
Excel with the Financial Reporter add-in.

Important! This add-in is available only when you start Excel from the Statement Designer.

The Financial Reporter add-in is a set of commands that you select from the FR menu on the Microsoft
Excel ribbon. For more information, see "FR Menu Commands" (page 85).

Tip: Turn on manual calculation in Excel so that formulas are not updated automatically. You can
recalculate FR commands at any time by pressing the F9 key.

Using the Statement Designer to Design Financial Statements

For information on using the Statement Designer to create custom financial statements, see "Designing
Financial Statements" (page 23).

For a series of short lessons on using the Statement Designer, see "Financial Reporter Tutorial" (page 7).
For information on the fields that you can use in financial statements, see:

e "Account Master Fields" (page 164)

e "Transaction Fields" (page 166)
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Including Information in Printed Financial Statements

You can include the following options when printing financial statements from the G/L Financial
Statement Designer by clicking FR > FR View on the menu bar:

* Report Options
¢ Audit Information
e Formulas

¢ DrillDown Information

Report Options

When you select Report Options, the first page of the financial statement displays the following
information:

» Statement name

» Fiscal year and period

» Report type (actual or provisional)

e Account processing and sorting order

* Account selection ranges

Including DrillDown Information

On the G/L Print Financial Statements and Statement Designer screens, you can select the DrillDown
Information option to add drilldown link comments to the generated report.

For more information, see "About FR Drilldown" (page 86).

Including Audit Information

The Audit Information option is available only when using FR View in the Statement Designer—it is not
available on the G/L Print Financial Statements screen.

When you select Audit Information, the statement includes information from the control information
columns of the spreadsheet (columns A through D), as well as the report columns that are usually
printed.

Including Formulas

The Formulas option is available only when using FR View in the Statement Designer—it is not available
on the G/L Print Financial Statements screen.

Usually, when you generate a report from a financial report specification, Financial Reporter inserts
balances and net amounts from the database into the generated financial report. However, if you select
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Formulas, Financial Reporter creates a financial report from the specification with a formula for each
general ledger balance or net that appears in the final report. You can then update that financial report
with current database values by recalculating the spreadsheet (pressing F9).

The most common type of report that is composed only of formulas is one that keeps financial ratios.

Note: Spreadsheets with formulas are much larger than standard report specifications—and they are
less flexible.

Financial Reporter automatically refreshes General Ledger data the next time you load the linked
spreadsheet in the Statement Designer. You can also use the G/L Print Financial Statements screen to
recalculate and print the report.

If you want to change the report (for example, by adding new accounts in the chart), you must regenerate
the report to incorporate the changes in your statement.

Tips:
* To save the linked spreadsheet, save the file under another name, and then remove the report
specification from the renamed spreadsheet.

¢ Keep financial ratios in a formula sheet.

About Totals and Subtotals

Financial statements contain columns of figures that are subtotaled and totaled according to account
type.

The most common arithmetical operation involves summing the balances or net changes of groups of
accounts at a moment in time, as in the following example:

Current Last Year

Balance Balance

Petty cash 274.57 358.00

Bank account, US dollars 8,437.54 5,932.90

Bank account, CAD 4,372.96 3,665.39
dollars

Total: 13,085.07 9,956.29

If this was a spreadsheet, you would place a formula such as in each of the "total" cells.

This formula would add together the values in cells B3, B4 and B5, and display the total in B6.
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Totaling a column of figures with Financial Reporter is just as easy. All you do is refer to the cells or range
of cells in the specification, and Financial Reporter will translate the cell references in the final report. You
may refer to a single cell, a list of cells, or a cell range.

In the following example, the formula will be translated when you generate the report to the

appropriate range of cells in the Report range to add the balances of all accounts in the range 1100 to
1300.

A BlC|D| E | F |
i\ =FRACCT("ACCTDESC") =FRAMT{"BALP")
Current Balance
1100:1300 1 \
Total: =SUM(F3)

Note:
Excel does not allow you to specify a negative range of cells as a parameter of SUM. For example, the

following SUM formula will not work in Excel:

You can fix the formula by moving the minus sign like this:

In summary, to perform any mathematical operations within the financial report, use standard
spreadsheet formulas and functions.

About Rounding on Balance Sheets

If you have spent much time working with financial statements, you know that balance sheets do not
balance when you round account totals. You always have to force a balance by adding a rounding
difference to one of your accounts or account sections.

The next two spreadsheet examples show two ways to ensure that your balance sheets will balance:

» Example 1 shows a simple mechanism that rounds all balances on the statement, and then forces
the totals of rounded assets to balance rounded liabilities.

» Example 2 produces a more theoretically correct balance by summing all unrounded account
balances, and then forcing the statement to balance to this sum.

Example 2 makes use of a hidden column of unrounded account data, and so will require a larger
spreadsheet and more memory to run.

Example 1: Forcing a Rounded Balance Sheet to Balance

This sample statement rounds and sums all printed figures on each side of the balance sheet, and then
forces liabilities and owner equity to balance with the assets. Any rounding differences are lumped with
owner equity.
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The specification for the statement includes a few rows that must be hidden before generating the final
report (row 11 and row 14).

| & |B|C|D] E | F |
1 [WACCT D =FRACCT{("ACCTDESC") =ROUND{FRAMT{"BALP").-3)
i Description Current Balance
3
4 Assets:
E (1000:1199 1 %
b Total assets: =5UM(F5)
7
8 Liabilities
9 |(3000-:3899 1 %
110 Total liabilities =5UM(F9)
11 (3900:3999 T %
12 Equity =SUM{F11.F14)
13 Total liabilities & equity =Fb
14 =Fb-F10-F11

This specification performs the following actions:

1. Prints the rounded balances of all asset accounts it retrieves from the general ledger using

The - 5 indicates the number of digits to the left of the decimal place to which the value is rounded (in
this case, thousands).

Because D is specified in column D, each account is printed on a separate line. (This is on row 5.)

2. Totals the rounded balances of all asset accounts. (Row 6.)

3. Prints the rounded balances of all liability accounts it retrieves from the general ledger using the
same formula. Again, each account is printed on a separate line. (Row 9.)

4. Totals the rounded balances of all liability accounts. (Row 10.)

5. Retrieves a single balance for equity. This amount is calculated on a hidden row, because the
difference between the rounded assets and the rounded liabilities plus equity will be added to the
equity section. (Row 11.)

6. Calculates the difference between the balances. (Row 14.)
7. Sums the difference between the balances and the equity amount. (Row 12.)

8. Displays the balance for total liabilities and equity. Since this balance must match assets, the
specification uses the same total. (Row 13.)

Note: If any accounts are missing from this statement, it will still balance (because we have forced a
balance between the assets and the liabilities plus equity).
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Example 2: Forcing a Balance to the Rounded Total of Unrounded Account Balances

The following statement example shows another way to set up a rounding mechanism in balance sheets
to handle rounding differences.

This method has two main advantages over the previous example:

1. It more accurately reflects an unrounded balance sheet, because the final balance is derived by
summing unrounded balances, instead of by summing rounded ones.

2. ltis self-auditing.

In example 1, you are forcing assets to balance liabilities and equity, so even if you leave accounts off the
statement, the report will balance. In example 2, the rounded statement will not balance if you leave out
an account.

Before generating the final report, you must hide column F, as well as rows 6, 9, and 10. (See the final
report example, below.) For information about hiding columns and rows, see "About Formatting Financial
Statements" (page 62).

| A |B[C|D] E | F | G |
1 |WACCT T =FRAMT{"BALF") =ROUND{$F1.-3)
2 Description Current Balance
3
4 (1000:1199 Cash L1 L1
E (1200:1299 Receivables \ \
E |1300:1350 \ \
7 Fixed assets =5UM(GBE.G10)
i Total assets: =SUM({F4.F5.FB)
g =SUM({G4.Gh.GE)
10 =G8-GY9

This specification performs the following actions:

1. Inserts the unrounded balances of all accounts in column F of the spreadsheet, and inserts the
rounded balances of all accounts in column G.

2. Calculates a rounded sum of column F (in G8) and column G (in G9) of the spreadsheet.

Note: The rounded total to which we want to balance is the total in G8. The total in G9 contains the
cumulative effect of all rounding differences.

3. Calculates the difference between the rounded totals (G8 and G9) in G10 of the spreadsheet.

4. Adds the difference between the totals to the last range of accounts (in row 7 of the spreadsheet).

By adding the rounding difference to the last group of figures, we have forced the figures in column G to
equal the total in G8.
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You handle the credit side of the balance sheet using a similar approach, summing all liabilities with
owner equity, and then deciding where to put the difference between the sums of the rounded and

unrounded balances.

The generated statement includes rows and columns that would be hidden on the final report (shown in

bold):

Description Current Balance
Cash 37,657.35 38,000
Receivables 89,576.73 90,000

356,526.85 357,000

Fixed assets 356,000
Total assets: 484,000
485,000

(1,000)

Rows and Columns Hidden on Report

About Verifying Account Data

You can use two methods in Financial Reporter to test account information to decide whether it should
appear in a report.

» Use aformula in column C to test the contents of a line. You can specify conditions for excluding
generated lines from a report based on the contents of the line.

For more information, see "About Columns in Report Specifications" (page 35).

» Use FR functions with spreadsheet functions. Financial Reporter functions can replace parameters of
spreadsheet functions, so you can test the contents of fields before printing the report, or manipulate
them as you wish.

Example:
To specify that a balance is printed only if it exceeds 6000, use

To print the average value of two accounts, use
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About Optional Fields in Financial Reports

You can print account optional fields and transaction optional fields detail using Financial Reporter.

* You can retrieve account optional fields using FRACCT or FRPOST.

Note: A field name for an account optional field is the original optional field name with the prefix
You must include the period following the letter A.

* You retrieve transaction optional fields using FRPOST.

Note: A field name for a transaction optional field is the original optional field name with the prefix

You must include the period following the letter T.

If an FR command retrieves data from more than one transaction, you can consolidate optional field data
for Amount, Integer, and Number optional field types in the following ways:

* You can print the optional field value of the first retrieved record that has optional field values.

If the field specified in the first parameter of the FRACCT or FRPOST command is an amount, integer,
or number field, and is appended with U, only the first optional field value is reported.

* You can print a consolidated total that sums up all values from the retrieved optional fields.

If the specified field name is not appended by anything or is appended by C, a consolidated total is
printed.

About Columns in Report Specifications

Most of a financial report specification is a template for the report it produces. For example, all report
formatting (such as column widths, fonts, highlighting and underlining) appears on the financial report
specification.

The first four columns of the report specification (columns A through D) contain important control
information.

Note: You can begin a specification in any column, as long as the Spec range begins with the same
column.

Sample Report Specification

In this example, row 1 is a default row. To use the default formulas in subsequent rows, place a backslash
in the appropriate spreadsheet cells.
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A B|C|D E F

1\ =FRACCT("ACCTDESC") =FRAMT("BALP")
2 Account Description Current Balance
3 |1020:1400 \ \

Column A

The contents of column A of each row (the first column of the Spec range) determine the purpose of all
columns in the row. There are five possible types of rows in a report specification:

o Comment row. If column A starts with (two periods), the row is a comment row.

» "As is" row. If column A is blank, the row is part of the report and will appear "as is" on the final
report.

» Default row. If column A starts with \ \, the row is used for setting up defaults for the remaining
rows on the report.

You can have more than one default specification row; each applies to the rows between it and the next
default row.

« Title row. If column A starts with \ T, the row is used to define title lines on the final report. You can

have up to five title rows, which will appear at the top of each tab of the report (immediately under
the header lines).

» Body specification row. Rows that start with account number references are called "body
specification rows."

Note:
¢ If column A contains any other data, Financial Reporter assumes that the data is a reference to
one or more account numbers.

» If an account number appears in column A, it generally means that all printed columns in the row
will contain data from that account.

Columns B, Cand D

Columns B, C and D filter accounts specified in column A (columns 2 through 4 of the Spec range) to
refine the account selection. For example:

e Column A can specify a range of accounts.

» Column B can contain a filter to restrict the range of accounts in column A to a particular account
group (or to an account type or account name).

Column B can also refer to the filter for posted transactions, if Column D refers to listing by posted
transaction details or by posted transaction consolidated details.
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For more information, see "About Selection Criteria for Filtering Accounts" (page 57).

o Column C can remove any lines from the report that have zero balances (use 7 to omit zero-
balance lines) or meet a condition such as "balances less than $1,000".

« Column D can consolidate the balances of the range of accounts, consolidate by account segment, list
each account separately, consolidate all values from retrieved optional fields, or print the optional field
value of the first retrieved record. This can also be consolidated by transaction date and posting
sequence.

Use T to generate a single total line for an account range. If you leave column D blank, or specify a D,
Financial Reporter will list the details for each account in the range.

Column D constants for use in the spec area are the indicators for listing by transaction details, by
transaction consolidated total, and by transaction total. Values must begin with

List By Cell Value of Column
D

Transaction details in posted transaction PD
order
Transaction consolidated total PT
Transaction consolidated by account P(POSTRAN)
Transaction consolidated by journal date P(POSTDATE)
Transaction consolidated by posting P(POSTSEQ)
sequence

Column D Constants

Transactions can also be listed by consolidated account segments and account groups as listings by
accounts. When consolidating by a specific account order in listing by transactions, the column D value
must start with P instead of with

Example: is the consolidation of transactions with account segment 2 retrieving
records from a transaction, while is the consolidation of account history with
account segment 2 retrieving records from an account.

To list the details by transaction, the spec must provide a correct sorting order, as illustrated in the
following table:
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Exclusive Sorting Meaning
Order
POSTTRAN By Posted Transaction, in account
order
POSTDATE By Date Order
POSTSEQ By Posting Sequence Order
POSTACCT By Account Posting Sequence
Sorting Order
Note:
¢ If the account reference is specified with exclusive sorting order at column A from a spec line
and the order is an account order (for example, ), Financial Reporter does

not generate the transaction details of the spec line.

« If the consolidation value in column D is , the sorting order must be

« Ifthe consolidation value in column D is , the sorting order must be

« Ifthe consolidation value in column D is , the sorting order must be

« If the consolidating total is retrieved by any defined account switches, like it

can be sorted by any defined account order, similar to listing by accounts.

« Listing by transaction is only limited to the inquiry of transaction records from the inquired
period.

« Use T to generate a single total line for an account range. If you leave column D blank, or
specify a D, Financial Reporter lists the details for each account in the range.

Column E

The report template actually starts in Column E, the fifth column of the Spec range. Any value or formula
placed in the report template area is part of the final report.

The following example shows a report specification displayed in formula view.
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| A I=1[=[=) E F G H |
1 |. Specification UNIVS
2 |.. This specification will produce an expense
3 |.. schedule for the current fiscal period,
4 | . guarter. and vearto date.
R =FR"COM
b achedule
fi ="Forthe
g
g |y ST =FRAMTA[" =FRAMTA( FFRAMTA
NETF") "NETOM  ["METYTD
10 Current Quarer r'ear
11 Feriod ToDate | ToDate
12 | ="6000:6999" D| =FRACCT{"ACCTDESC" b i h
13
14 =BUMIGTZ)| =SUMHT2)| =5LIM{T &)
15

In this example, the first three lines of column F that appear on the report are:

. , @ Financial Reporter function that displays the company name on the
statement.

» The text "Schedule of Expenses."

o The text and function ""For the period ending " ." The function inserts the period
end date from the database.

Row 9 of the specification sets the default contents of statement columns. Column A of this row starts
with two backslashes.

The next row with text contains the headings for columns G, H, and |. These headings are printed "as is."

Note: You use formatting commands in Excel to underline these column headings.

The next row with text will be expanded on the printed report to include all accounts in the range between
6000 and 6999 that meet other selection criteria specified in cells B, C, and D, or entered at print time on
the Print Statements screen. In the spreadsheet's formula view, the row looks like this:

(12 |="6000:5999" | |Dl=FRACCT{"ACCTDESC"Y | B I I |

The backslash () in the three columns on the right indicates that each cell value will be generated from

the default formula set for the column. (Financial Reporter inserts the account reference in column A into
any default formula that requires the account reference parameter. For example, the default formula for
column Gis . FRAMTA is a Financial Reporter function that prints the account
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period balances or net amounts from the account fiscal sets. In this case, the formula specifies the net
amount for the current period.)

When Financial Reporter processes this cell of the statement template, it expands the formula with the
account reference from column A. (For example, J)

The remaining two columns also use a default formula; in this case, bringing in the net changes for the
quarter to date and the year to date.

The final row in our example is the total line:

=SUM{G12) =SUM(H12) =SUM(I12)

Note: You use formatting commands in Excel to format cells with top and bottom borders.

Notice also that the total formula for each column refers to a single cell (or list of cells) in the specification
range. In our example, the single cell in the specification range formula will be replaced in the report
range formula by a range reference that contains as many rows as there are accounts in the account
range specified on line 12.

About Calculated Columns
Calculated columns contain figures resulting from calculations on data in other columns of the statement.

To define a calculated column, use standard spreadsheet formulas in the default column specification
row. For example:

Current Last Year Curr/
Balance Balance LYear
Petty cash 274.57 358.00 77
Bank account, US 8,437.54 5,932.90 142
dollars
Bank account, 4,372.96 3,665.39 1.19
CAD dollars
Total: 13,085.07 9,956.29 1.31

In this statement, the default formula for the last column (column H on a report specification) is

. The formula states that this column contains the value of column F divided by column G.
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When the report is generated, Financial Reporter adjusts the relative cell references on each line.

Using Currency Exchange Rates in Column Calculations

Financial Reporter can use exchange rates maintained in Sage 300, so you can create financial reports
in any currency you maintain, using the exchange rates from any fiscal period.

To retrieve exchange rate information, you use the FRRATE function to get exchange rate information.
For more information, and for examples of how to use this function, see "FRRATE Function" (page 137).

| & [B|c|D] E | F | G . H |
1 %W =FRACCT{("ACCTDESC" =FRAMT{"BALP") -FRAMT{"BALF.L1") =(F1/G1)
2 Current Last Year Currf
3 Balance Balance LYear
4 (1100:1300 L1 \ L1 L1
b Total: =SUM(F4) =SUM(G4) =({F5/G5)

Note: The rate returned by the FRRATE function is always used as a multiplier to convert source
currency to functional, even if you defined the rate as a divisor. If the rate is defined in the System
Manager as a divisor, Financial Reporter returns the reciprocal of the rate.

About Default Column Specifications

In a financial statement specification, default column specifications are defined in the first line, and then
used with a range of accounts in the last line.

The following example illustrates default column specifications and specification lines that apply to a
range of accounts:

F8 Bl D E F G H I
g |y ST =FRAMTAM FFRAMTAL |=FRAMTA,
METP") "NETQM  ["METYTD
110 Current Cluarter “aar
11 Feriod ToDate ToDate
12 | ="B000:E999' D[ =FRACCT("ACCTDESC" Y i i

The line starting with two backslashes in column A contains default column specifications. These
default column specifications are in effect until you define a new set of defaults.

To use the currently defined default column specification, you simply type backslash (\) into a cell, as in
the last line of the example above.

Note:
« You can follow \ with — or + to print the inverse or the absolute value of the formula result.

 Remember that the actual report area starts from column E.
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Advantages of Using Default Column Specifications

Both of the following examples print exactly the same information. The first example uses a complete
formula to get each value; the second example uses default column specifications and an account
reference to a range of accounts.

For each of the following examples, assume that accounts 1100, 1200, and 1400 are consecutively
numbered accounts in the general ledger.

Example 1: Using Formulas to Place Values

In this example, you require one formula to print each piece of information:

e e e E F |
5 Account Description Current Balance
i =FRACCT{"ACCTDESC"."1020") =FRAMT{"BALP"."1020")
=FRACCT{"ACCTDESC"."1200") =FRAMT{"BALP"."1200")
=FRACCT({"ACCTDESC"."1400") =FRAMT({"BALP"."1400")

To print the current balance of 200 accounts, along with their descriptions, you would require 400
formulas—and you would have to change the specification each time you added to the chart of accounts.

Example 2: Using Default Column Specifications to Place Values

In this example, you use a default column specification to place values:

A i S 0 0 A 3 e |
I =FRACCT{"ACCTDESC") =FRAMT("BALP")
Account Description Current Balance
|1020:1400 ! !

This example demonstrates how Financial Reporter lets you define a report line that applies to a range of
accounts. At print time (or when using FR View in the Financial Statement Designer), the single line will
be expanded to as many lines as there are accounts in the range.

In other words, a report that prints the current balances of all accounts in the general ledger can be
defined by a single line that specifies the range of all accounts.
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Note:
« The default column specifications line begins with two backslashes (\ \).

« The default column specification assigns a particular formula to the backslash (). In our
example, the formulas have used only Financial Reporter functions.

Alternatively, you could assign a value to \, or make use of spreadsheet functions in your formulas.
You can follow \ with — or + to print the inverse or the absolute value of the formula result.

* The default column specifications are exactly the same as the formulas in the first example,
except that they do not include the account reference.

When you generate the statement, Financial Reporter inserts the account references for the line into
the default formula.

¢ The account reference is for a range of accounts. The single line in this example will be
expanded to as many lines as there are accounts in the range.

e Youcan use - - to specify all accounts in the ledger. For more information, see "About Account
Number References" (page 54).

¢ Columns B, C, and D may contain selection criteria that affect the range of accounts and
whether the final value will be printed at all.

Adding Default Information for Columns B, C, and D

The following example illustrates default values for columns B, C, and D, as well as for the printed
columns of the report:

R B i} 5 ! F =
A\ ACCTTYPE="B" Z T =FRACCT(*ACCTDESC") =FRAMT("BALP")
, Account Description Current Balance
{1020:1400 Cash )

Note that you do not have to specify a backslash () in columns B, C or D to inherit the defaults. If you

want anything but the default values, you must specify the information you want to display.

Financial Reporter evaluates the last line of the above specification and performs the following actions:

1. Evaluate all accounts in the account number range specified in row 3 to see that they are type "B"
accounts.

2. Get the account balance of each account in the range that is a balance sheet account.

3. Total the balances—because T in column D specifies that a single total line will be generated from
the account range, rather than one line for each account to list the details.

Note: If you leave column D blank, or specify a D, Financial Reporter lists all details.
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4. Check whether the amount in column F is zero (because of the 7 in column C). If it is, Financial
Reporter does not print the line.

Financial Reporter looks only at the numbers on a line to decide if zero-suppression should take place. In
this example, the description in column E does not affect whether the line is printed.

If you do not want to suppress zeroes on a single line, enter the [\l in column C on the line that you want to
print.

For details on specifying selection criteria and suppressing lines, see "About Consolidating Account
Ranges" (page 50), "About Excluding Lines from Reports" (page 58), and "About Selection Criteria for Filtering
Accounts" (page 57).

For more information about Financial Reporter functions, see "Financial Reporter Functions" (page 94).

Sample Default Column Specifications

The following examples illustrate standard financial report formats and the column specifications you use
to produce these reports.

Example 1: Balance This Period and Last Period

This example produces a comparative balance sheet.

¢ Column E lists the current balance.

e Column F lists the balance in the previous period.

| a |B|C|D] E | F |
1 % =FRAMTA("BALP") =FRAMTA("BALLP")
i Current Balance | Balance Last Month
3 |1100:1300 } \

Example 2: This Year/ Last Year Balances with Percentage of Total Columns
This example produces a comparative balance sheet with four columns of data.

» Column G lists the current balances.
» Column | lists the balances for the corresponding period in the previous year.

e Columns H and J compare each account as a percentage of the totals for the corresponding year.

| F | G | H | I | d |
1 =FRAMTA("BALP") =G1/G4%  =FRAMTA("BALP.L1%) =11714%
i Current ¥ear % of Total Previous Year % of Total
d L) L) \ \
4 =SUM(G3) =SUM{13)
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Note: The formulas in columns H and J illustrate that the range of accounts is defined in row 3 of the
report specification, and the total calculation is in row 4. Financial Reporter recalculates these cell
references for the generated report.

Example 3: Period and Year-to-Date Expenses

This example produces a comparative expense schedule with two columns of data.
e Column E lists the expenses this period.

e Column F lists the expenses year-to-date.

| A | B|C]|D| E | F |
1 W =FRAMTA("MNETP") =FRAMTA["NETYTD")
i Expenses This Period Expenses Year to Date
3 |60O00:8999 % 11

Example 4: Current Period and Year-to-Date Expenses as a Percentage of Sales

This example produces a comparative expense schedule, with each current period and year-to-date
expense listed as a percentage of sales.

» The range of expense accounts is defined in row 13, and uses the default formulas defined in row
11 of the report specification.

¢ The total sales calculation is in row 9.

| F | G | H | | | J |
g =5UM(GE) =S5UM(18)
10
11 =FRAMTA["NETP") =G11/G9% =FRAMTA({"NETYTD") =111719%
12 Current Year % of Total Previous Year % of Total
13 Y \ \ \
14 =5SUM(G13) =5UM(13)
Note: Financial Reporter recalculates all formula cell references for the generated report.

Example 5: Current Period and Year-to-Date Expenses Compared to Last Year
This example produces a comparative expense schedule with six columns of data.

» Column G lists the current period expense.

» Column H lists the expense for the corresponding period in the previous year.

e Columns J and K list the year-to-date expenses.

e Columns | and L compare each amount as a percentage of the amount in the previous year.
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__| G I H | I | J K | L |
18 [-FRAMTA{"NETP") | =FRAMTA("NETP.L1") | =G18/H18% =FRAMTA("NETYTD") =FRAMTA{"NETYTD.L1") =J18/K18%
19 | Current Same Month % of This Year Last Year % of
M Month Last Year Last Year YTD YTD Last Year
2 | A A A 4 A A

Note: The range of expense accounts is defined in row 21 of the report specification, but the formulas
in 118 and L18 reference the default formula cells that are used in row 21. Financial Reporter
recalculates these cell references for the generated report.

Example 6: Side-by-Side Departmental Statements

This example produces a side-by-side departmental comparative balance sheet with three columns of
data.

e The processing order is set in column A to Account order.

» Column D indicates that each time the account number changes, Financial Reporter should create
a new line.

Column E lists the name of each account.

Column F provides the current balance of accounts that meet the criterion of Department A.

Column G provides the balance of accounts that meet the criterion of Department B.

A [Blc] D | E | F | G |
1 \WACCT DACCT]) =FRACCT["ACCTDESC"] =FRAMT["BALP" " "[ACSEGYALDZ = ""A"™)"] =FRAMT["BALP".,"" "[ACSEGVALOD2 = ""B"""]
2 Department A Department B
3 | ="1000:2999" \ \

\

Using Formulas to Retrieve General Ledger Account
Information

In the Financial Statement Designer, you use Excel formulas to insert account record information or fiscal
set values anywhere in a financial statement.

Example:

inserts the account description from account 1000-333
(for example, "Cost of goods sold").

inserts the actual balance of account 1000-333 for the

current fiscal period for the year 2019.

You can also insert company information in a financial statement. For example,
inserts the name of the currently open company.
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The easiest way to insert Sage 300 financial information is by using the FR Paste function, which you can
use to create a formula quickly. For more information, see "About FR Paste" (page 88).

To specify balances and quantities, you use the following syntax:

Formula Sage 300 Notes
Financial
Information

Account If is specified without an 2 or P prefix for actual or

balance provisional amounts, it will default to the report setting chosen at
print time.

Provisional
balance

Actual quantity

Provisional You can specify budget sets according to the edition of Sage 300 you
quantity use:

e Sage 300 Standard includes budget sets 1 and 2
e Sage 300 Advancedincludes budget sets 1, 2, and 3

e Sage 300 Premium includes the numbers 1 to 5 for the budget
sets (for example, 1BALP or 2BALP).

Financial Information Syntax

Tip: You can construct your financial statements by placing a Financial Reporter function at each point
where you want to print financial information. However, identifying each item individually can be a time-
consuming and unnecessarily rigid way to create a statement. Developing a statement specification
with default formulas for each column, indicating the group of accounts to which the column formulas
will apply, is a more flexible and efficient way to create your statement.

About Account Order in Financial Statements

In financial statements, Financial Reporter lists ranges of accounts in the order set in the financial report
specification or (if not set in the specification) in the order you specify when printing.

You can sort accounts by any account segments, and you can specify a range of values for each
segment you sort by. You can also sort by account group, using the formula or by

account-sorted group, using the formula
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Example:
If your accounts have two segments, the account reference generates two possible

account listings, depending on the sort order you specify:

« If accounts are sorted by segment 1, they are listed like this:
* 100-A
+ 100-B
e 120-A
* 120-B

» If accounts are sorted by segment 2, they are listed like this:
* 100-A
e 120-A
* 100-B
* 120-B

Specifying Order at Print Time or in the Default Row Specification

The default order for processing accounts is the order specified at print time on the Financial Statements
screen (or the FR View screen when editing specifications).

You can also enforce the order of processing accounts in ranges for all or part of a report by specifying
the order in the first column of the default row specification (immediately after the backslashes "\\").

You may process account numbers in any of the following orders:

. (account number order)

. (account segment order)

. (account group order)

. (account segment #n order)

. (to list accounts by the segment with description Segment_desc. For
example, )

The order you specify determines:

» The order in which accounts in expanded account references are printed.

» The ease (and, consequently, the speed) with which the accounts can be retrieved by Financial
Reporter.
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In the following example, account numbers have two segments: a department segment and an account
segment. The department segment is first (not recommended), and there are only two department codes
in the ledger, but a large number of accounts. The first account segment in the ledger is 1000.

If Financial Reporter processes accounts in order by the account segment, it will only have to process
accounts 1000 through 1100 (specified like this).

A B|C|D

WACCT

%-100071100

The accounts will appear in the following order on the report (by account segment, then by department):
* A-1000
e B-1000
* A-1100
+ B-1100

If, on the other hand, Financial Reporter processes accounts in account number order (which lists the
department segment first) it will have to scan each account in the ledger to see if it matches the range.

A B|C|D

\ACCTID

%-100071100

The final report will also be in account number order, which, in this case, will be in department order for
the indicated range.

* A-1000
* A-1100
» B-1000
» B-1100

The order of segments in an account number is defined by the account's structure code—not by the order
of segments shown on the G/L Options screen in General Ledger. Consequently, if you have different
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structures that have different first segments, ACCTID order will produce odd results, and you should
order accounts by a particular segment or by account group.

If you choose to print by the account segment, the order for processing is first by that account segment,
and second by the complete account number (as defined by its structure).

If you print by the account group code, the order is first by account group, second by account segment
code, and third by account number.

The default sort order remains in effect until you specify another sort order, or unless it is overridden in a
specific account reference (see the next section).

Specifying Account Order for One Account Reference

You can choose to process a single account reference in a different order than indicated by a default row

specification or by the report options on the Financial Statements screen.

You specify a processing order for an account reference by placing itimmediately after the account

reference
Example:
. uses account order, so processes only account 1000. Segment 2 will appear
in any order.
. uses segment 2 order, so will scan all account numbers. However,

segment 2 will be in order.

. uses account number order for accounts that use the
REGION account structure. Will only process particular accounts in the range.

Note: If the account reference specifies a range using a colon :, this reference will be processed in
account number order unless you set an order for the reference using the | character (no matter what
order is set in the Print dialog box or in the default row specification).

As you can see from these examples, the way you reference accounts can have a substantial impact on
performance.

For information on specifying account references, see "About Account Number References" (page 54).

About Consolidating Account Ranges

You can perform two extremely useful operations on a group of accounts. You can:

» Consolidate all the lines of an account range instead of printing out the details.

 Print subtotals for groups of accounts according to changes in particular account segments.
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Grouped, Separate, or Summarized Data

You can generate separate lines for each account in an account range, consolidating the account
reference in a single line, consolidating account data by account group, or you can consolidate the
account data by account segment code.

You specify this choice in column D of a report specification. In addition, you can use the column D
setting to override the account order processing on a line-by-line basis.

Value Description

D For a detail. Prints one line for each account number.

RD For a rollup account detail. Prints all the top-level rollup details, as well as
accounts not in rollup groups.

T For a total. Consolidates the data.

D(ACCT) Consolidates by the account segment code, setting the account number
sorting order to account segment order for this single account reference.

D(ACCTGROUP) | Consolidates by the account group.

D(ACSEGVALN) | Consolidates by account segment number n.

D(AcctSegID)

Consolidates by the named account segment—for example, D(REGION).

PD Consolidates by transaction details in posted transaction order.
PT Consolidates by transaction consolidated total.

P(POSTTRAN) Consolidates by transaction consolidated by account.
P(POSTDATE) Consolidates by transaction consolidated by journal date.
P(POSTSEQ) Consolidates by transaction consolidated by posting sequence.

Column D Valid Values

In each case where consolidation is performed on the basis of a property of the account number,

Financial Reporter processes the account number in the order required for consolidation. For example, if

consolidation is by account group, the account numbers are processed in account group order.

Transactions can also be listed by consolidated account segments and account groups when listing by

accounts. If you are consolidating by a specific account order in a list of transactions, the value in Column

D must begin with a “P”. For example:
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* P(ACSEGVALO2) returns transaction records consolidated by account segment 2.

* D(ACSEGVALO02) returns account history records consolidated by account segment 2.

FR requires a correct sorting order in Column D in order to list details by transaction through field
consolidation, as follows:

Sorting Order for Consolidating Transactions

Exclusive Sorting Order Meaning
POSTTRAN By posted transaction in account order
POSTDATE By date order
POSTSEQ By posting sequence order
POSTACCT By account posting sequence
Important!
¢ The sorting order must be POSTTRAN if the consolidation value in column D is by P
(POSTTRAN).
¢ The sorting order must be POSTDATE if the consolidation value in column D is by P
(POSTDATE).
¢ The sorting order must be POSTSEQ if the consolidation value in column D is by P(POSTSEQ).
¢ Anything that appears in column D on a default specification line will be used by all subsequent
lines unless you specifically override it.

Examples of "T" and "D" Consolidation Settings

The following examples show the effect of T and D settings in column D of a report specification.

Displaying Account Balances on Separate Lines

Specifying D in column D lists each of the accounts between 1100 and 1200 on separate lines.

A |B[c[D] E | F |

| W =FRACCT{"ACCTDESC" =FRAMT("BALP"™)
Current Balance

|11I]I]:12I]I] Dy v
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Current
Balance
Petty cash 274.57
Bank account 8,437.54
Bank account, CAD 4,372.96
dollars
Total: 13,085.07

Displaying Account Totals on a Single Line

Specifying T in column D indicates that all accounts in the range are consolidated.

A |B[C|D] E l F l
A\ =FRACCT{("ACCTDESC") =FRAMT{"BALP")
| Current Balance
|11I]I]:12I]I] T Liguid assets \

The resulting report totals the balances of all the accounts between 1100 and 1200, and reports the total
on asingle line.

Current

Balance
Liquid 13,085.07
assets

Displaying Accounts in Segment Order, Consolidated by Segment

Specifying in column D indicates that all accounts in the range are to be listed in account
segment order and consolidated by the account segment.

A |BIC] D | E | F |
i\ =FRSDESC(1) =FRAMT{"BALP")
Current Balance
1100:1200 D{ACCT]) % !
Current
Balance
Petty cash 274.57
Bank 12,810.50
account
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Current
Balance

Total: 13,085.07

Two lines are printed in the above example, because there are two account numbers with an account
segment code between 1100 and 1200.

The first account segment code (1100) is for petty cash, and the second account segment code (1200) is
for Bank Accounts. Two separate account numbers have an account segment code of 1200, but these
two accounts (shown in the previous example) have been consolidated.

summarizes by account segment code all other segments that happen to be within the ranges
specified when printing the report.

For subsequent rows, the order will revert to the order that was in effect prior to this specification row.

About Account Number References

An account number reference specifies the accounts from which you want to retrieve General Ledger
data.

Tip: In the Statement Designer, use FR Paste to specify accounts and account ranges without
manually entering formulas. For more information, see "About FR Paste" (page 88).

Specifying Accounts and Ranges of Accounts

You can specify a single account number, or a range of account numbers in consolidated (single-row) or
detailed (one row per account) format.

Example:
The formula retrieves data from a range of accounts into a

single spreadsheet cell.

When specifying account groups, you can use these formulas:
. (sort by account group)

. (account-sorted group)

The rules for specifying an account number reference are the same, whether the reference is in a function
or in column A of a specification row.

Sage 300 2023 Financial Reporter User's Guide



Example:
Column A of a specification row specifies account data to use for the row:

A B|C|D

%-100071100

In this example,  is a wildcard character that takes the place of one or more characters. For more

information, see "About Wildcard Characters in Account Numbers" (page 60).

In column D, you can enter D to specify that each account is listed separately, or T to specify that each

account is totaled on a single line.

For more information, see "Account Reference Syntax and Examples" (page 91).

Account References and Performance

Financial Reporter can generate reports faster when it does not have to look up information for a
substantial number of extra accounts. For this reason, check that the account processing order in the
report matches the way you specify account references.

For more information, see "About Account Order in Financial Statements" (page 47).

Restricting Account Selection

Financial Reporter selects which account data is to appear in a financial report by evaluating three
separate account number filters:

» The account number reference in column A of the report line.
» The account filtering expression in column B (if there is one).

» The print range options for the entire report.

Normally, an account has to satisfy the requirements of all three filters in order to be included in the
report. However, Financial Reporter also provides a mechanism for specifying a report range, and for
including accounts which lie outside that range.

The easiest way to add account numbers to a financial statement is using FR Paste. For more
information, see "About FR Paste" (page 88).

Specifying Account Structures

To restrict account number selection to a particular account structure, use a formula such as

, which specifies an individual account number and a range of
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account numbers. The square brackets indicate the account structure codes used by the account
numbers.

Specifying a Segment to Override a Segment Range

You can override a segment range specified on the Print Financial Statements screen by including the
segment values you want on the line in the column A account number reference.

Example: If you want to compare the performance of each department to the total sales for the
organization, you can specify the total organization's sales on a line as follows:

. In this example, you would print reports
specifying a segment range of A, of B, and so on.

Turning off Report-level Account Range Filtering

A S prefix turns off report-level account range filtering for the particular account number reference. If you
use a S prefix, any account numbers that match the account reference you specify and match the

selection criteria in column B will appear on the report, regardless of the restrictions imposed by Financial
Reporter print settings.

You can also use the S prefix with the = = wildcard characters to include any account in the ledger

allowed by the criteria in column B for the row. (= = is an account number reference that includes all
accounts, no matter what their account structure.)

Specifying Ranges of Accounts when the Account Segment is not First in the Account Structure

Account references work best when the account segment is the first segment of your account numbers.
Not only is it easier to specify account ranges, but Financial Reporter processes them more quickly as
well.

If you do not have the account segment first, you can still specify a range of account segment codes and
print the accounts in account segment order.

For example:

. specifies all accounts with an account segment code from 4000 to 8000, no matter

how many segments are in the number, and no matter where the account segment is in the
account structure.

. specifies all accounts with an account segment value between 400 and
600, and with a Department segment value from A to C. indicates that the accounts are
ordered by account segment.

. specifies account segment values from 400 to 600, no matter what the
value of other segments. Again, the accounts are ordered by account segment.
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. specifies all account numbers ordered by the account segment. To specify a range or
account segments, add a criterion in column B, such as

The last example is the most flexible, because it specifies a range of account segment values no matter
where the account segment lies in the account structure. This is especially useful if you have more than
one account structure.

About Selection Criteria for Filtering Accounts

You use the selection criteria feature in Financial Reporter to include account figures in a report based on
settings in the General Ledger account master.
For example, you could use the selection criteria expression

to select all accounts with an account type of "B" (for balance sheet) and an active switch

set to currently active.
When you place a selection criteria expression in a formula or on a statement line, Financial Reporter:

1. Looks up the account identified by the account number in column A of the line (or by a formula).

2. Checks to see that the account master information matches the selection criteria you have
specified.

You can include selection criteria in column B of a specification (to restrict the accounts selected from the
Account Code reference specified in column A), or in formulas that retrieve account balances, net
amounts and quantities from posted transactions, or net amounts from General Ledger.

Tips:
¢ The easiest way to define selection criteria is to use FR Paste. For more information, see "About
FR Paste" (page 88).

* Generally, you should not use selection criteria if you can achieve the same result with a more
selective account number reference.

¢ You can improve report performance by being more precise in your account references to
restrict the number of initial account lookups.

¢ You can choose report criteria variables you select from the Preview Financial Reporter screen
while you are in a worksheet. Financial Reporter recalculates FR commands according to the
criteria you have saved. (For example, if you have created two workbooks for different years,
you can switch between the workbooks without losing the value of FR commands after running
FR View.)

Using Selection Criteria in Column B

You can use selection criteria in column B of a specification to restrict the accounts selected from the
Account Code reference specified in column A.
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Defining a default expression for column B is similar to defining other default report columns: you place
the default selection criteria expression in column B of a default specification line.

If you enter criteria on a default line, it is used for all subsequent lines that do not have a criteria defined.

In other words, if you do not want the default expression to apply to a line, you must override it on the line.

Note: You do not need to type \ on lines for which you want to use the default selection criteria.

Using Selection Criteria in Formulas

You can also use selection criteria in formulas that use FRAMT, FRAMTA, FRCREDIT, FRDEBIT,
FRTRN, FRTRNA, FRTRNCR, and FRTRNDR functions to retrieve account balances, net amounts and
quantities from posted transactions, or net amounts from General Ledger.

If you paste an expression into a formula, the selection criteria acts on the formula only. If you paste the
expression into column B of a statement line, the selection criteria further refines the account number
reference specified for the current line.

About Excluding Lines from Reports

You can specify conditions to exclude generated lines from a report based on the contents of the line.
You define the criteria for excluding a report line by adding a formula to column C of the line.

» Suppressing lines with zero values. To specify zero-line suppression, you type Z in column C.
Financial Reporter suppresses all lines with a value of zero.

If you do not want to suppress zeros on an individual line, but you specified Z in the default specification,
type N in column C of the line you want printed.
» Using logical value formulas to include and exclude lines. You can place a logical value formula

(TRUE/FALSE) in column C. If the formula in column C returns TRUE, Financial Reporter does not
print the line. If the formula returns FALSE, the line is printed.

For example, will check if the value in column F is less than 10% of the value in
column G. If the statement is true, the line will be omitted from the report.

Note: Anything that appears in column C on a default specification line will be used by all subsequent
lines unless you specifically override it.

About Expression Syntax for Selection Criteria

The easiest way to create a selection criteria expression is to use FR Paste. For more information, see
"About FR Paste" (page 88).

You can also enter expressions directly into spreadsheet cells.

A simple criteria expression looks like this:
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A more complex one looks like this:

ACCTTYPE and QTYSW (quantities switch) are fields in the account master file. All other fields in this file
are listed in the next section.

Selection criteria use account master fields only. For more information, see "Account Master Fields" (page
164).

Left-to-Right Evaluation

Selection criteria expressions are evaluated strictly from left to right unless brackets are added. In other
words, the above example will be evaluated as:

The expression will select all accounts that contain the word "sale" in their description, and it will select all
income statement accounts that also store quantities.

Note: Criteria are case-sensitive, so a description with “Sale” will be excluded.

Brackets

You may use brackets to change the order of evaluation. For example:

will select income statement accounts that store quantities, or that contain the word "sale" in their
description.

All the relational operators work with all the field types except for switches (like QTYSW), where only the
and (not equal) operators apply.
Spaces

You use spaces to separate field names, operators and constants in expressions. For this reason, if you
are comparing a string that includes spaces, you must enclose the entire string in quotation marks.

Quotation Marks

Remember that criteria are text parameters. If you place criteria in formulas, you must enclose criteria
text in quotation marks.
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If you paste criteria in column B, you will notice that FR Paste inserts them as formulas containing text.
For example:

FR Paste adds an extra pair of quotation marks around text values to accommodate spaces within the
text strings.

If you paste a formula with criteria, it looks like this:

If this is a default line column specification, the middle parameter in the formula will take on the account
reference specified in column A.

LIKE

The operator is similar to the = operator, except the second operand can contain the wild cards

and

« % matches any group of characters.

« matches any single character.

So is true for any accounts with descriptions that include the word

"sale." This would include "Product B sales," as well as "Cost of sales."

Optional Fields

Selection criteria can also include optional fields. For example, the following expression restricts the
results to accounts with account optional field ACCTCLASS = Sales:

And, the following expression restricts the results to transactions with transaction optional field
QUANTITY<=0:

For more information, see "About Optional Fields in Financial Reports" (page 35).

About Wildcard Characters in Account Numbers

You can use two wildcard characters when specifying account numbers:
« The underline character, , is a placeholder for one character.

« The percent character, -, is a placeholder for one or more characters.
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Example:
Using Wildcard Characters

Account Description
number
specification

A123%[sc] Specifies all single segment account numbers starting with the characters
“A123.

D_6834 Specifies all single segment accounts sharing the same first character (D),
followed by one character of any value, and ending with the same four
characters (6834).

Note: You cannot use the Finder with FR Paste to insert wildcard characters. You must type in the
wildcard characters yourself.

"%%" is Not a Wildcard Character

Although resembles a wildcard character, it is used in only two very specific ways:
. specifies all account numbers in the ledger. (See the QUIKINC and QUIKBAL statements that
come with General Ledger.)

. specifies all account numbers starting with 6000—no matter how many segments they
have. (This specification has the same effect as )

Example:
In this example, account number selection is based solely on the account group specified in column B.

A B

%% | ACCTGRPCOD=1

%% ACCTGRPCOD=2

%% ACCTGRPCOD=3

Financial Reporter will list all Current assets, then all Fixed assets, and, finally, all Other assets.

Unless you process accounts by ACCTGROUP, Financial Reporter must scan every account in the
ledger to see if it fits the criterion in column B.
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Tip: To get the best performance from Financial Reporter, you should use specific account references,
and specify account processing orders that complement the references. For more information, see

"About Account Order in Financial Statements" (page 47).

Note also that you cannot combine account reference ranges with wildcard characters. For example,
is not allowed.

However, you can combine account references in a list, such as

About Formatting Financial Statements

All formatting of financial statements is controlled by the Financial Statement Designer's formatting
commands. For more information about controlling tab size, tab headings, font size, and style, refer to the
help and documentation for Microsoft Excel.

The most efficient method for formatting the area and the text within a cell is to create a style that includes
various attributes (such as bold text, currency format, right alignment, and so on), and then apply the
style to spreadsheet cells.

Adding Title Lines

The first five lines of the report specification are the title lines, which are repeated at the top of each tab of
the report.

You can specify up to five lines that will appear at the top of each tab of a financial statement.
You can define only one set of title lines in a specification. All title lines must be together (contiguous).

If you have defined more than one set of title lines, Financial Reporter uses the last set in the
specification.

Example:

The Universal Corporation
Balance Sheet As of October 31, 1999

Current Balance
Petty cash 274.57
Bank account 8,437.54
Bank account, CAD dollars 4,372.96
Total: 13,085.07
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If you want the title to appear only on the first tab of the report, leave the first column for these rows blank.
The rows are transferred "as is" to the beginning of the Report range.

Note: If you use the Financial Reporter \T line, you cannot separately mark a group of cells as title
lines. Title lines must be consecutive, and cannot be split by a tab break.

Adding Explanatory Comments (..)

We suggest you begin every specification with a few comment lines describing it, and add comments
throughout to explain important sections of your specifications.

You can make any line of a report specification a comment line by starting column A with two periods. For
example, the following four lines are in cells A1 through A4 of a report specification:

|.. Specification name: INC51

This specification file will produce a statement of earnings with one
column of figures showing current year to date results.

Grid Lines and Other Report Formatting

You specify all formatting for financial reports in the Financial Statement Designer's using Microsoft Excel
formatting commands.

For example:

» To select the character font, bold type, left or right alignment, number appearance, cell borders
and patterns, you use the commands in the Font and Alignment groups (on the Home tab of the
Excel ribbon).

e Toturn the spreadsheet grid on or off for printing, and turn on or off the row and column labels, you
select options in the Show group (on the View tab of the Excel ribbon).

» Toforce a tab breaks in the printed report, use the Set tab Break command in the corresponding
position of the report specification. Set the tab break in column A of the spreadsheet. (Note that the
cell containing the tab break creates a vertical tab break as well as a horizontal one.)

All formatting applied to rows or columns in a report specification is applied to the rows and columns of
the generated report.

To see the effect of all tab formatting in the Financial Report Designer, click File > Print to see a preview
after you have used FR View to generate the report.

Hiding Columns and Rows

It is often useful to have statement columns and rows that you don't want printed on your final report. For
example, you may have statement rows that contain intermediate rounding calculations.
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To hide a column, you can do either of the following:
» Right-click the column, select Column Width, and then set width to 0.

» Click and drag the edge of the column until its width is 0.

To hide a row, you can do either of the following:
» Right-click the row, select Row Height, and then set height to 0.
» Click and drag the top or bottom edge of the row until its height is 0.

About Page Layout

The File > Page Setup command controls the page layout and allows you to set headers, footers, and
margins in a spreadsheet.

Printing Column Headings with Options/Set Print Titles

To print recurring column headings at the top of each page, use the Financial Statement Designer's Set
Print Titles feature.

Setting Page Breaks

If you set a page break in the report template, Financial Reporter treats the page break as an "As is" row.

and inserts it in the corresponding point in the final report.

The main use of page breaks is to begin new sections of a statement at the top of a page, or to ensure
that all columns to the right of the page break appear on a separate page. Page breaks create a
horizontal and a vertical division where you insert them in a spreadsheet.
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Page Breaks
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The above diagram shows the effect of setting two page breaks: one in cell A11, which creates a
horizontal break, and one in cell H23, which also creates a vertical break.

Page breaks are not very useful for statements containing account references that are expanded into
many rows. They work best for starting sections of a report on a new page.

Generally, for multi-page reports, you can either leave the pagination to the Financial Statement
Designer, or you can print the report to a file (or copy it to a word processor), then add whatever
embellishments you want in the report file before printing a final report.

About the Spec Range

The Spec range is a named range of spreadsheet cells that begins with the first row and column of the
report specification, and includes all cells that are part of the specification.

Before you can generate a report from a report specification, you must define the Spec range for your
spreadsheet.

Note: The Spec range is already defined in all financial report specifications that come with Financial
Reporter.
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To check for a Spec range:
1. On Excel's ribbon, click Formulas > Name Manager.

2. If"Spec"is not listed in the Name Manager window, click New, and then define the Spec range.

Layout of the Spec Range
Columns with control information Columns that form the statement template
(A-D) (E-H)
A B C D | ET] F ! G ! H

.. Specification name: Quikhalz

.. This specification file will produce a balance sheetwith colurmns for
.. the current vear balance and the previous year balance as atthe currentfiscal period.

Sample Company £ imited
Balance Sheet
August 31, 2019 and August 31, 2018

Unaudited
ASSETS
WACCTGROUP z DiACCT) - 0.00 0.00
Current Previous
ear Year
Current assets:
%% ACCTGRPCOD ="01" OR ACCTGRPCOD = "02" ORY, Y Y
Total current assets 0.0a 0.0a
Fixed assets:
%% ACCTGRPCOD = "05" , y Y
4 ACCTGRPCOD = "08" T Less accumulated depreciation - -
0.00 0.00
Dther assets:
%% ACCTGRPCOD ="07" Y Y Y
0.00 0.00
0.00 0.00

LIABILITY AND SHAREHOLDER'S EQUITY

Current liahilities:
%% ACCTGRPCOD ="08" OR ACCTGRPCOD = "03" ORY, - -
Total current liahilities 0.oa 0.0a

S A R N N e P g P T P P P s
RO IS ©ewad i oo~Neogewmo o @NSO RN -

The first four columns of the Spec range (A through D) are reserved for control information for Financial
Reporter.

The other columns form a template that determines the appearance of the report and the type of data that
it retrieves.
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Note: A specification can begin in any column of a worksheet, but the first column of the Spec range
must be the first column of the specification. We always refer to the first column of the specification as
column A. (There is no reason why you should start a specification anywhere else.)

Redefining the Spec Range

If you want to redefine the spec range in your worksheet after generating a report, use the FR Clear
command to clear up the report area, and then make your changes to the spec range.

Setting the Spec Range

The Spec range is a named range of spreadsheet cells that begins with the first row and column of the
report specification, and includes all cells that are part of the specification.

Before you can generate a report from a report specification, you must define the Spec range for your
spreadsheet.

To define the Spec range in a Financial Reporter spreadsheet:

1. With the statement spreadsheet open in Excel, select the complete report specification, from the
first row and column to the last row and column.

2. Onthe Excel Ribbon, click Formulas > Define Name.

3. Type as the range name, then click OK.

Important! You must type exactly these letters, although the capitalization doesn't matter.

Note: You do not define a Report range for the spreadsheet. Financial Reporter defines the Report
range when it generates the report from a specification.

About the Report Range and the Print Range

The Report range is generated from the Spec range when you print the financial report. It contains data
that is generated by the report, as well as data extracted from the General Ledger.

The template portion of the specification expands in the final report to display the actual general ledger
data.

The control information in the first four columns of the specification is replaced by audit information in the
report range—the numbers of the accounts from which the information was taken.

When you print the report, Financial Reporter prints all but the first four columns of the Report range
(omitting the audit information).

The area it prints is called the Print range.
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Consolidating the Financial Statements of Multiple
Companies in Microsoft Excel

These instructions assume that the statement you are consolidating consists of a single worksheet in
Excel.

To consolidate financial statements:
1. In Sage 300, open the largest company.
2. Open General Ledger > Financial Reporter > Statement Designer, and then click Start.

3. Open the financial statement that you want to consolidate, and save it as a new workbook.

Tip: Save the workbook with a name that identifies it as a consolidated statement.

4. Review column C of the financial statement specification to make sure it does not suppress blank
lines. (You use a ” to suppress blank lines.)

5. Turn on manual calculation in Excel.
a. Click File > Options.
b. On the Formulas tab, in the Calculation options group, select Manual.
c. Click OK.

You can recalculate values at any time by pressing the F9 key.

6. For each company that you want to consolidate, copy the worksheet for the company to the
workbook in which you are consolidating statements.

a. Click the worksheet tab to select it.

b. Onthe Home tab, in the Cells group, click Format, and then under Organize Sheets, click
Move or Copy Sheet.

The Move or Copy window appears.
c. From the To book list, select the workbook in which you are consolidating statements.
d. From the Before sheet list, select (move to end).
e. Select the Create a copy option.
f. Click OK.

7. Rename each worksheet for the company it represents, saving the workbook frequently. (To
rename the worksheet, right-click the worksheet tab, and then click Rename.)

8. When you have created one worksheet for each company, click the sheet for the company you
opened in Sage 300, and then use FR View to generate the financial statement.
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10.

11.

12.

13.
14.
15.

16.
17.

For more information about FR View, see "FR Menu Commands" (page 85).

Right-click the tab for the first sheet in the workbook, click Insert, and then click Worksheet insert
a blank worksheet, which you will use to create the consolidated statement.

Right-click the new worksheet, click Rename, and then type a name for the worksheet.

Note: These instructions use as the name for this worksheet.

Generate and save statements for each additional company you want to consolidate.
a. In Sage 300, open the company.
b. Open General Ledger > Financial Reporter > Statement Designer, and then click Start.

c. Use FR View to generate the statement, using the same options you specified for the first
company.

d. Save the workbook and close the Statement Designer.

Open the worksheet you created, and then open a new window for each worksheet,
arranging them so they are all in view and their contents are aligned.

a. Onthe View tab, in the Window group, click New Window.
b. On the View tab, in the Window group, click Arrange All, and then select Vertical.

c. Ineach window, select a different tab, and scroll to align the contents of each window so
that the first description in each generated report aligns with the top cell in the window.

In the worksheet that contains the most accounts, select and copy the print area.
In the worksheet, right-click cell A1, and then select Paste Special > Values.

Without deleting any blank lines, use Excel to format the statement as needed.

Note: You may have to insert lines for accounts that appear in one ledger, but not in others.

Clear all amounts from the report.

Sum the accounts for like accounts across all worksheets, so that totals for all companies appear
in place of the amounts you erased in the previous step.
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Chapter 4: Printing Financial Statements

Important! Printing using the Statement Designer is not the same as printing using the Print Financial
Statements screen.

When you print using the Statement Designer:

e You can generate an audit information tab as well as account audit information in the first column
of the report.

The audit information tab lists information such as the print ranges and any specified processing order.

* You can create formulas for each value that appears in the report range instead of the values
themselves.

This means that you can update the report simply by recalculating the spreadsheet.

Note: Spreadsheet formulas make the spreadsheet a lot larger.

* If you generate a series of statements for a group of departments, the separate statements are
generated in consecutive sheets in an Excel workbook.

When you print a set of statements using the G/L Print Financial Statements screen, Financial Reporter:

* Repeats the report generation process for each account segment.

 Prints a series of separate statements.

For instructions, see "Printing a Financial Statement" (page 71).

Tip: Keep financial ratios and graphs in a formula sheet. (The most common type of "formula-only"
report is one that keeps financial ratios.)

There are two main advantages of a report that is composed only of formulas:

1. The report has the same cell references each time you use it.

2. The report area remains intact when you recalculate the report. (If you generate a report from a
specification, the old report is cleared before the new one is generated.)

Because the spreadsheet remains the same each time you use it, you can include graphs in your reports
and be sure of the data you are referencing.
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Printing Reports With and Without a Spec Range

If a spreadsheet has formulas only (with no Spec range), you cannot use FR View to calculate and print
the report. Instead:

* You press 9 to calculate the values of the formulas.
» Financial Reporter recalculates the spreadsheet when you print the report.

« If you do not want to print the whole spreadsheet, you can use Excel's Set Print Area command to
define the area you wish to print.

If the spreadsheet has a defined Spec range, Financial Reporter automatically regenerates the financial
statement before printing it. All the columns included the Spec range are included on the printed
statement, except columns A, B, C, and D.

Preparing to Print Reports

If report information extends beyond the right edge of the spreadsheet print area, it may be cut off.
You can modify a report specification to make sure that report information is not truncated by:

« Widening the spreadsheet column that contains the extra-wide result.

» Redefining the Spec range to include the columns over which the information extends.

This approach works because the right print area boundary of a financial statement that is generated
from a specification is the same as the Spec range boundary.

Printing a Financial Statement

To print a financial statement in Financial Reporter, you can use either of the following methods:

e Use the G/L Print Financial Statements screen to specify print options and print the financial
statement.

» Open a financial statement specification in the Statement Designer, use FR View to generate the
statement, and then print.

The following procedure describes how to use the G/L Print Financial Statements screen. For information
about using the Statement Designer to print financial statements, see "About Generating Reports from
Specifications" (page 26) and "G/L Statement Designer" (page 28).
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To print a financial statement:

1.

2.

Open General Ledger > Financial Reporter > Print Financial Statements.
Click Browse, and then select a financial statement file.

For a list of sample financial statements included with Sage 300, see "Sample Financial Statements"
(page 79).

Under Fiscal Option, specify the year and period for which to create the statement.
Under Report Type, specify whether to include actual or provisional amounts in the report.

¢ Actual. Includes only amounts that have been permanently posted to general ledger
accounts.

< Provisional. Includes amounts that have been provisionally posted to general ledger
accounts, as well as permanently posted amounts.

Under Report As, specify whether to print a single, consolidated report, or to print separate reports
for different account number segments.

Note: The Separate option is available only after you select Segment in the Sort By area of the
screen, and then enter the range of segments. (This option is not available if you select the Account

segment.)

Under Include, select the Report Options and/or DrillDown Information options as needed.

When you select Report Options, the first page of the financial statement displays the following
information:

» Statement name

 Fiscal year and period

¢ Report type (actual or provisional)

¢ Account processing and sorting order
¢ Account selection ranges

On the G/L Print Financial Statements and Statement Designer screens, you can select the DrillDown
Information option to add drilldown link comments to the generated report. The Drilldown Information
option is available only when you select File or E-Mail under Print Destination. For more information,
see "About FR Drilldown" (page 86).

For information about the Audit Information and Formulas options, see "G/L Statement Designer" (page
28).
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7. Under Sort By, specify the order in which to sort records in the printed financial statement.

« If you select Account No., you can use the From and To fields to specify a range of account
numbers to include, or leave the default values in these fields to include all account numbers.

« If you select Segment, select a segment in the list that appears. You can use the From and
To fields to specify a range of account numbers to include, or leave the default values in
these fields to include all segments.

8. Specify account groups or sort code groups to include.

« If you want to select account groups by sort code range, select the Select Account Groups
By Sort Code Range option. You can use the From Sort Code - Account Group and To
Sort Code - Account Group fields to specify a range of sort codes to include, or leave the
default values in these fields to include all sort codes.

« If you did not select the Select Account Groups By Sort Code Range option, you can use
the From Account Group and To Account Group fields to specify a range of sort codes to
include, or leave the default values in these fields to include all sort codes.

9. Inthe table, specify optional ranges of segments. If you selected Separate under Report As in
step 5, you can double-click the Report As column to select Separate or Consolidated.

10. Select a print destination.

11. Click Print.

G/L Print Financial Statements Screen

To Open this Screen

Open General Ledger > Financial Reporter > Print Financial Statements.
Secondary Screens
¢ "Print for Financial Statements Screen" (page 77)
Related Tasks

e "Printing a Financial Statement" (page 71)

Overview

Use the G/L Print Financial Statements screen to print standard or custom financial statements for your
general ledger data.

Sage 300 2023 Financial Reporter User's Guide 73



You can select one of several statement specifications included with General Ledger to print a standard
financial statement.

You can also select a statement specification that you have created and saved using the Financial
Statement Designer.

The Print Financial Statements screen displays a variety of options that you can use to print a report.

Important! Printing using the Statement Designer is not the same as printing using the Print Financial
Statements screen.

For more information, see "Printing Financial Statements" (page 70).

Fields and Controls

Buttons

Close

Click Close to close the screen.

Print

Click this button to open the Print Financial Statements screen, where you:
« Specify the printer on which to print the statement.
» Select the size of paper that best accommodates the statement.
» Specify the orientation of the statement (portrait or landscape).
» Specify the number of copies to print.
Fiscal Option (Year/Period)
Specify the year and the fiscal period for the report.

You can print financial reports as of any past period for which you have data in General Ledger.

Include

You can choose to include the following information when you print statements using the G/L Print
Financial Statements screen:
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* Report Options

When you select Report Options, the first page of the financial statement displays the following
information:

+ Statement name

 Fiscal year and period

Report type (actual or provisional)
¢ Account processing and sorting order
¢ Account selection ranges

» Drilldown Information

Note: The Drilldown Information option is available only after you select File or E-mail in the Print
Destination area of the screen.

The recipient of an e-mailed statement must be using the same database, with General Ledger
installed, to drill down to underlying transactions in the report.

Print Destination

For Financial Reporter statements, you use the Print Destination settings on the Print Financial
Statements screen. (These statements do not use the destination specified for other Sage 300 reports
from the Print Destination tool on the desktop.)

At print time, you select one of the following destinations:
* Printer. Print to a physical printer.
» Preview. Display the report on your computer screen.
e File. Save the report as afile.
If you select File as the print destination:

* You specify whether to save the file in Excel format or in text format. Financial Reporter
then saves all the values in the report's Print range in that file format.

« When you print, Financial Reporter assigns new file names based on the original Financial
Report spreadsheet name, followed by a sequence number. For example, if the
spreadsheet was named BALANCE.XLS, the print file spreadsheet would be named
BALANCE.001 or BALANCE.001.xls, depending on the format you chose.

If statement printing generates a series of reports (for example, a departmentalized report), the
separate reports will be numbered BALANCE.001, BALANCE.002, BALANCE.003, and so on.

» E-mail. Send the report as an attachment in an e-mail message.
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Report As

You can print a single, consolidated report, or you can print separate reports for different account
number segments. For example, if one of your account number segments is a department code, you
can print a separate report for each department.

Note: Before you can select Separate, you must select Segment and specify a segment that is not

the Account segment.

To print separate reports, you must print by any segment except the account segment. In other words, if
you have three segments in your account numbers, Region, Department, and Account, you must sort by
the Region segment or the Department segment.

Tip: To print separate reports by Region and Department, you choose the Region or Department

segment for the Sort by selection, then, in the segment table, choose Separate for the other segment.

When using the Print Financial Statements screen to print financial statements, the report is generated
for each account segment code, printing each separate report in turn.

Report Type
Financial Reporter allows you to print one of two groups of data:

» Actual. Includes only amounts that have been permanently posted to general ledger accounts.

» Provisional. Includes amounts that have been provisionally posted to general ledger accounts,
as well as permanently posted amounts.

This option affects only formulas that are not explicitly set as Actual or Provisional in the statement
specification.

The report specification can also have the following effects at print time:

» Prefixes used for NET and BAL determine the fiscal set. NET and BAL can have a prefix A, P, Q, QA,
QP, 1, 2, 3, 4 or 5, to indicate Actual, Provisional, Quantity, Actual Quantities, Provisional Quantities,
or any of the five budget sets. For example:

« ABALP provides the actual balance at the current fiscal period.
» 1BALP provides the balance from budget set 1 for the current fiscal period.

« BALP provides either the actual balance or the provisional balance, depending on the
report type you select at print time.

« If you do not specify a prefix or if you select Q, the default is either actual or provisional,
depending on the report type.
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Sort by

You can order accounts on financial statements by account number, by a particular segment of the
account number, by the account group, or by account group sort code.

You may then specify a range for the item by which you are ordering the report.

The sort order you select does not override account sorting orders that are specified in the report. If the
sorting order is crucial to the contents of the report, you should build it into the report specification.

Note: To print separate reports, you must print by any segment except the account segment. In other
words, if you have three segments in your account numbers, Region, Department, and Account, you

must sort by the Region segment or the Department segment before you can select Separate for the
Report as option.

Sorting order affects the order in which accounts within a range will appear on a financial report, and it
affects the report processing efficiency.

For more information, see "About Account Order in Financial Statements" (page 47).

Select Accounts Fields and Table
Use the From and To fields to restrict the accounts included on a financial statement to:

» Arange of account groups (unless the report is ordered by account group).

» Ranges of account segment codes (such as a range of departments and/or range of regions).

You can also print separate reports by account number segments. For example, to print separate
reports for each department in each region of your company, you select Sort by Region, and then when
selecting accounts in the table, select Report as Separate (by double-clicking Consolidated).

Print for Financial Statements Screen

To Open this Screen

1. Open General Ledger > Financial Reporter > Print Financial Statements.
Specify the statement name.
Select printing options.

Click Print.

A w N
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Related Tasks

"Printing a Financial Statement" (page 71)

Overview
Use the G/L Print for Financial Statements screen when printing statements in Financial Reporter to:

» Specify the printer on which to print the statement.
» Select the size of paper that best accommodates the statement.
» Specify the orientation of the statement (portrait or landscape).

» Specify the number of copies to print.
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Appendix A: Sample Financial
Statements

Financial statements are Microsoft Excel spreadsheets that use special functions to extract data from the
Sage 300 company database.

General Ledger includes the following standard financial statements. English-language statements are
located in the ENG subfolder of the General Ledger program folder. If are using another supported
language version of Sage 300, you'll find your statements in a language-specific folder. For example,
French statements are located in the FRA subfolder and work with French-language Excel.

Important!
The sample statements are designed for Sage 300 sample data, and retrieve data using standard
account groups.

To use the statements with your own data, you must either:

¢ Assign the same standard account groups to your accounts.

¢ Customize the sample statements to match the account groups that you have set up for your
company.

To modify a sample statement, first copy the file and then save it with a new file name.

Balance Sheets

General Ledger includes standard balance sheet statements and summaries.
The sample summaries include:

« Aregular size balance sheet that summarizes the company's assets, liabilities, and equity at a
specific point in time.

« A common size balance sheet, which includes a regular size balance sheet, and separate reports
listing asset line items as a percentage of total assets, and liability line items as a percentage of
total liabilities.

» Common size balance sheets that also include graphical summaries, statements for specified
periods, comparisons of current and previous year amounts, and comparisons of current year and
budget amounts.
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Note: All sample balance sheets include the profit or loss for the period.

Balance Sheet Statements

General ledger includes the following sample statements:

. Standard Balance Sheet (single column)
. Comparative Balance Sheet (Current Year / Previous Year)
. Comparative Balance Sheet (Current Period / Previous Period)

Balance Sheet Summaries

General ledger includes the following sample statements:
. Common Size Balance Sheet Summary
A summary as amounts and as a percentage of total assets and liabilities, printed on separate pages.
. Balance Sheet Summary with Graphs

A summary as amounts and a graph as a percentage of total assets and liabilities. Asset summaries
and liability summaries are printed on separate pages.

Important! Financial Reporter does not generate this report. Rather, the report uses data from fixed
cells in the Excel spreadsheet, and may not print the correct information if the report is generated
with the [Include] Report Options setting. If you are printing the report from the G/L Print Financial
Statements screen in Sage 300, make sure that [Include] Report Options is not selected.

Note: For Excel-based charts, the default position of data labels varies by Excel version. To add or
remove data labels or modify their position, refer to the help or documentation provided with your
installed version of Excel.

. Balance Sheet Summary for Specified Period
A summary of the balance sheet for a specified period.
. Comparative Balance Sheet Summary (Current Year / Previous Year)
A comparison of current and previous year amounts, and variance by amount and percentage.

. Comparative Balance Sheet Summary (Current Year / Budget)
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A comparison of actual and budgeted amounts for the current year, and variance by amount and
percentage.

Income Statements

General Ledger includes standard income statements and income statement summaries.
The sample summaries include:

» Aregular size income statement that summarizes the company's profit or loss for a specified
period.

e A common size income statement, which includes a regular size income statement, and separate
reports listing line items as a percentage of sales revenue.

» Common size income statements that also include graphical summaries, statements for specified
periods, comparisons of current and previous year amounts, and comparisons of current year and
budget amounts.

Tip: You can use Excel formulas and functions to display amounts as percents or ratios.

Standard Income Statements

General ledger includes the following sample statements:

. Standard Income Statement (single column)

. Comparative Income Statement (Current Year to Date / Last Year to Date)
. Comparative Income Statement (Current Year to Budget)

. Comparative Income Statement (Current Year with Drilldown)

Use this statement to drill down to an originating transaction. For more information, see "About FR
Drilldown" (page 86).
Income Statement Summaries

Income statement summaries display each account as a percentage of sales revenue, allowing financial
managers to see how the company’s profit is affected by income statement components.

General ledger includes the following sample statements:
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. Common Size Income Statement
A summary as amounts and as a percentage of sales revenue, printed on separate pages.
. Income Statement Summary with Graphs

A summary as amounts and a graph as percentages of total revenue.

Important! Financial Reporter does not generate this report. Rather, the report uses data from fixed
cells in the Excel spreadsheet, and may not print the correct information if the report is generated
with the [Include] Report Options setting. If you are printing the report from the G/L Print Financial
Statements screen in Sage 300, make sure that [Include] Report Options is not selected.

Note: For Excel-based charts, the default position of data labels varies by Excel version. To add or
remove data labels or modify their position, refer to the help or documentation provided with your
installed version of Excel.

. Income Statement Summary for Specified Period

A summary of the income statement for a specified period.
. Comparative Income Statement Summary (Current Year / Previous Year)

A comparison of current and previous year amounts, and variance by amount and percentage.
. Comparative Income Statement Summary (Current Year / Budget)

A comparison of actual and budgeted amounts for the current year, and variance by amount and
percentage.

Financial Analysis Statements

Analysis statements display financial ratios used by financial managers to evaluate a company's
performance.
Financial Ratios

For some of the following sample statements, you must enter financial ratios for a benchmark company—
an average company in your industry—on the Benchmarks worksheet.

General ledger includes the following sample statements:
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Financial Ratios

A summary of the financial ratios for the current period grouped into the following categories:
Profitability, Asset Utilization, Liquidity, Debt Utilization, and Growth.

Financial Ratios and Benchmarks
A comparison of the company's financial ratios to the benchmark, and the variance between the ratios.
Financial Ratios and Benchmarks with Graphs

A graph comparing the company's financial ratios to the benchmark.

Important! Financial Reporter does not generate this report. Rather, the report uses data from fixed
cells in the Excel spreadsheet, and may not print the correct information if the report is generated
with the [Include] Report Options setting. If you are printing the report from the G/L Print Financial
Statements screen in Sage 300, make sure that [Include] Report Options is not selected.

Note: For Excel-based charts, the default position of data labels varies by Excel version. To add or
remove data labels or modify their position, refer to the help or documentation provided with your
installed version of Excel.

Comparative Financial Ratios (Current Year / Previous Year)

A comparison of the company's financial ratios for the current and previous years, and the variance
between the ratios.

Comparative Financial Ratios and Benchmarks with Graphs (Current Year / Previous
Year)

A graph comparing the company's financial ratios for the current and previous years to the benchmark.

Important! Financial Reporter does not generate this report. Rather, the report uses data from fixed
cells in the Excel spreadsheet, and may not print the correct information if the report is generated
with the [Include] Report Options setting. If you are printing the report from the G/L Print Financial
Statements screen in Sage 300, make sure that [Include] Report Options is not selected.

Note: For Excel-based charts, the default position of data labels varies by Excel version. To add or
remove data labels or modify their position, refer to the help or documentation provided with your
installed version of Excel.
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Financial Forecasts

Use financial forecasting to assess your current operating performance, and project how your business
will perform in the future.

creates a forecasted income statement and balance sheet. The statements include actuals
for the current and previous years, and projected amounts for the next three years based on the
percentage of sales revenue growth.

Note: The forecasting method assumes that certain expenses, assets, and liabilities maintain a
constant relationship to the level of sales. To perform what-if analysis, enter projected percentages for
revenue growth and other line items in the Adjustments area of the statement specification.
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Appendix B: FR Menu Commands

When you use the Statement Designer to open a Microsoft Excel worksheet, an Add-Ins tab appears on
the Excel ribbon. On this tab, the FR menu displays commands you can use to create and edit financial
reports and specifications.

FR Menu Commands

Command Description Notes

FR Clear Clears the report range from a * You usually use FR Clear before saving a

previously generated financial final version of a specification after
statement developing and testing it.

* You do not need to use FR Clear before
using FR View to generate a report.
However, by clearing the report range first,
you save a smaller spreadsheet and one
that will take less time to load whenever you
print the financial report.

FR Drill down to transactions after | For more information, see "About FR Drilldown"
Drilldown generating a financial (page 86).

statement that contains
formulas for transactions.

FR Help View help for the Financial
Statement Designer.

FR Options | Specify whether the opening * Use Budget Opening Balance. Select this
. . option to display the budget amount carried

budget or °pe”'”9 qua.ntlty for forward from the previous year.

an account on a financial

Note: If there is budget information for the
current year, this option is ignored and the
information for the current year is displayed.

statement should be carried
forward from the previous year.

» Use Quantity Opening Balance. Select this
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Command Description Notes

option to display quantities carried forward
for accounts that use the Maintain
Quantities option.

Note: If there is quantity information for the
current year, this option is ignored and the
information for the current year is displayed.

Tip: If you change a selection, run FR View to
update your report.

FR Paste Inserts Financial Reporter For more information, see "About FR Paste"
functions, account numbers, (page 88) and "Using FR Paste to Insert
and selection criteria. Information in Financial Reports" (page 90).
FR View Opens the G/L Financial For more information, see "G/L Statement
Statement Designer screen, Designer" (page 28).

which you use to generate
financial statements from report
specifications.

FR Menu Commands

About FR Drilldown

On the G/L Print Financial Statements and Statement Designer screens, you can select the DrillDown
Information option to add drilldown link comments to the generated report.

Drilldown instructions are stored in the comment object of a cell. After generating a report, you can right-
click a results cell, and then click FR DrillDown to view transaction details.

Note: The recipient of an e-mailed report must be using the same database, with General Ledger
activated, if they want to drill down to underlying transactions in the report.

Warning! A spreadsheet containing a large number of drilldown links may be slow to open, or fail to
open, in the Statement Designer and in Microsoft Excel.

When you use the Statement Designer to open a Microsoft Excel worksheet, an Add-Ins tab appears on
the Excel ribbon. On this tab, the FR menu displays commands you can use to create and edit financial
reports and specifications. The FR Drilldown command appears on this menu. You use it to view original
transactions after a report has been generated in the Financial Statement Designer.
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Note: You must use the FR View command to generate a report before you can use FR DrillDown.

FR DrillDown Example

The sample spreadsheet uses the transaction function FRTRNA to demonstrate drilldown.

In the sample spreadsheet, the formula produces a statement of earnings with
one column of figures showing current year-to-date results. The comment displayed explains how to drill
down to the transaction.

To see how FR Drilldown works, perform the following steps in the sample spreadsheet
1. On the Excel ribbon, on the Add-Ins tab, click FR > FR View.
2. Click OKto run FR View.

The report is generated. Results cells where FR DrillDown is available appear with a red mark in the top

right corner of the cell.

3. Right-click a report cell, and then then click FR DrillDown.

The original transaction details appear in a new window.

Formulas that Support FR Drilldown

FR DrillDown works only with formulas that contain the following transaction functions:
« FRTRN
« FRTRNA

FRTRNCR
 FRTRNDR

FR DrillDown is not available for formulas that contain edited versions of the following transaction
functions:

* FRTRN

* FRTRNA
* FRTRNCR
* FRTRNDR

The following are examples of edited commands:
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For information about other menu commands in the Financial Statement Designer, see "FR Menu
Commands" (page 85).

About FR Paste

When you use the Statement Designer to open a Microsoft Excel worksheet, an Add-Ins tab appears on
the Excel ribbon. On this tab, the FR menu displays commands you can use to create and edit financial
reports and specifications.

The FR Paste command appears on this menu. You use it to paste formulas into spreadsheet cells to
retrieve and display the following General Ledger data:

» Account numbers. For more information, see "About Account Number References" (page 54).

« Account selection criteria (Qquery-by-example expressions). For more information, see "About
Selection Criteria for Filtering Accounts" (page 57).

» Financial Reporter functions. For more information, see "Financial Reporter Functions" (page 94).

+ Rolled up amounts.

Note:
» Onthe FR Paste Function screen, use the Rolled Up Amounts option to specify whether
or not to paste rolled up balances or quantities into reports for rollup accounts. This option
is available for FRAMT, FRAMTA, FRCREDIT, and FRDEBIT only.

« Take care when creating the rollup group to avoid ending up with doubled amounts in the
final report.

« Select the Rollup Members Account option to include balances or quantities for rollup
member accounts whose balances or quantities are also being rolled up to their rollup
account in the same paste function in the report.

For information about other menu commands in the Financial Statement Designer, see "FR Menu
Commands" (page 85).

Pasting Single Values and Default Column Specifications

The following are typical single values you will paste in a financial report:
e Company name
» Period-end date (or today's date)
 Division or department for which the report is printed

e Asingle account balance
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For each of the above items, you will paste a complete formula, and you will probably not have to edit the
result.

Pasting Column Formulas

If you are pasting a formula to use as a default column specification, do not enter an account reference
(because you will be supplying that in column A of each line that uses the default column specification).

For example, the formula for a single cell might be , Whereas a default

column formula would be

For instructions on using FR Paste, see "Using FR Paste to Insert Information in Financial Reports" (page
90).

About the Fiscal Designator

When you use the Statement Designer to open a Microsoft Excel worksheet, an Add-Ins tab appears on
the Excel ribbon. On this tab, the FR menu displays commands you can use to create and edit financial
reports and specifications.

The FR Paste command appears on this menu. On the FR Paste Function screen, the Fiscal Designator
is a drop-down list that appears for the FRAMT, FRAMTA, FRDEBIT, FRCREDIT, FRTRN, FRTRNA,
FRTRNCR, and FRTRNDR functions. The list shows the fiscal set options you can select:

e Budgetsets1,2,3,4,and5

* A. Actual monetary figures

» P. Provisionally-posted monetary figures
» Q. Quantities (either actual or provisional)
* QA. Actual quantities

* QP. Provisionally-posted quantities

Note:
The FRTRN, FRTRNA, FRTRNCR, and FRTRNDR functions include only the following options:

¢ A. Actual monetary figures
* Q. Quantities (either actual or provisional)

* QA. Actual quantities

Whether actual or provisional figures or quantities appear depends on the default you select on the
Preview Financial Statements screen at the time you print a report.
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Using FR Paste to Insert Information in Financial Reports

When you use the Statement Designer to open a Microsoft Excel worksheet, an Add-Ins tab appears on
the Excel ribbon. On this tab, the FR menu displays commands you can use to create and edit financial
reports and specifications.

The FR Paste command appears on this menu. You use it to paste formulas into spreadsheet cells to
retrieve and display General Ledger data. For more information, see "About FR Paste" (page 88).

To insert information using FR Paste:

1.
2.

In the Statement Designer, select the cell where you want to insert General Ledger data.

On the Excel ribbon, on the Add-Ins tab, click FR > FR Paste.

The FR Paste Function window appears. Below the Functions list and available selections, a cell
reference (such as ) and formula (such as ) appear. As you select
options, this area is updated to display the current formula.

In the bottom left corner of the screen, the function builds as you select options.

From the Functions list, select a function, account reference, or selection criteria expression.

When you select a function, available options and parameters for the function appear to the right of the
list. Depending on your selection, these may include account numbers, account ranges, selection
criteria, currency type, and other options.

Specify options for the function, account reference, or expression. For more information, see
"Financial Reporter Functions" (page 94).

If you are specifying account numbers, you can specify individual account numbers or a range of
account numbers.

If you want to filter an account or account range by specific criteria, click the Selection Criteria
button, and then specify criteria to use.

When you have created the formula, paste it into your report or specification.

a. To paste the formula into the selected cell (listed in the bottom left of the screen), click
Paste.

b. To select a different cell, click Next Row, Prev Row, Next Column, or Prev Column to
navigate to the desired cell, and then click Paste.

The formula you created is pasted into the financial report or specification.

Sage 300 2023 Financial Reporter User's Guide 90



Appendix C: Account Reference Syntax
and Examples

Account number references can use the following symbols:

Symbol Description
Hyphen | An account segment separator defined on the G/L Options screen in General Ledger.
(The hyphen is the default separator.)
Colon Separates account numbers in a range.
Tilde Separates segment codes in a segment range.

Account Reference Symbols

Note: All examples assume that segment 1 is the account segment and segment 2 is the department
segment.

Standard Account References

Format

Description

Examples

or

A specific General Ledger
account number composed of
one or two segments.
Account numbers can be
entered with or without the
segment separator —. However,
if you are specifying ranges of
accounts, we suggest you
include separators to remove
ambiguity from your
specifications.

Account 100, department C.
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Format

Description

Examples

A range of General Ledger
accounts and departments.
When creating a search
statement from the information
you enter, Financial Reporter
adds Zs to the last number in the
range. In other words, it
searches for account numbers
between "aaaa-A" and "bbbb-
BZZZZ2Z7777777777".

Accounts between 100 and 200 (from
any department)

Accounts with an account segment value
between 100 and 200, and with a
Department segment value between A
and F (for any order other than ACCTID
order).
If the order is ACCTID, account 150-H
will be included because it falls between
100-A and 200-F. However, for non-
ACCTID order, Financial Reporter takes
only those accounts that fall within both
ranges ( the range of accounts and the
range of departments), so that
is the same as

(shown below).
If the order is ACCTID, the constraint is
ACCTID => 100-A and ACCTID <= 200-
F.

or

A range of General Ledger
account numbers. (The wildcard
notation %% is a simpler way of
specifying all accounts with the
same segment.)

or

All accounts that start with 100, regardless of

account structure.

A range of General Ledger
account numbers with a fixed
second segment.

Financial Reporter retrieves
information from each account
within the range that includes the
second segment code.

Accounts in department F with an
account segment value between 100 and
200, and with a department segment
code of F.

Accounts with an account segment code
between 100 and 200, and with a
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Format

Description

Examples

department segment code from Ato F.

A range of General Ledger
account segment codes.
Financial Reporter retrieves all
accounts matching the account
segment you specify, no matter
how many segments are in the
number, and no matter where
the account segment is in the
account structure.

This allows you to specify a
range for one segment (rather
than a range of complete
account numbers), and is
particularly useful when the
account segment is not the first

segment in the account number.

Accounts with an account segment code from
4000 to 8000, no matter how many segments
are in the number, and no matter where the
account segment is in the account structure.
For example, results will include 10-4000, 20-
5000, and 10-6000 if those accounts exist in
General Ledger.

An individual account number
and a range of account
numbers. The square brackets
indicate the account structure
codes used by the account
numbers.

A set of ranges and individual
accounts with each
specification separated by a
comma.

Standard Account References
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Appendix D: FR Function Reference

Use Financial Reporter functions to retrieve data from General Ledger, including transaction and optional
field information.

Financial Reporter Function Notation

Financial Reporter functions use the following typographic conventions:

Convention Description

UPPERCASE Function names are in uppercase letters.

() Function arguments are listed in parentheses.

, All arguments are separated by a comma.
Most argument parameters are text, so are either:

¢ In quotation marks

» Areference to a spreadsheet cell that contains a text value, or a formula that
returns a text value

Note: Excel will return a "#VALUE!" error if you specify an argument that does
not exist.

Example:

Financial Reporter Functions

Accounts in General Ledger (G/L) contain two main types of data:

» Master information: Account name, account type, and other information regarding the account.

» Fiscal set values: Balances and net amounts for each general ledger account.
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You can use the following functions in Financial Reporter to retrieve data from General Ledger, including

transaction and optional field information.

Function

Data Retrieved

"FR Function" (page 96)

G/L Option data, company data, and
statement print options

"FRACCT Function" (page 100)

Account data, including account optional
fields

"FRAMT Function" (page 104) , "FRAMTA Function"
(page 111) , "FRCREDIT Function" (page 118),
"FRDEBIT Function" (page 125)

Fiscal set data

"FRFISCAL Function" (page 132)

Fiscal calendar dates

"FRPOST Function" (page 134)

Accounts and transaction detail data, and
account and transaction optional field data
from posted transactions

"FRRATE Function" (page 137)

Exchange rates

"FRSDESC Function" (page 139)

Segment code descriptions

"FRTRN Function" (page 140), "FRTRNA Function"
(page 146), "FRTRNCR Function" (page 152),
"FRTRNDR Function" (page 158)

Transaction detail data including net totals,
and account and transaction optional fields
(but not provisional amounts)

(page 88).

Tip: In Excel, use FR Paste (available from the Financial Statement Designer's FR menu) to insert a
Financial Reporter function into a financial statement. From the FR Paste screen, you can select the
function, its arguments, and additional report options. For more information, see "About FR Paste"
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FR Function

This function can retrieve G/L Option, company, and fiscal calendar data; runtime parameter values; and

statement print options.

Syntax
Arguments
Argument Description
option The name of a field from the Company Profile, Fiscal Calendar, or G/L Options
screens; or a specified runtime parameter or print option.
formatted Indicates whether the return value should be formatted according to the presentation
(Optional) defined in the view. If omitted, the default is "Formatted." Use one of the following
constructs:
 "FORMATTED", "F", or "FMT"
e "UNFORMATTED", "U", or "UNFMT"

Option can be one of the following:

G/L Options fields
Field Description
name
Orgid 6-character database ID for the company (for example, SAMINC)
Coname Company name
Address1 First address line
Address2 | Second address line
Address3 | Third address line
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Field Description
name
Address4 | Fourth address line
City City
Province Province
State State
Zip Zip code
Postal Postal code
Country Country
Phone Telephone number
Fax Fax number
Contact Ledger contact name
FuncCurr | Ledger functional currency
RPCurr Reporting currency code, when the Euro is the functional currency
RPACCT Rounding account defined in G/L Options for the reporting currency, when the Euro
is the functional currency

Runtime parameters and print options

Name

Contents of the field

SessionDate

Date entered at signon

Year Fiscal year
Period Fiscal period number
Start Period start date
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Name Contents of the field
End Period end date
QStart Quarter start date
QEnd Quarter end date
ReportType « If unformatted, returns "1" for actual, "2" for provisional report
« If formatted, returns "Actual” or "Provisional”
ReportAs  If unformatted, returns "1" for consolidated, "2" for separate
« If formatted, returns "Consolidated" or "Separate"
SortBy  If unformatted, returns "1" for Account ID, "2" for Segment ID, "3" for
Account Sorted Group
« If formatted, returns "AccountID," “SegmentID," or "Account Sorted Group"
SortByAcSeg « If unformatted, returns the number of the segment by which you are
sorting
« If formatted, returns the name of the segment by which you are sorting
From AcctID Starting Account ID in the print range
To AcctlD Ending Account ID in the print range

From AcctGroup

Starting Account Group in the print range

To AcctGroup Ending Account Group in the print range

AcSegNamen Name of the nth account segment (for example, Division or Department)
AcSegReportAsn | If ReportAs = 2 (separate), this is the consolidation setting of the nth segment
FromAcSegn Starting value of the nth segment in the print range

ToAcSegn Ending value of the nth segment in the print range

CurAcSegValn

The current value of the segment for the current report. This value is only

appropriate when "ReportAs" = 2 (separate).

Acctgroupsort

Sorting by Account Sorted Group

Acctgroup

Sorting by Account Group
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Examples

Statement

Return Value

=FR("Coname")

The Garden Inc.

=FR("End")

4/30/02
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FRACCT Function

This function retrieves data from G/L account records, including account optional fields. It cannot retrieve
data from transaction optional fields.

Syntax

Note: The function returns a blank if the account reference is missing, the account does not exist, or if
no accounts exist in the specified range.

Arguments
Argument Description
field name The name of a field from the G/L account record, including account optional fields.
Tip: Account optional fields have an "A." prefix.
account A string specifying a single account or a range of accounts. See "About Account Number
reference References" (page 54).
Note:
» For arange of accounts, the function returns only the data that is common to
all accounts.
« Ifthe account does not exist, FRACCT returns a hyphen (-).
criteria An expression that imposes selection criteria on the accounts. The account
reference and expression together determine the accounts that will be included in
the calculation. See "About Selection Criteria for Filtering Accounts" (page 57).
formatted Indicates whether the return value should be formatted according to the presentation
(Optional) defined in the view. If omitted, the default is "Formatted." Use one of the following
constructs:
e "FORMATTED", "F", or "FMT"
e "UNFORMATTED", "U", or "UNFMT"
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Field names for G/L account data

You can use the following G/L account field names. To retrieve optional fields, add the prefix "A." before

the field name (include the period).

Field Name

Description

ACCTID

Account number, including all segments

CREATEDATE

Date the account was created

ACCTDESC

Account description

ACCTTYPE

Account type

+ Ifunformatted, |, B, orR

« If formatted, "Income," "Balance sheet," or "Retained earnings"

ACCTBAL

Normal balance

¢ [If unformatted, 1 for debit or 2 for normal credit

« [fformatted, "Debit" or "Credit"

ACTIVESW

Account status (Active or Inactive)

« If unformatted, 1 for active or O for inactive

+ If formatted, "Active" or "Inactive"

CONSLDSW

Consolidation setting

 If unformatted, 1 if transactions are consolidated on posting, 0 if
they are not

« Ifformatted, "Consolidate journals" or "Do not consolidate
journals"

QTYSW

Quantity setting

 If unformatted, 1 if quantities are used with account, 0 if not

+ |f formatted, "Yes" or "No"

UOM

The unit of measure, if quantities are used

ALLOCSW

Allocation setting

» [f unformatted, 1 if account can be reallocated, 0 if not

Sage 300 2023 Financial Reporter User's Guide

101



Field Name Description
« If formatted, "Yes" or "No"
ACCTOFSET Account number for reallocation
ACCTSRTY Allocation transaction source code
ROLLUPSW Rollup setting
« If unformatted, 1 if account is a rollup account, 0O if not
« Ifformatted, "Yes" or "No"
MCSW Multicurrency setting
« If unformatted, 1 if multicurrency, 0O if not
« If formatted, "Yes" or "No"
SPECSW Specific source currencies setting
 [f unformatted, 0O if all currencies, 1 if specified
« [fformatted, "All currency" or "Specific currency"
ACCTGRPCOD Account group code
CTRLACCTSW Control account setting

« If unformatted, 1 if account is a control account, 0 if not

¢ If formatted, "Control account" or "Non control account"

SRCELDGID (Reserved
field)

Source ledger, if the account is a control account (for example, AR
or AP).

ALLOCTOT Percentage total of different allocation rates
ABRKID Account structure code

YRACCTCLOS Last year closed

ACCTFMTTD Formatted account number

ACSEGVALnN (n=01to 10)

Account segment code, 01to 10

ACCTSEGVAL

Segment defined as the Account Segment in G/L Options
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Field Name Description
ACCTGRPSCD Account group sort code
POSTOSEGID The code for the segment used for account posting
DEFCURNCOD Default currency code
Examples
Statement Return Value
=FRACCT "Cost of goods sold"

("ACCTDESC","1000-333")

("A.ACCTCLASS","4000")

=FRACCT "Yes"
("QTYSW","1000-333","F")
=FRACCT("ACCTTYPE", "Income"
"1000-333","FMT")

=FRACCT "Sales"

=FRACCT
("ACCTDESC","1000-
333:1000-400")

Prints a description that includes only those words that are common to
each account in the account range.

For example, if the accounts in the range have the following
descriptions, the word "Receivable" would be the return value.

¢ Accounts Receivable: customers
« Accounts Receivable: employees

« Receivable: over 90 days
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FRAMT Function

This function retrieves actual, budget, and quantity balances and net amounts from General Ledger
accounts for a specified period.

All amounts returned by FRAMT respect the account type. Debit balances in debit accounts and credit
balances in credit accounts are returned as positive numbers; credit balances in debit accounts and debit
balances in credit accounts are returned as negative numbers.

Although FRAMT is similar to "FRAMTA Function" (page 111), FRAMTA returns all debit balances as
positive numbers and all credit balances as negative numbers regardless if the account is a debit or credit
type.

FRAMT is also similar to "FRTRN Function" (page 140), but FRAMT retrieves totals from account history,
whereas FRTRN retrieves totals from transaction history.

Syntax

Note: The function returns 0 if the account reference is missing, the account does not exist, or if no
accounts exist in the specified range.

Arguments

Argument Description

field name The name of a field from the General Ledger fiscal sets with an optional fiscal
designator prefix and optional fiscal year suffix (separated from the field name with a
period).

The fiscal designator prefix can be:
¢ A. Actual amount

* R. Rollup amounts. R must be the first character and can be used with other prefixes

Tip: In Excel, if you use the FR PASTE screen to add the FRAMT function to a
statement, select the Use Rolled Up Amounts check box.

e P. Provisional amounts
* Q. Quantities (either actual or provisional, depending on the report type)
» QA. Actual quantities

* QP. Provisional quantities
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Argument Description

¢ 110 5. Budget set number

The number of available budget sets varies by product edition.
e 2in Sage 300 Standard
e 3in Sage 300 Advanced
¢ 5in Sage 300 Premium

Note: If no prefix is supplied, the default report setting is used (either actual or
provisional, depending on the type of report). Similarly, if the fiscal prefix is "Q" or
"RQ," actual or provisional quantities are returned, depending on the type of report.

The fiscal year suffix can be:

* YYYY. A specific fiscal year, such as 2010

e Ln.nyears ago relative to the current fiscal year; for example, L1 is last year, and
L2 is 2 years ago

* Nn.nyears in the future relative to the current fiscal year; for example, N1 is next
year, and N2 is the year after next

Note: If no suffix is supplied, the current fiscal year is used.

Example: For the field name argument ABALP.2008, ABALP is the combination of
fiscal set prefix and field name referencing the actual balance for the current period,
and 2008 is the fiscal year suffix.

account A string specifying a single account or a range of accounts. See "About Account
reference Number References" (page 54).

criteria An expression that imposes selection criteria on the accounts and account optional
(Optional) | fields. The account reference and expression together determine the accounts and
account optional fields that will be included in the calculation. See "About Selection
Criteria for Filtering Accounts" (page 57).

currency A string containing the currency reference. A currency reference has the form "CCC.T,"
(Optional) where CCCis a 3-character currency code (for example, CAD for Canadian dollars, or
USD for US dollars), and T is the currency type (also known as the currency code
qualifier).

The currency type can be:
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Argument Description

» S. Source currency
¢ E. Functional equivalent of the source amount

* F. Functional currency total (including functional equivalents of all source
amounts)

* R. Reporting currency total (includes reporting equivalents of all source amounts)

Note: This option is only available if you select the Euro as your functional
currency and specify a different reporting currency in Company Profile.

Note: If no currency is supplied, functional (home) currency is used.

Fiscal Set Field Names

Financial Reporter can retrieve the following balance and net change fields.

Note: In the Reporter Code Suffix, nis a number that can refer to the fiscal period (from 1 to 13), or to
the quarter (from 1 to 4).
Field Description | Reporter Code Suffix BAL NET

(balance) (net

changes)

Current period P BALP NETP
Last period LP BALLP NETLP
nth period nP BALNnP NETnP
n periods ago nPA BALnPA NETnPA

Period balance and net change

BALP, BALnP, BALYTD, etc. include adjustments from period 14 only if the balance is for the final
period of the year. BALY includes period 14. The closing entries are not included. To include closing
entries, use BALCLOSE. To print the balance from the final fiscal period without the adjustment
amount, use FRAMT("BALP")-FRAMT("NETADJ").

NETP, NETnP, NET4Q, NETPQ will also include adjustments from period 14 if the net is
requested for the final period of the year. (NET works like BAL.)
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Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Current quarter (to end) Q BALQ NETQ
Current quarter to date QTD BALQTD NETQTD
Last quarter LQ BALLQ NETLQ
Last quarter to date LQTD BALLQTD NETLQTD
nth quarter nQ BALnQ NETnQ
nth quarter to date nQTD BALnQTD NETnQTD
n quarters ago nQA BALnQA NETnQA
n quarters ago to date nQATD BALNQATD | NETnQATD
Preceding quarter (3 periods) PQ BALPQ NETPQ
Preceding quarter (n periods ago) | PQnPA BALPQnPA | NETPQNnPA
Quarter balance and net change
Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Current half year (to end) S BALS NETS

This code allows you to compare the current QTD to the QTD of a previous quarter by providing
you with to-date figures relative to the current quarter. If you are now in period 2 of the current

quarter, QTD will give you the first 2 periods of any previous quarter.
nQATD lets you go up to four quarters ago. If you need to specify more, use nQATD.L1.

PQ handles any three periods, providing you with revolving quarters. The preceding 3 periods

include the current period plus the two previous ones.

The NET for a group of periods that crosses a year-end boundary will also include the adjustments
in period 14, but not include the closing entry; otherwise, the net would include the zeroing entries in

income and expense accounts.
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Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Current half year to date STD BALSTD NETSTD
Last half year LS BALLS NETLS
Last half year to date LSTD BALLSTD NETLSTD
nth half year nS BALNS NETnS
hth half year to date nSTD BALnhSTD NETnSTD
n half years ago nSA BALnSA NETnSA
n half years ago to date nSATD BALNSATD | NETnSATD
Preceding half year (6 periods) PS BALPS NETPS
Preceding half year (n periods ago) | PSnPA BALPSnPA | NETPSnPA
Half year balance and net change
Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Total year Y BALY NETY
Year to date YTD BALYTD NETYTD
Preceding year (12 or 13 periods) | PY BALPY NETPY
Preceding year (n periods ago) PYnPA BALPYnPA NETPYnPA

This code allows you to compare the current half year TD to the half year TD of a previous half
year by providing you with to-date figures relative to the current half year. If you are now in period 2

of the current half year, half year TD will give you the first 2 periods of any previous half year.
nSATD lets you go up to 2 half years ago. If you need to specify more, use nSATD.L1.

PS handles any six periods, providing you with revolving half years. The preceding six periods

includes the current period plus the five previous ones.
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Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Beginning of year OPEN BALOPEN
End of year CLOSE BALCLOSE | NETCLOSE
Period 14 adjustments ADJ NETADJ

Total year balance and net change

Note:
¢ You can print year-end adjustments and transactions to close income accounts to retained
earnings with NETADJ, and print closing figures with NETCLOSE and BALCLOSE.

 Allfiscal field set values are calculated relative to the fiscal period set for the report, with the
exception of BALOPEN, NETADJ, and NETCLOSE, and fields that reference a specific time
period.

» BALOPEN is the opening balance of the account for the year.
« NETADJ is the amount posted to the adjustment period.
« NETCLOSE is the amount posted to the closing period.
« If there are no records for a future period, zero is returned.
* You can use a fiscal set prefix with NET and BAL to return specific values. For example:

e BALP provides the actual balance (or provisional balance for supported functions) for the
current fiscal period.

« ABALP provides the actual balance for the current fiscal period.

« 1BALP provides the balance from budget set 1 for the current fiscal period (for functions that
can reference budget sets).

Examples
Statement Return Value
=FRAMT The provisionally-posted balance of Deutsche Marks (in source

BALCLOSE acts like BALP in every period except the last period of the year, when it includes the
adjustments and the closing entry. NETCLOSE provides the closing entry only.

NETADJ provides the amount from period 14. To print the balance from the final fiscal period
without the adjustment amount, use FRAMT("BALP")-FRAMT("NETADJ").
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Statement

Return Value

("PBALP.L1","1000-33-
248"; "DEM.S")

currency) to account 1000-33-248 for the current period last year

=FRAMT("QBALP","2000")

The quantity balance of the current period for account 2000

=FRAMT
("ABAL.2010","1000% %",
"(ACCTTYPE="B")")

The total actual balance for all balance sheet accounts with account
numbers starting with "1000" for the year 2010
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FRAMTA Function

This function is similar to "FRAMT Function" (page 104). It has the same arguments as FRAMT, and
returns the same data. The difference is that the sign of the return value is dependent on the account type
for FRAMT, but not for FRAMTA.

FRAMTA returns all debit balances as positive numbers, and all credit balances as negative numbers,
making it easy to sum a range of accounts without regard for the account type. By contrast, FRAMT
returns debit balances in credit accounts as negative numbers and credit balances in credit accounts as
positive numbers.

Syntax

Note: The function returns 0 if the account reference is missing, the account does not exist, or if no
accounts exist in the specified range.

Arguments

Argument Description

field name The name of a field from the General Ledger fiscal sets with an optional fiscal
designator prefix and optional fiscal year suffix (separated from the field name with a
period).

The fiscal designator prefix can be:
¢ A. Actual amount

* R. Rollup amounts. R must be the first character and can be used with other prefixes

Tip: In Excel, if you use the FR PASTE screen to add the FRAMT function to a
statement, select the Use Rolled Up Amounts check box.

e P. Provisional amounts

* Q. Quantities (either actual or provisional, depending on the report type)
» QA. Actual quantities

» QP. Provisional quantities

« 110 5. Budget set number
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Argument

Description

The number of available budget sets varies by product edition.
e 2in Sage 300 Standard
¢ 3in Sage 300 Advanced
* 5in Sage 300 Premium

Note: If no prefix is supplied, the default report setting is used (either actual or
provisional, depending on the type of report). Similarly, if the fiscal prefix is "Q" or
"RQ," actual or provisional quantities are returned, depending on the type of report.

The fiscal year suffix can be:

* YYYY. A specific fiscal year, such as 2010

* Ln.nyears ago relative to the current fiscal year; for example, L1 is last year, and
L2 is 2 years ago

* Nn.nyears in the future relative to the current fiscal year; for example, N1 is next
year, and N2 is the year after next

Note: If no suffix is supplied, the current fiscal year is used.

Example: For the field name argument ABALP.2008, ABALP is the combination of
fiscal set prefix and field name referencing the actual balance for the current period,
and 2008 is the fiscal year suffix.

account A string specifying a single account or a range of accounts. See "About Account

reference Number References" (page 54).

criteria An expression that imposes selection criteria on the accounts and account optional

(Optional) | fields. The account reference and expression together determine the accounts and
account optional fields that will be included in the calculation. See "About Selection
Criteria for Filtering Accounts" (page 57).

currency A string containing the currency reference. A currency reference has the form "CCC.T,"

(Optional) where CCCis a 3-character currency code (for example, CAD for Canadian dollars, or

USD for US dollars), and T is the currency type (also known as the currency code
qualifier).

The currency type can be:

» S. Source currency

¢ E. Functional equivalent of the source amount
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Argument

Description

» F. Functional currency total (including functional equivalents of all source
amounts)

* R. Reporting currency total (includes reporting equivalents of all source amounts)

Note: This option is only available if you select the Euro as your functional
currency and specify a different reporting currency in Company Profile.

Note: If no currency is supplied, functional (home) currency is used.

Fiscal Set Field Names

Financial Reporter can retrieve the following balance and net change fields.

Note: In the Reporter Code Suffix, nis a number that can refer to the fiscal period (from 1 to 13), or to
the quarter (from 1 to 4).
Field Description | Reporter Code Suffix BAL NET

(balance) (net

changes)

Current period P BALP NETP
Last period LP BALLP NETLP
nth period nP BALnP NETnP
n periods ago nPA BALNnPA NETnPA

Period balance and net change

BALP, BALnP, BALYTD, etc. include adjustments from period 14 only if the balance is for the final
period of the year. BALY includes period 14. The closing entries are not included. To include closing
entries, use BALCLOSE. To print the balance from the final fiscal period without the adjustment

amount, use FRAMT("BALP")-FRAMT("NETADJ").

NETP, NETnP, NET4Q, NETPQ will also include adjustments from period 14 if the net is

requested for the final period of the year. (NET works like BAL.)
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Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Current quarter (to end) Q BALQ NETQ
Current quarter to date QTD BALQTD NETQTD
Last quarter LQ BALLQ NETLQ
Last quarter to date LQTD BALLQTD NETLQTD
nth quarter nQ BALnQ NETnQ
nth quarter to date nQTD BALnQTD NETnQTD
n quarters ago nQA BALnQA NETnQA
n quarters ago to date nQATD BALNQATD | NETnQATD
Preceding quarter (3 periods) PQ BALPQ NETPQ
Preceding quarter (n periods ago) | PQnPA BALPQnPA | NETPQNnPA
Quarter balance and net change
Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Current half year (to end) S BALS NETS

This code allows you to compare the current QTD to the QTD of a previous quarter by providing
you with to-date figures relative to the current quarter. If you are now in period 2 of the current

quarter, QTD will give you the first 2 periods of any previous quarter.
nQATD lets you go up to four quarters ago. If you need to specify more, use nQATD.L1.

PQ handles any three periods, providing you with revolving quarters. The preceding 3 periods

include the current period plus the two previous ones.

The NET for a group of periods that crosses a year-end boundary will also include the adjustments
in period 14, but not include the closing entry; otherwise, the net would include the zeroing entries in

income and expense accounts.
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Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Current half year to date STD BALSTD NETSTD
Last half year LS BALLS NETLS
Last half year to date LSTD BALLSTD NETLSTD
nth half year nS BALNS NETnS
hth half year to date nSTD BALnhSTD NETnSTD
n half years ago nSA BALnSA NETnSA
n half years ago to date nSATD BALNSATD | NETnSATD
Preceding half year (6 periods) PS BALPS NETPS
Preceding half year (n periods ago) | PSnPA BALPSnPA | NETPSnPA
Half year balance and net change
Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Total year Y BALY NETY
Year to date YTD BALYTD NETYTD
Preceding year (12 or 13 periods) | PY BALPY NETPY
Preceding year (n periods ago) PYnPA BALPYnPA NETPYnPA

This code allows you to compare the current half year TD to the half year TD of a previous half
year by providing you with to-date figures relative to the current half year. If you are now in period 2

of the current half year, half year TD will give you the first 2 periods of any previous half year.
nSATD lets you go up to 2 half years ago. If you need to specify more, use nSATD.L1.

PS handles any six periods, providing you with revolving half years. The preceding six periods

includes the current period plus the five previous ones.
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Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Beginning of year OPEN BALOPEN
End of year CLOSE BALCLOSE | NETCLOSE
Period 14 adjustments ADJ NETADJ

Total year balance and net change

Note:
¢ You can print year-end adjustments and transactions to close income accounts to retained
earnings with NETADJ, and print closing figures with NETCLOSE and BALCLOSE.

 Allfiscal field set values are calculated relative to the fiscal period set for the report, with the
exception of BALOPEN, NETADJ, and NETCLOSE, and fields that reference a specific time
period.

» BALOPEN is the opening balance of the account for the year.
« NETADJ is the amount posted to the adjustment period.
« NETCLOSE is the amount posted to the closing period.
« If there are no records for a future period, zero is returned.
* You can use a fiscal set prefix with NET and BAL to return specific values. For example:

e BALP provides the actual balance (or provisional balance for supported functions) for the
current fiscal period.

« ABALP provides the actual balance for the current fiscal period.

« 1BALP provides the balance from budget set 1 for the current fiscal period (for functions that
can reference budget sets).

Examples

The following examples show the differences between the return values for the FRAMT and FRAMTA
functions.

BALCLOSE acts like BALP in every period except the last period of the year, when it includes the
adjustments and the closing entry. NETCLOSE provides the closing entry only.

NETADJ provides the amount from period 14. To print the balance from the final fiscal period
without the adjustment amount, use FRAMT("BALP")-FRAMT("NETADJ").
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AccountType Value FRAMT FRAMTA

Return Value | Return Value
Debit 100 DR 100 100
Debit 100 CR -100 -100
Credit 100 CR 100 -100
Credit 100 DR -100 100
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FRCREDIT Function

This function is the same as "FRAMT Function" (page 104), except that it returns values for only those
accounts that have credit amounts (balances or net changes)-regardless of whether the account is a
debit or credit account.

Note: This function can retrieve budget and provisional amounts, calculate balances, and include
rollup amounts and rollup members accounts.

Syntax

Tip: Use the criteria argument to restrict this function to credit (CR) account types.

FRCREDIT returns the credit value of the account, with the following exceptions:

¢ Returns blank if the value of a debit account is zero or a debit amount
e Returns 0 if the value of a credit account is zero

* Returns "0" if the account reference is missing or if a specified account cannot be found

Arguments

Argument Description

field name The name of a field from the General Ledger fiscal sets with an optional fiscal
designator prefix and optional fiscal year suffix (separated from the field name with a
period).

The fiscal designator prefix can be:

e A. Actual amount

* R. Rollup amounts. R must be the first character and can be used with other prefixes

Tip: In Excel, if you use the FR PASTE screen to add the FRAMT function to a
statement, select the Use Rolled Up Amounts check box.

» P. Provisional amounts

* Q. Quantities (either actual or provisional, depending on the report type)
* QA. Actual quantities

» QP. Provisional quantities

¢ 110 5. Budget set number
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Argument

Description

The number of available budget sets varies by product edition.
e 2in Sage 300 Standard
¢ 3in Sage 300 Advanced
* 5in Sage 300 Premium

Note: If no prefix is supplied, the default report setting is used (either actual or
provisional, depending on the type of report). Similarly, if the fiscal prefix is "Q" or
"RQ," actual or provisional quantities are returned, depending on the type of report.

The fiscal year suffix can be:

* YYYY. A specific fiscal year, such as 2010

* Ln.nyears ago relative to the current fiscal year; for example, L1 is last year, and
L2 is 2 years ago

* Nn.nyears in the future relative to the current fiscal year; for example, N1 is next
year, and N2 is the year after next

Note: If no suffix is supplied, the current fiscal year is used.

Example: For the field name argument ABALP.2008, ABALP is the combination of
fiscal set prefix and field name referencing the actual balance for the current period,
and 2008 is the fiscal year suffix.

account A string specifying a single account or a range of accounts. See "About Account

reference Number References" (page 54).

criteria An expression that imposes selection criteria on the accounts and account optional

(Optional) | fields. The account reference and expression together determine the accounts and
account optional fields that will be included in the calculation. See "About Selection
Criteria for Filtering Accounts" (page 57).

currency A string containing the currency reference. A currency reference has the form "CCC.T,"

(Optional) where CCCis a 3-character currency code (for example, CAD for Canadian dollars, or

USD for US dollars), and T is the currency type (also known as the currency code
qualifier).

The currency type can be:

» S. Source currency

¢ E. Functional equivalent of the source amount
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Argument Description

» F. Functional currency total (including functional equivalents of all source
amounts)

* R. Reporting currency total (includes reporting equivalents of all source amounts)

Note: This option is only available if you select the Euro as your functional
currency and specify a different reporting currency in Company Profile.

Note: If no currency is supplied, functional (home) currency is used.

Fiscal Set Field Names

Financial Reporter can retrieve the following balance and net change fields.

Note: In the Reporter Code Suffix, nis a number that can refer to the fiscal period (from 1 to 13), or to
the quarter (from 1 to 4).
Field Description | Reporter Code Suffix BAL NET

(balance) (net

changes)

Current period P BALP NETP
Last period LP BALLP NETLP
nth period nP BALnP NETnP
n periods ago nPA BALNnPA NETnPA

Period balance and net change

BALP, BALnP, BALYTD, etc. include adjustments from period 14 only if the balance is for the final
period of the year. BALY includes period 14. The closing entries are not included. To include closing
entries, use BALCLOSE. To print the balance from the final fiscal period without the adjustment
amount, use FRAMT("BALP")-FRAMT("NETADJ").

NETP, NETnP, NET4Q, NETPQ will also include adjustments from period 14 if the net is
requested for the final period of the year. (NET works like BAL.)
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Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Current quarter (to end) Q BALQ NETQ
Current quarter to date QTD BALQTD NETQTD
Last quarter LQ BALLQ NETLQ
Last quarter to date LQTD BALLQTD NETLQTD
nth quarter nQ BALnQ NETnQ
nth quarter to date nQTD BALnQTD NETnQTD
n quarters ago nQA BALnQA NETnQA
n quarters ago to date nQATD BALNQATD | NETnQATD
Preceding quarter (3 periods) PQ BALPQ NETPQ
Preceding quarter (n periods ago) | PQnPA BALPQnPA | NETPQNnPA
Quarter balance and net change
Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Current half year (to end) S BALS NETS

This code allows you to compare the current QTD to the QTD of a previous quarter by providing
you with to-date figures relative to the current quarter. If you are now in period 2 of the current

quarter, QTD will give you the first 2 periods of any previous quarter.
nQATD lets you go up to four quarters ago. If you need to specify more, use nQATD.L1.

PQ handles any three periods, providing you with revolving quarters. The preceding 3 periods

include the current period plus the two previous ones.

The NET for a group of periods that crosses a year-end boundary will also include the adjustments
in period 14, but not include the closing entry; otherwise, the net would include the zeroing entries in

income and expense accounts.
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Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Current half year to date STD BALSTD NETSTD
Last half year LS BALLS NETLS
Last half year to date LSTD BALLSTD NETLSTD
nth half year nS BALNS NETnS
hth half year to date nSTD BALnhSTD NETnSTD
n half years ago nSA BALnSA NETnSA
n half years ago to date nSATD BALNSATD | NETnSATD
Preceding half year (6 periods) PS BALPS NETPS
Preceding half year (n periods ago) | PSnPA BALPSnPA | NETPSnPA
Half year balance and net change
Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Total year Y BALY NETY
Year to date YTD BALYTD NETYTD
Preceding year (12 or 13 periods) | PY BALPY NETPY
Preceding year (n periods ago) PYnPA BALPYnPA NETPYnPA

This code allows you to compare the current half year TD to the half year TD of a previous half
year by providing you with to-date figures relative to the current half year. If you are now in period 2

of the current half year, half year TD will give you the first 2 periods of any previous half year.
nSATD lets you go up to 2 half years ago. If you need to specify more, use nSATD.L1.

PS handles any six periods, providing you with revolving half years. The preceding six periods

includes the current period plus the five previous ones.
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Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Beginning of year OPEN BALOPEN
End of year CLOSE BALCLOSE | NETCLOSE
Period 14 adjustments ADJ NETADJ

Total year balance and net change

Note:
¢ You can print year-end adjustments and transactions to close income accounts to retained
earnings with NETADJ, and print closing figures with NETCLOSE and BALCLOSE.

 Allfiscal field set values are calculated relative to the fiscal period set for the report, with the
exception of BALOPEN, NETADJ, and NETCLOSE, and fields that reference a specific time
period.

» BALOPEN is the opening balance of the account for the year.
« NETADJ is the amount posted to the adjustment period.
« NETCLOSE is the amount posted to the closing period.
« If there are no records for a future period, zero is returned.
* You can use a fiscal set prefix with NET and BAL to return specific values. For example:

e BALP provides the actual balance (or provisional balance for supported functions) for the
current fiscal period.

« ABALP provides the actual balance for the current fiscal period.

« 1BALP provides the balance from budget set 1 for the current fiscal period (for functions that
can reference budget sets).

Examples

The following examples show the differences between the return values for the FRAMT and FRCREDIT
functions.

BALCLOSE acts like BALP in every period except the last period of the year, when it includes the
adjustments and the closing entry. NETCLOSE provides the closing entry only.

NETADJ provides the amount from period 14. To print the balance from the final fiscal period
without the adjustment amount, use FRAMT("BALP")-FRAMT("NETADJ").
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Account Type | Value FRAMT | FRCREDIT

Return Value | Return Value
Credit 100 CR 100 100
Credit 0 0 0
Debit 0 0 blank
Debit 100 CR -100 100
Debit 100 DR 100 blank
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FRDEBIT Function

This function is the same as "FRAMT Function" (page 104), except that it returns values for only those
accounts that have debit amounts (balances or net changes)-regardless of whether the account is a
debit or credit account.

Note: This function can retrieve budget and provisional amounts, calculate balances, and include
rollup amounts and rollup members accounts.

Syntax

Tip: Use the criteria argument to restrict this function to debit (DR) account types.

FRDEBIT returns the debit value of the account, with the following exceptions:

« Returns blank if the value of a credit account is zero or a credit amount
¢ Returns 0 if the value of a debit account is zero

» Returns "0" if the account reference is missing or if a specified account cannot be found

Arguments

Argument Description

field name The name of a field from the General Ledger fiscal sets with an optional fiscal
designator prefix and optional fiscal year suffix (separated from the field name with a
period).

The fiscal designator prefix can be:

¢ A. Actual amount

* R. Rollup amounts. R must be the first character and can be used with other prefixes

Tip: In Excel, if you use the FR PASTE screen to add the FRAMT function to a
statement, select the Use Rolled Up Amounts check box.

* P. Provisional amounts

* Q. Quantities (either actual or provisional, depending on the report type)

QA. Actual quantities

» QP. Provisional quantities

Sage 300 2023 Financial Reporter User's Guide

125



Argument Description

¢ 110 5. Budget set number

The number of available budget sets varies by product edition.
e 2in Sage 300 Standard
e 3in Sage 300 Advanced
¢ 5in Sage 300 Premium

Note: If no prefix is supplied, the default report setting is used (either actual or
provisional, depending on the type of report). Similarly, if the fiscal prefix is "Q" or
"RQ," actual or provisional quantities are returned, depending on the type of report.

The fiscal year suffix can be:

* YYYY. A specific fiscal year, such as 2010

e Ln.nyears ago relative to the current fiscal year; for example, L1 is last year, and
L2 is 2 years ago

* Nn.nyears in the future relative to the current fiscal year; for example, N1 is next
year, and N2 is the year after next

Note: If no suffix is supplied, the current fiscal year is used.

Example: For the field name argument ABALP.2008, ABALP is the combination of
fiscal set prefix and field name referencing the actual balance for the current period,
and 2008 is the fiscal year suffix.

account A string specifying a single account or a range of accounts. See "About Account
reference Number References" (page 54).

criteria An expression that imposes selection criteria on the accounts and account optional
(Optional) | fields. The account reference and expression together determine the accounts and
account optional fields that will be included in the calculation. See "About Selection
Criteria for Filtering Accounts" (page 57).

currency A string containing the currency reference. A currency reference has the form "CCC.T,"
(Optional) where CCCis a 3-character currency code (for example, CAD for Canadian dollars, or
USD for US dollars), and T is the currency type (also known as the currency code
qualifier).

The currency type can be:
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Argument Description

» S. Source currency
¢ E. Functional equivalent of the source amount

* F. Functional currency total (including functional equivalents of all source
amounts)

* R. Reporting currency total (includes reporting equivalents of all source amounts)

Note: This option is only available if you select the Euro as your functional
currency and specify a different reporting currency in Company Profile.

Note: If no currency is supplied, functional (home) currency is used.

Fiscal Set Field Names

Financial Reporter can retrieve the following balance and net change fields.

Note: In the Reporter Code Suffix, nis a number that can refer to the fiscal period (from 1 to 13), or to
the quarter (from 1 to 4).
Field Description | Reporter Code Suffix BAL NET

(balance) (net

changes)

Current period P BALP NETP
Last period LP BALLP NETLP
nth period nP BALNnP NETnP
n periods ago nPA BALnPA NETnPA

Period balance and net change

BALP, BALnP, BALYTD, etc. include adjustments from period 14 only if the balance is for the final
period of the year. BALY includes period 14. The closing entries are not included. To include closing
entries, use BALCLOSE. To print the balance from the final fiscal period without the adjustment
amount, use FRAMT("BALP")-FRAMT("NETADJ").

NETP, NETnP, NET4Q, NETPQ will also include adjustments from period 14 if the net is
requested for the final period of the year. (NET works like BAL.)
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Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Current quarter (to end) Q BALQ NETQ
Current quarter to date QTD BALQTD NETQTD
Last quarter LQ BALLQ NETLQ
Last quarter to date LQTD BALLQTD NETLQTD
nth quarter nQ BALnQ NETnQ
nth quarter to date nQTD BALnQTD NETnQTD
n quarters ago nQA BALnQA NETnQA
n quarters ago to date nQATD BALNQATD | NETnQATD
Preceding quarter (3 periods) PQ BALPQ NETPQ
Preceding quarter (n periods ago) | PQnPA BALPQnPA | NETPQNnPA
Quarter balance and net change
Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Current half year (to end) S BALS NETS

This code allows you to compare the current QTD to the QTD of a previous quarter by providing
you with to-date figures relative to the current quarter. If you are now in period 2 of the current

quarter, QTD will give you the first 2 periods of any previous quarter.
nQATD lets you go up to four quarters ago. If you need to specify more, use nQATD.L1.

PQ handles any three periods, providing you with revolving quarters. The preceding 3 periods

include the current period plus the two previous ones.

The NET for a group of periods that crosses a year-end boundary will also include the adjustments
in period 14, but not include the closing entry; otherwise, the net would include the zeroing entries in

income and expense accounts.
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Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Current half year to date STD BALSTD NETSTD
Last half year LS BALLS NETLS
Last half year to date LSTD BALLSTD NETLSTD
nth half year nS BALNS NETnS
hth half year to date nSTD BALnhSTD NETnSTD
n half years ago nSA BALnSA NETnSA
n half years ago to date nSATD BALNSATD | NETnSATD
Preceding half year (6 periods) PS BALPS NETPS
Preceding half year (n periods ago) | PSnPA BALPSnPA | NETPSnPA
Half year balance and net change
Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Total year Y BALY NETY
Year to date YTD BALYTD NETYTD
Preceding year (12 or 13 periods) | PY BALPY NETPY
Preceding year (n periods ago) PYnPA BALPYnPA NETPYnPA

This code allows you to compare the current half year TD to the half year TD of a previous half
year by providing you with to-date figures relative to the current half year. If you are now in period 2

of the current half year, half year TD will give you the first 2 periods of any previous half year.
nSATD lets you go up to 2 half years ago. If you need to specify more, use nSATD.L1.

PS handles any six periods, providing you with revolving half years. The preceding six periods

includes the current period plus the five previous ones.
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Field Description Reporter Code Suffix BAL NET
(balance) (net
changes)
Beginning of year OPEN BALOPEN
End of year CLOSE BALCLOSE | NETCLOSE
Period 14 adjustments ADJ NETADJ

Total year balance and net change

Note:
¢ You can print year-end adjustments and transactions to close income accounts to retained
earnings with NETADJ, and print closing figures with NETCLOSE and BALCLOSE.

 Allfiscal field set values are calculated relative to the fiscal period set for the report, with the
exception of BALOPEN, NETADJ, and NETCLOSE, and fields that reference a specific time
period.

» BALOPEN is the opening balance of the account for the year.
« NETADJ is the amount posted to the adjustment period.
« NETCLOSE is the amount posted to the closing period.
« If there are no records for a future period, zero is returned.
* You can use a fiscal set prefix with NET and BAL to return specific values. For example:

e BALP provides the actual balance (or provisional balance for supported functions) for the
current fiscal period.

« ABALP provides the actual balance for the current fiscal period.

« 1BALP provides the balance from budget set 1 for the current fiscal period (for functions that
can reference budget sets).

Examples

The following examples show the differences between the return values for the FRAMT and FRDEBIT
functions.

BALCLOSE acts like BALP in every period except the last period of the year, when it includes the
adjustments and the closing entry. NETCLOSE provides the closing entry only.

NETADJ provides the amount from period 14. To print the balance from the final fiscal period
without the adjustment amount, use FRAMT("BALP")-FRAMT("NETADJ").
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Account Type | Value FRAMT FRDEBIT
Return Value | Return Value

Debit 100 DR 100 100

Debit 0 0 0

Credit 0 0

Credit 100 DR -100 100

Credit 100 CR 100 blank
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FRFISCAL Function

This function returns a date (as a string) from the fiscal calendar in Common Services.

Syntax

Arguments

Argument Description

option The period or quarter date.
Valid parameters are:
 Start: Start date of the period
» End: End date of the period
» QStart: Start date of the quarter
* QEnd: End data of the quarter

fiscal year | Valid parameters are:

(Optional) * YYYY: A specific 4-digit fiscal year, such as 2010

* Ln:nyears ago, relative to the current fiscal year; for example, L1 is last year, and
L2 is 2 years ago

* Nn:nyears in the future, relative to the current fiscal year; for example, N1 is next
year, and N2 is the year after next

If not specified, assumed to be the current year.

fiscal period | Fiscal period number from 1 to 12. If not specified, the current period is used.

(Optional) Note: This field is an integer so is not enclosed in quotation marks.

formatted Indicates whether the return value should be formatted according to the presentation

(Optional) defined in the view. If omitted, the default is "Formatted." Use one of the following
constructs:

* "FORMATTED", "F", or "FMT"
* "UNFORMATTED", "U", or "UNFMT"
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Examples

Statement Return Value
=FRFISCAL("Start") 11/01/2009
=FRFISCAL("Start","","O","U") | 20081101
=FRFISCAL("Start","L1", VALUE | 11/01/2008

(FR("Period")),"F")
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FRPOST Function

This function retrieves account and transaction detail information from posted G/L transactions. It can
also retrieve transaction optional fields and account optional field data for the account specified in the
transaction record.

Details can be consolidated or not consolidated. That is, if the result of FRPOST (or "FRACCT Function"
(page 100)) is derived from more than one transaction, and if the result is from an optional field of type
Integer, Number, or Amount, you can print a consolidated total that sums up all values from the retrieved
optional fields or print the value of the first retrieved record that has an optional field value.

 |f an optional field name is specified as is, or [C] is appended to the field name, a consolidated total
is printed.

 If [U]is appended to the specified optional field name, only the first optional field value is reported.

Syntax

The function can retrieve data from all G/L account fields and account optional fields defined for "FRACCT
Function" (page 100), It can also reference transaction optional fields defined in G/L Setup, and the
following G/L transaction fields:

Transaction Field Name Description
DEFCURNCOD Default currency code
FISCALYR Fiscal year

FISCALPERD Fiscal period

SRCECURN Source currency code
SRCELEDGER Source ledger code
SRCETYPE Source type code
POSTINGSEQ Posting sequence number
CNTDETAIL Detail count

JRNLDATE Journal date

BATCHNBR Batch number
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Transaction Field Name Description
ENTRYNBR Journal entry number
TRANSNBR Journal transaction number
CONSOLIDAT Consolidation occurred on post
JNLDTLDESC Journal detail description
JNLDTLREF Journal detail reference
TRANSAMT Journal transaction amount (functional amount)
TRANSQTY Journal transaction quantity
SCURNAMT Journal source currency amount
RATETYPE Currency Rate Table type
RATEDATE Date of currency rate selected
CONVRATE Currency rate for conversion
RATEOPER Currency rate operator
Arguments
Argument Description
field name The name of a field from the G/L account record, including account and transaction

optional fields.

Note:
« Account optional fields have an 2 . prefix

« Transaction optional fields have a prefix

account A string specifying a single account or a range of accounts. See "About Account
reference Number References" (page 54).
criteria An expression that imposes selection criteria on the accounts. The account

reference and expression together determine the accounts that will be included in
the calculation. See "About Selection Criteria for Filtering Accounts" (page 57).

Sage 300 2023 Financial Reporter User's Guide

135



Argument

Description

formatted Indicates whether the return value should be formatted according to the presentation
(Optional) defined in the view. If omitted, the default is "Formatted." Use one of the following

constructs:

 "FORMATTED", "F", or "FMT"
e "UNFORMATTED", "U", or "UNFMT"

Examples
Statement Return Value
=FRPOST Retrieves unformatted transaction amounts for Account 1000 that
("TRANSAMT", have a posting sequence number of 100.

"1000","(POSTINGSEQ
= 1 00)","U“)

=FRPOST
("TRANSAMT",
"1000","(JRNLDATE =
20100110)","U")

Retrieves the unformatted transaction amount from Account 1000
from January 10, 2010.

=FRPOST
("ACCTDESC","1000")

Retrieves the account description from Account 1000.

=FRPOST
("T.QTY","4000")

Retrieves the transaction optional value for QTY for Account 4000 for
the inquired period.

Note: Account numbers and transaction date are shown in the examples; however, this information
can be set in the report specification—the account number in column A, and other criteria, such as the
transaction date, in column B.
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FRRATE Function

This function returns the exchange rate, as a multiplier, for converting amounts from source to functional
currency. If the exchange rate is defined as a divisor, Sage 300 provides its reciprocal.

Syntax
Arguments
Argument Description
functional Functional (home) currency code
currency
source Source currency code
currency
rate type Rate type code
rate date If the period end date is not specified, Financial Reporter will use:
(Optional) » The period end date defined in the report specification
e The session date, if the report is not generated from a report specification
The date is specified as . Note that the spreadsheet
function returns the serial number of the date.
option This argument is only required for handling exchange rates for euro-member
(Optional) currencies that use the Euro Conversion Rates table, such as francs or schillings.

Use one of the following parameters to choose which part of the currency exchange
rate (from euro-member currency to non-euro-member currency) you want the function
to provide:

* RF returns the floating portion value of the exchange rate—the portion not fixed
between the euro and non-euro-member currencies. RF returns a "1" if the
currencies are euro-member, and the year is greater or equal to 1999.

* RC returns the composite exchange rate—the effective rate between a non-euro
currency and a euro-member currency. This is the default if no value is specified.
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Argument Description

Note:

will return the rate from the Euro Conversion Rates table.

» For non-euro currencies, RC will look up the rate in the Currency Rate table.

» If the source and functional currencies are both euro-member currencies, RC

« If the functional currency is the euro, and the source is not a euro-member
currency, RC will return the effective exchange rate between the two

currencies.
Examples
Some of the following example use the spreadsheet function . This function converts a
textual representation of a date (such as the date string returned by FRFISCA) to a serial number, which
FRRATE accepts.
Statement Return
Value
=FRRATE("USD","CAD","AV") .75
=FRRATE("USD","CAD","SP", .75
DATE(2009,10,31))
=FRRATE("USD","CAD","SP", .75
DATEVALUE(FRFISCAL("Start")))
=FRRATE("ATS","EUR","AV", DATEVALUE(FRFISCAL("Start")),"RC") 13.760300
=FRRATE("USD","ATS","AV", DATEVALUE(FRFISCAL("Start")),"RF") .88274
Note: This function returns the floating exchange component between the Austrian
schilling and the US dollar. In this case, this is the euro to US dollar exchange rate.
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FRSDESC Function

This function returns the account segment name from the General Ledger segment codes table, given a

segment number and code.

Syntax

Arguments

Argument

Description

segment number | G/L segment number, from 1to 10

segment code G/L segment code

Examples

In the following examples, segment 1 is the department segment. The third example shows how to use
the FR function to return the segment code for the current report.

Statement

Return Value

=FRSDESC(1,"USEAST")

Eastern United States

=FRSDESC(1,"SALES")

Sales Department

=FRSDESC(1,FR("CurAcSegVal1"))

Sales Department
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FRTRN Function

This function retrieves net amounts and net quantities from posted transactions for a specified period. It
retrieves actual values and summary totals (by both account and transaction fields), and allows drill down
to associated transactions.

FRTRN is similar to "FRAMT Function" (page 104), but FRTRN retrieves totals from transaction history,
whereas FRAMT retrieves totals from account history.

Note: This function cannot retrieve budget or provisional amounts, calculate balances, or include rollup
amounts or totals.

Syntax

Note: FRTRN returns 0 if no transactions are retrieved from transaction history.

Arguments
Argument Description
field name The name of a field from the General Ledger fiscal sets with an optional fiscal

designator prefix and optional fiscal year suffix (separated from the field name with a
period).

The fiscal designator prefix can be:

e A. Actual amount
* Q. Quantities

* QA. Actual quantities

Note: If no prefix is supplied, the default report setting is used (actual).

The fiscal year suffix can be:

* YYYY. A specific fiscal year, such as 2010

e Ln. nyears ago relative to the current fiscal year; for example, L1 is last year, and
L2 is 2 years ago

¢ Nn. nyears in the future relative to the current fiscal year; for example, N1 is next
year, and N2 is the year after next
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Argument Description

Note: If no suffix is supplied, the current fiscal year is used.

account A string specifying a single account or a range of accounts. See "About Account
reference Number References" (page 54).

criteria An expression that imposes selection criteria on the accounts and on transaction
(Optional) fields, including account and transaction optional fields. The account reference and
expression together determine the accounts and additional data that will be
included in the calculation. See "About Selection Criteria for Filtering Accounts" (page
57).

currency A string containing the currency reference. A currency reference has the form "CCC.T,"
(Optional) where CCCis a 3-character currency code (for example, CAD for Canadian dollars, or
USD for US dollars), and T is the currency type.

The currency type can be:

» S. Source currency
e E. Equivalent source amount in the functional currency

» F. Functional currency total (including functional equivalents of all source
amounts)

* R. Reporting currency total

« Ifthe currency code is functional, R includes reporting equivalents of all
source amounts.

« If the currency code is not functional, R provides equivalent amounts in the
reporting currency.

Note: If no currency is supplied, functional (home) currency is used.

Fiscal Set Field Names

Financial Reporter can retrieve the following net change fields.

Note: In the Reporter Code Suffix, nis a number that can refer to the fiscal period (from 1 to 13), or to
the quarter (from 1 to 4).
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Field Description | Reporter Code Suffix NET
(net
changes)
Current period P NETP
Last period LP NETLP
nth period nP NETnP
n periods ago nPA NETnPA
Period net change
Field Description Reporter Code Suffix NET
(net
changes)
Current quarter (to end) Q NETQ
Current quarter to date QTD NETQTD
Last quarter LQ NETLQ
Last quarter to date LQTD NETLQTD
nth quarter nQ NETnQ
nth quarter to date nQTD NETnQTD
n quarters ago nQA NETnQA
n quarters ago to date nQATD NETnQATD

NETP, NETnP, NET4Q, NETPQ will also include adjustments from period 14 if the net is
requested for the final period of the year. (NET works like BAL.)

This code allows you to compare the current QTD to the QTD of a previous quarter by providing
you with to-date figures relative to the current quarter. If you are now in period 2 of the current
quarter, QTD will give you the first 2 periods of any previous quarter.

nQATD lets you go up to four quarters ago. If you need to specify more, use nQATD.L1.
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Field Description Reporter Code Suffix NET
(net
changes)
Preceding quarter (3 periods) PQ NETPQ
Preceding quarter (n periods ago) | PQnPA NETPQnPA
Quarter net change
Field Description Reporter Code Suffix NET
(net
changes)
Current half year (to end) S NETS
Current half year to date STD NETSTD
Last half year LS NETLS
Last half year to date LSTD NETLSTD
nth half year nS NETnS
hth half year to date nSTD NETnSTD
n half years ago nSA NETnSA
n half years ago to date nSATD NETnSATD

PQ handles any three periods, providing you with revolving quarters. The preceding 3 periods
include the current period plus the two previous ones.

The NET for a group of periods that crosses a year-end boundary will also include the adjustments
in period 14, but not include the closing entry; otherwise, the net would include the zeroing entries in
income and expense accounts.

This code allows you to compare the current half year TD to the half year TD of a previous half
year by providing you with to-date figures relative to the current half year. If you are now in period 2
of the current half year, half year TD will give you the first 2 periods of any previous half year.

nSATD lets you go up to 2 half years ago. If you need to specify more, use nSATD.L1.
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Field Description Reporter Code Suffix NET
(net
changes)
Preceding half year (6 periods) PS NETPS
Preceding half year (n periods ago) | PSnPA NETPSnPA
Half year net change
Field Description Reporter Code Suffix NET
(net
changes)
Total year Y NETY
Year to date YTD NETYTD
Preceding year (12 or 13 periods) | PY NETPY
Preceding year (n periods ago) PYnPA NETPYnPA
Beginning of year OPEN
End of year CLOSE NETCLOSE
Period 14 adjustments ADJ NETADJ

Total year net change

PS handles any six periods, providing you with revolving half years. The preceding six periods
includes the current period plus the five previous ones.

NETCLOSE provides the closing entry only.

NETADJ provides the amount from period 14.

Sage 300 2023 Financial Reporter User's Guide 144



Note:
¢ You can print year-end adjustments and transactions to close income accounts to retained
earnings with NETADJ, and print closing figures with NETCLOSE and BALCLOSE.

» Allfiscal field set values are calculated relative to the fiscal period set for the report, with the
exception of NETADJ, and NETCLOSE, and fields that reference a specific time period.

« NETADJ is the amount posted to the adjustment period.
 NETCLOSE is the amount posted to the closing period.
 |fthere are no records for a future period, zero is returned.
* You can use a fiscal set prefix with NET to return specific values. For example:
e NETP provides the net amount for the current fiscal period.

« ANETP provides the actual net change for the current fiscal period.

Examples

Statement Return Value

=FRTRN("NETLQ","1000") | Net transactions for the last quarter for account 1000

=FRTRN("NET#P","1000") Net transactions for inquired period for account 1000

=FRTRN("NETQTD","1000") | Net transactions for the quarter to date for account 1000
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FRTRNA Function

This function retrieves net amounts and net quantities from posted transactions for the period that you
specify. It retrieves actual values and summary totals (by both account and transaction fields), and allows
drill down to associated transactions.

Like "FRAMTA Function" (page 111), it displays debit amounts as positive numbers and credit amounts as
negative numbers.

Note: FRTRNA does not calculate balances, and does not include provisionally posted transactions.

Syntax

Arguments

Argument

Description

field name

The name of a field from the General Ledger fiscal sets with an optional fiscal
designator prefix and optional fiscal year suffix (separated from the field name with a
period).

The fiscal designator prefix can be:

¢ A. Actual amount
* Q. Quantities

* QA. Actual quantities

Note: If no prefix is supplied, the default report setting is used (actual).

The fiscal year suffix can be:

* YYYY. A specific fiscal year, such as 2010

e Ln. nyears ago relative to the current fiscal year; for example, L1 is last year, and
L2 is 2 years ago

* Nn. nyears in the future relative to the current fiscal year; for example, N1 is next
year, and N2 is the year after next

Note: If no suffix is supplied, the current fiscal year is used.

account

A string specifying a single account or a range of accounts. See "About Account
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Argument Description

reference Number References" (page 54).

criteria An expression that imposes selection criteria on the accounts and on transaction
(Optional) fields, including account and transaction optional fields. The account reference and
expression together determine the accounts and additional data that will be

included in the calculation. See "About Selection Criteria for Filtering Accounts" (page
57).

currency A string containing the currency reference. A currency reference has the form "CCC.T,"
(Optional) where CCC s a 3-character currency code (for example, CAD for Canadian dollars, or
USD for US dollars), and T is the currency type.

The currency type can be:
» S. Source currency

¢ E. Equivalent source amount in the functional currency

e F. Functional currency total (including functional equivalents of all source
amounts)

* R. Reporting currency total

« Ifthe currency code is functional, R includes reporting equivalents of all
source amounts.

« If the currency code is not functional, R provides equivalent amounts in the
reporting currency.

Note: If no currency is supplied, functional (home) currency is used.

Fiscal Set Field Names

Financial Reporter can retrieve the following net change fields.

Note: In the Reporter Code Suffix, nis a number that can refer to the fiscal period (from 1 to 13), or to
the quarter (from 1 to 4).
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Field Description | Reporter Code Suffix NET
(net
changes)
Current period P NETP
Last period LP NETLP
nth period nP NETnP
n periods ago nPA NETnPA
Period net change
Field Description Reporter Code Suffix NET
(net
changes)
Current quarter (to end) Q NETQ
Current quarter to date QTD NETQTD
Last quarter LQ NETLQ
Last quarter to date LQTD NETLQTD
nth quarter nQ NETnQ
nth quarter to date nQTD NETnQTD
n quarters ago nQA NETnQA
n quarters ago to date nQATD NETnQATD

NETP, NETnP, NET4Q, NETPQ will also include adjustments from period 14 if the net is
requested for the final period of the year. (NET works like BAL.)

This code allows you to compare the current QTD to the QTD of a previous quarter by providing
you with to-date figures relative to the current quarter. If you are now in period 2 of the current
quarter, QTD will give you the first 2 periods of any previous quarter.

nQATD lets you go up to four quarters ago. If you need to specify more, use nQATD.L1.
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Field Description Reporter Code Suffix NET
(net
changes)
Preceding quarter (3 periods) PQ NETPQ
Preceding quarter (n periods ago) | PQnPA NETPQnPA
Quarter net change
Field Description Reporter Code Suffix NET
(net
changes)
Current half year (to end) S NETS
Current half year to date STD NETSTD
Last half year LS NETLS
Last half year to date LSTD NETLSTD
nth half year nS NETnS
hth half year to date nSTD NETnSTD
n half years ago nSA NETnSA
n half years ago to date nSATD NETnSATD

PQ handles any three periods, providing you with revolving quarters. The preceding 3 periods
include the current period plus the two previous ones.

The NET for a group of periods that crosses a year-end boundary will also include the adjustments
in period 14, but not include the closing entry; otherwise, the net would include the zeroing entries in
income and expense accounts.

This code allows you to compare the current half year TD to the half year TD of a previous half
year by providing you with to-date figures relative to the current half year. If you are now in period 2
of the current half year, half year TD will give you the first 2 periods of any previous half year.

nSATD lets you go up to 2 half years ago. If you need to specify more, use nSATD.L1.
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Field Description Reporter Code Suffix NET
(net
changes)
Preceding half year (6 periods) PS NETPS
Preceding half year (n periods ago) | PSnPA NETPSnPA
Half year net change
Field Description Reporter Code Suffix NET
(net
changes)
Total year Y NETY
Year to date YTD NETYTD
Preceding year (12 or 13 periods) | PY NETPY
Preceding year (n periods ago) PYnPA NETPYnPA
Beginning of year OPEN
End of year CLOSE NETCLOSE
Period 14 adjustments ADJ NETADJ

Total year net change

PS handles any six periods, providing you with revolving half years. The preceding six periods
includes the current period plus the five previous ones.

NETCLOSE provides the closing entry only.

NETADJ provides the amount from period 14.
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Note:
¢ You can print year-end adjustments and transactions to close income accounts to retained
earnings with NETADJ, and print closing figures with NETCLOSE and BALCLOSE.

» Allfiscal field set values are calculated relative to the fiscal period set for the report, with the
exception of NETADJ, and NETCLOSE, and fields that reference a specific time period.

« NETADJ is the amount posted to the adjustment period.
 NETCLOSE is the amount posted to the closing period.
 |fthere are no records for a future period, zero is returned.
* You can use a fiscal set prefix with NET to return specific values. For example:
e NETP provides the net amount for the current fiscal period.

« ANETP provides the actual net change for the current fiscal period.
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FRTRNCR Function

This function is similar to "FRCREDIT Function" (page 118), and retrieves net totals (credit amounts only)
from transactions. It retrieves actual values and summary totals (by both account and transaction fields),

and allows drill down to associated transactions.

Note: This function cannot retrieve budget or provisional amounts, calculate balances, or include rollup
amounts or totals.

Syntax

Tip: Use the criteria argument to restrict this function to credit (CR) transactions.

Arguments

Argument

Description

field name

The name of a field from the General Ledger fiscal sets with an optional fiscal
designator prefix and optional fiscal year suffix (separated from the field name with a
period).

The fiscal designator prefix can be:

e A. Actual amount
¢ Q. Quantities

* QA. Actual quantities

Note: If no prefix is supplied, the default report setting is used (actual).

The fiscal year suffix can be:

* YYYY. A specific fiscal year, such as 2010

e Ln. nyears ago relative to the current fiscal year; for example, L1 is last year, and
L2 is 2 years ago

* Nn. nyears in the future relative to the current fiscal year; for example, N1 is next
year, and N2 is the year after next

Note: If no suffix is supplied, the current fiscal year is used.

account

A string specifying a single account or a range of accounts. See "About Account
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Argument Description

reference Number References" (page 54).

criteria An expression that imposes selection criteria on the accounts and on transaction
(Optional) fields, including account and transaction optional fields. The account reference and
expression together determine the accounts and additional data that will be

included in the calculation. See "About Selection Criteria for Filtering Accounts" (page
57).

currency A string containing the currency reference. A currency reference has the form "CCC.T,"
(Optional) where CCC s a 3-character currency code (for example, CAD for Canadian dollars, or
USD for US dollars), and T is the currency type.

The currency type can be:
» S. Source currency

¢ E. Equivalent source amount in the functional currency

e F. Functional currency total (including functional equivalents of all source
amounts)

* R. Reporting currency total

« Ifthe currency code is functional, R includes reporting equivalents of all
source amounts.

« If the currency code is not functional, R provides equivalent amounts in the
reporting currency.

Note: If no currency is supplied, functional (home) currency is used.

Fiscal Set Field Names

Financial Reporter can retrieve the following net change fields.

Note: In the Reporter Code Suffix, nis a number that can refer to the fiscal period (from 1 to 13), or to
the quarter (from 1 to 4).
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Field Description | Reporter Code Suffix NET
(net
changes)
Current period P NETP
Last period LP NETLP
nth period nP NETnP
n periods ago nPA NETnPA
Period net change
Field Description Reporter Code Suffix NET
(net
changes)
Current quarter (to end) Q NETQ
Current quarter to date QTD NETQTD
Last quarter LQ NETLQ
Last quarter to date LQTD NETLQTD
nth quarter nQ NETnQ
nth quarter to date nQTD NETnQTD
n quarters ago nQA NETnQA
n quarters ago to date nQATD NETnQATD

NETP, NETnP, NET4Q, NETPQ will also include adjustments from period 14 if the net is
requested for the final period of the year. (NET works like BAL.)

This code allows you to compare the current QTD to the QTD of a previous quarter by providing
you with to-date figures relative to the current quarter. If you are now in period 2 of the current
quarter, QTD will give you the first 2 periods of any previous quarter.

nQATD lets you go up to four quarters ago. If you need to specify more, use nQATD.L1.
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Field Description Reporter Code Suffix NET
(net
changes)
Preceding quarter (3 periods) PQ NETPQ
Preceding quarter (n periods ago) | PQnPA NETPQnPA
Quarter net change
Field Description Reporter Code Suffix NET
(net
changes)
Current half year (to end) S NETS
Current half year to date STD NETSTD
Last half year LS NETLS
Last half year to date LSTD NETLSTD
nth half year nS NETnS
hth half year to date nSTD NETnSTD
n half years ago nSA NETnSA
n half years ago to date nSATD NETnSATD

PQ handles any three periods, providing you with revolving quarters. The preceding 3 periods
include the current period plus the two previous ones.

The NET for a group of periods that crosses a year-end boundary will also include the adjustments
in period 14, but not include the closing entry; otherwise, the net would include the zeroing entries in
income and expense accounts.

This code allows you to compare the current half year TD to the half year TD of a previous half
year by providing you with to-date figures relative to the current half year. If you are now in period 2
of the current half year, half year TD will give you the first 2 periods of any previous half year.

nSATD lets you go up to 2 half years ago. If you need to specify more, use nSATD.L1.
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Field Description Reporter Code Suffix NET
(net
changes)
Preceding half year (6 periods) PS NETPS
Preceding half year (n periods ago) | PSnPA NETPSnPA
Half year net change
Field Description Reporter Code Suffix NET
(net
changes)
Total year Y NETY
Year to date YTD NETYTD
Preceding year (12 or 13 periods) | PY NETPY
Preceding year (n periods ago) PYnPA NETPYnPA
Beginning of year OPEN
End of year CLOSE NETCLOSE
Period 14 adjustments ADJ NETADJ

Total year net change

PS handles any six periods, providing you with revolving half years. The preceding six periods
includes the current period plus the five previous ones.

NETCLOSE provides the closing entry only.

NETADJ provides the amount from period 14.
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Note:
¢ You can print year-end adjustments and transactions to close income accounts to retained
earnings with NETADJ, and print closing figures with NETCLOSE and BALCLOSE.

» Allfiscal field set values are calculated relative to the fiscal period set for the report, with the
exception of NETADJ, and NETCLOSE, and fields that reference a specific time period.

« NETADJ is the amount posted to the adjustment period.
 NETCLOSE is the amount posted to the closing period.
 |fthere are no records for a future period, zero is returned.
* You can use a fiscal set prefix with NET to return specific values. For example:
e NETP provides the net amount for the current fiscal period.

« ANETP provides the actual net change for the current fiscal period.
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FRTRNDR Function

This function is similar to "FRDEBIT Function" (page 125), and retrieves net totals (debit amounts only)
from transactions. It retrieves actual values and summary totals (by both account and transaction fields),
and allows drill down to associated transactions.

Note: This function cannot retrieve budget or provisional amounts, calculate balances, or include rollup
amounts or totals.

Syntax

Tip: Use the criteria argument to restrict this function to debit (DR) transactions.

Arguments

Argument Description

field name The name of a field from the General Ledger fiscal sets with an optional fiscal
designator prefix and optional fiscal year suffix (separated from the field name with a
period).

The fiscal designator prefix can be:

e A. Actual amount
¢ Q. Quantities

* QA. Actual quantities

Note: If no prefix is supplied, the default report setting is used (actual).

The fiscal year suffix can be:

* YYYY. A specific fiscal year, such as 2010

e Ln. nyears ago relative to the current fiscal year; for example, L1 is last year, and
L2 is 2 years ago

* Nn. nyears in the future relative to the current fiscal year; for example, N1 is next
year, and N2 is the year after next

Note: If no suffix is supplied, the current fiscal year is used.

account A string specifying a single account or a range of accounts. See "About Account
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Argument Description

reference Number References" (page 54).

criteria An expression that imposes selection criteria on the accounts and on transaction
(Optional) fields, including account and transaction optional fields. The account reference and
expression together determine the accounts and additional data that will be

included in the calculation. See "About Selection Criteria for Filtering Accounts" (page
57).

currency A string containing the currency reference. A currency reference has the form "CCC.T,"
(Optional) where CCC s a 3-character currency code (for example, CAD for Canadian dollars, or
USD for US dollars), and T is the currency type.

The currency type can be:
» S. Source currency

¢ E. Equivalent source amount in the functional currency

e F. Functional currency total (including functional equivalents of all source
amounts)

* R. Reporting currency total

« Ifthe currency code is functional, R includes reporting equivalents of all
source amounts.

« If the currency code is not functional, R provides equivalent amounts in the
reporting currency.

Note: If no currency is supplied, functional (home) currency is used.

Fiscal Set Field Names

Financial Reporter can retrieve the following net change fields.

Note: In the Reporter Code Suffix, nis a number that can refer to the fiscal period (from 1 to 13), or to
the quarter (from 1 to 4).
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Field Description | Reporter Code Suffix NET
(net
changes)
Current period P NETP
Last period LP NETLP
nth period nP NETnP
n periods ago nPA NETnPA
Period net change
Field Description Reporter Code Suffix NET
(net
changes)
Current quarter (to end) Q NETQ
Current quarter to date QTD NETQTD
Last quarter LQ NETLQ
Last quarter to date LQTD NETLQTD
nth quarter nQ NETnQ
nth quarter to date nQTD NETnQTD
n quarters ago nQA NETnQA
n quarters ago to date nQATD NETnQATD

NETP, NETnP, NET4Q, NETPQ will also include adjustments from period 14 if the net is
requested for the final period of the year. (NET works like BAL.)

This code allows you to compare the current QTD to the QTD of a previous quarter by providing
you with to-date figures relative to the current quarter. If you are now in period 2 of the current
quarter, QTD will give you the first 2 periods of any previous quarter.

nQATD lets you go up to four quarters ago. If you need to specify more, use nQATD.L1.
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Field Description Reporter Code Suffix NET
(net
changes)
Preceding quarter (3 periods) PQ NETPQ
Preceding quarter (n periods ago) | PQnPA NETPQnPA
Quarter net change
Field Description Reporter Code Suffix NET
(net
changes)
Current half year (to end) S NETS
Current half year to date STD NETSTD
Last half year LS NETLS
Last half year to date LSTD NETLSTD
nth half year nS NETnS
hth half year to date nSTD NETnSTD
n half years ago nSA NETnSA
n half years ago to date nSATD NETnSATD

PQ handles any three periods, providing you with revolving quarters. The preceding 3 periods
include the current period plus the two previous ones.

The NET for a group of periods that crosses a year-end boundary will also include the adjustments
in period 14, but not include the closing entry; otherwise, the net would include the zeroing entries in
income and expense accounts.

This code allows you to compare the current half year TD to the half year TD of a previous half
year by providing you with to-date figures relative to the current half year. If you are now in period 2
of the current half year, half year TD will give you the first 2 periods of any previous half year.

nSATD lets you go up to 2 half years ago. If you need to specify more, use nSATD.L1.
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Field Description Reporter Code Suffix NET
(net
changes)
Preceding half year (6 periods) PS NETPS
Preceding half year (n periods ago) | PSnPA NETPSnPA
Half year net change
Field Description Reporter Code Suffix NET
(net
changes)
Total year Y NETY
Year to date YTD NETYTD
Preceding year (12 or 13 periods) | PY NETPY
Preceding year (n periods ago) PYnPA NETPYnPA
Beginning of year OPEN
End of year CLOSE NETCLOSE
Period 14 adjustments ADJ NETADJ

Total year net change

PS handles any six periods, providing you with revolving half years. The preceding six periods
includes the current period plus the five previous ones.

NETCLOSE provides the closing entry only.

NETADJ provides the amount from period 14.
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Note:
¢ You can print year-end adjustments and transactions to close income accounts to retained
earnings with NETADJ, and print closing figures with NETCLOSE and BALCLOSE.

» Allfiscal field set values are calculated relative to the fiscal period set for the report, with the
exception of NETADJ, and NETCLOSE, and fields that reference a specific time period.

« NETADJ is the amount posted to the adjustment period.
 NETCLOSE is the amount posted to the closing period.
 |fthere are no records for a future period, zero is returned.
* You can use a fiscal set prefix with NET to return specific values. For example:
e NETP provides the net amount for the current fiscal period.

« ANETP provides the actual net change for the current fiscal period.
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Appendix E: FR Field Reference

Use selection criteria expressions with account master fields and account optional fields (defined in G/L
Setup), and with transaction fields and transaction optional fields (defined using FRPOST).

Account Master Fields

You can use a selection criteria expression with any of the fields in the general ledger account master
(listed below).

Many values can be expressed in more than one way. For example, the quantity switch can be 1 or "Yes"
if the account keeps quantities, or 0 or "No" if it does not. A criteria expression for this field can look like
either of the following:

FR Paste always supplies the text value of G/L account master fields ("Yes" in the above example). If you
want to see the non-text values and the text values of these fields, see the Object Information for the
GLACCOUNT view in the Macro Editor.

Note: If a field's value is text, you must enclose field values in quotation marks. If the text contains a
space, it is best to enclose values in a second set of quotation marks:

To retrieve account optional fields, add the prefix before a field name (for example, ). Be
sure to include the period after the prefix.

The following table shows G/L account data field names:

Name Field Contents

ACCTID Account number, including all segments.

CREATEDATE Date the account was created. Dates are specified as
"yyyymmdd".

ACCTDESC Account description.
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Name Field Contents

ACCTTYPE Account type |, B or R for income statement, balance
sheet, or retained earnings account.

ACCTBAL 1 for normal debit; 2 for normal credit.

ACTIVESW "ACTIVE" or "INACTIVE".

CONSLDSW "Do not consolidate journals" or 0 if transactions are
not consolidated; "Consolidate journals" or 1 if
transactions are consolidated on posting

QTYSW "Yes" or 1 if quantities are used with account; "No" or 0
if not.

UOM The unit of measure if quantities are used.

ALLOCSW If account can be reallocated: "Yes" or 1 is yes; "No" or
Ois no.

ACCTOFSET Account number for reallocation.

ACCTSRTV Allocation transaction source code.

MCSW Multicurrency switch: "Yes" or 1 is yes; "No" or 0 is no.

SPECSW If posting is in all or specific source currencies. "All
currency" or 1 is all; "Specific curency" or O is
specified.

ACCTGRPCOD Account group code.

CTRLACCTSW If account is a control account. "Control account” or 1
is yes; "Non control account" or 0 is no.

SRCELDGID Source ledger if control account (e.g. AR, AP).
(Reserved field)

ALLOCTOT Total of different allocation rates (100).

ABRKID Account structure code.

YRACCTCLOS Year of the last close.

POSTOSEGID The account segment by which the account is closed.
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Name Field Contents

DEFCURNCOD Default currency code for the account.

ACCTFMTTD Formatted account number.

ACSEGVALnN Account segment value 01 to 10.

ACCTSEGVAL Account Segment Code

ACCTGRPCPY Account group COPY. A copy of the group code that is
a string instead of an integer.

ROLLUPSW Rollup switch. If unformatted, 1 if account is a rollup
account, 0 if not. If formatted, "Yes" or "No".

Transaction Fields

Transaction fields include account master fields and account optional fields defined in G/L Setup, and the
following transaction fields and transaction optional fields defined in FRPOST.

To retrieve account optional fields, add the prefix before a field name (for example, ). To
retrieve transaction optional fields, add the prefix before the field name (for example, ). Be

sure to include the period after these prefixes.

For more information, see "Account Master Fields" (page 164) and "FRPOST Function" (page 134).

Name Contents of the Field
FISCALYR Fiscal Year
FISCALPERD Fiscal Period
SRCECURN Source Currency Code

SRCELEDGER Source Ledger Code

SRCETYPE Source Type

POSTINGSEQ Posting Sequence Number

CNTDETAIL Detail Count

JRNLDATE Journal Date
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Name

Contents of the Field

BATCHNBR Batch Number

ENTRYNBR Journal Entry Number
TRANSNBR Journal Transaction Number
CONSOLIDAT Consolidation in Posting
JUNLDTLDESC Journal Detail Description
JNLDTLREF Journal Detail Reference
TRANSAMT Journal Transaction Amount
TRANSQTY Journal Transaction Quantity
SCURNAMT Journal Source Amount
RPTAMT Journal Reporting Amount
RATETYPE Date of Currency Rate Selected
RATEDATE Date of Currency Rate
CONVRATE Currency Rate for Conversion
RATEOPER Currency Rate Operator
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Appendix F: FAQ and Troubleshooting

How Do I...

Create an FR report with drilldown that doesn't show the FR code

If multiple users are viewing financial reports, and the report specifications are not to be edited, you use
the G/L Print Financial Statements screen to print the report, and select the DrillDown Information option
on that screen to include drilldown information in the report.

Enlarge the Spec range

In some reports, you might find that information is cut off the report because it extends beyond the right
edge of the spreadsheet print area. You can correct this by adjusting column width, or by redefining the
Spec range.

For more information about working with Spec ranges, see "About the Spec Range" (page 65).

Exclude accounts from a range in FR

You can specify selection criteria on a default specification line, on individual specification lines, and in
formulas.

With all these possibilities for account selection, you must be very clear which criteria are actually in
effect.

For more information about the rules that apply when specifying criteria, see "About Generating Reports
from Specifications" (page 26) and "About Selection Criteria for Filtering Accounts" (page 57).

Generate reports from specifications

For information about generating financial statements, see "About Generating Reports from Specifications"
(page 26).
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Turn off comments when Drilldown is selected

If you select the Drilldown Information option when generating a report, every cell with drilldown displays
a comment "Right-click and choose FR..." If the spreadsheet has many columns, this can fill the
spreadsheet.

To collapse comments so that only a content indicator appears:

1. Click File > Options.

2. Inthe Excel Options window, click the Advanced tab.

3. Inthe Display group, select the Indicators only, and comments on hover option.
4. Click OK.

Print recurring column headings at the top of each page when the report has
multiple pages
When a report has multiple pages, you can use title lines to print recurring column headings at the top of

each page. For more information, see "Printing a Financial Statement" (page 71).

Set grid lines and tab breaks

You set all formatting for financial reports using the formatting commands in the Financial Statement
Designer. For more information, see "About Formatting Financial Statements" (page 62).

Set the Spec range

Before you can generate and print a financial report from a report specification, you must define the Spec
range, which is a named range of cells in the spreadsheet. For more information, see "About the Spec
Range" (page 65) and "Setting the Spec Range" (page 67).

Troubleshooting
I'm getting error messages

For a list of Financial error messages and descriptions, see "Financial Reporter Error Messages" (page
171).
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Nothing happens when | click OK on the Financial Statement Generator

If nothing happens when you run FR View, check whether you have defined a spec range. For more
information, see "About the Spec Range" (page 65) and "Setting the Spec Range" (page 67).

| can't view some account descriptions in financial reports

If some account descriptions are not appearing in financial reports, check to see if the individual account
descriptions have any common description for accounts that are being consolidated in the report. To
include these account descriptions in a printed report, you may need to edit the descriptions.

Example:
Account number 6200-100 and 6200-200 are being consolidated into account 6200.

If the descriptions are as follows:

* 6200: "office expense total"
» 6200-100: "office expense Richmond"

* 6200-200: "office expense Toronto"

... the description on the printed financial report will be "office expense", which is the common name for
all three accounts.

If account 6200 used the description "miscellaneous account" instead, the description would be blank
in the financial report (there are no common elements in the three descriptions).

The report date appears in short date format even when Excel cell format is
set to long date

If you have changed cell format in Excel to display long date formats, but Financial Reporter still displays
dates in short format, you can use the following Excel DATEVALUE formula to change the fomat:

The bottom of the report is missing when printed

If some data is missing from the bottom of a report when printing, you may need to change the size of the
report as follows:
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1. On the Formulas tab of the Excel ribbon, click Define Name.
2. Inthe Name field, select Spec.

3. Inthe Refers to field, type

4. Click OK.

For more information, see "About the Spec Range" (page 65) and "Setting the Spec Range" (page 67).

Financial Reporter Error Messages

Financial Reporter error messages fall into two general categories:

» Error messages printed on financial statements. These messages report problems in formulas
and report specifications, such as an account reference with too many account code segments. If
Financial Reporter encounters a problem when generating a financial statement, itinserts a
message in the report, and then continues to generate (and print) the rest of the statement.

» Error messages displayed by Financial Reporter. These messages appear when you attempt to
open Financial Reporter screens, or when report generation is canceled, and may appear under
the following conditions:

 If Sage 300 cannot start Microsoft Excel.
« If the computer runs out of memory (RAM).

« If Financial Reporter cannot continue to generate the report. (For example, this may happen
if the text or formula in a specification cell is too long.)

The following tables describe these error messages and possible solutions.

Error Messages Printed on Financial Statements

Message Description
"Invalid account reference in cell. The account reference you entered in column A is
<cell location L> : <cell value V>" incorrect because it does not match the requirements for

column A cells.

"Invalid selection criteria in cell. You entered an incorrect selection criteria in this cell.
<cell location L> : <cell value V>" Follow the criteria in column B to refine the account
selection (for example, a filter that restricts the range of
accounts to a particular account group, account type, or
account name).

"Invalid zero-suppression formula in cell. You entered an incorrect definition for a zero-

Sage 300 2023 Financial Reporter User's Guide

171



Message

Description

<cell location L> : <cell value V>"

suppression formula in this cell. Follow the criteria in
column C to determine which lines are to be excluded.

"Invalid detail level in cell.
<cell location L> : <cell value V>"

You entered an incorrect consolidation switch in this cell.
Follow the criteria in column D for consolidating account
ranges.

"Invalid formula or expression in cell.
<cell location L> : <cell value V>"

This is a general message indicating that a formula or
expression at the stated cell location cannot be
interrupted by FR in generation.

Invalid specification line type in cell.
<cell location L> : <cell value V>

Invalid spec line definition at cell location L with value V
(not a comment line, or valid default line, or body line).

"FR cannot further generate any line for
the worksheet."

Generated lines are almost over spreadsheet limit.
Report generation has been stopped.

"Invalid consolidation of posted
transactions on specification in row <Row
R>. Consolidated details cannot be
generated using the combination of detail
level and sorting order."

The specified consolidation method for posted
transactions on the spec lines in row R must match with
a specific sorting order.

Error Messages Printed on Financial Statements

For more information, see "About Columns in Report Specifications" (page 35).

Error Messages when Starting G/L Statement Designer or Running Print

Financial Statements

Message

Description

"Error in creating Excel object."

Make sure Microsoft Excel is installed.

"Page Break Preview is not available in Print
Financial Statements (GL9100). Please go to
Statement Designer (GL9200) to use this function."

The Print Financial Statements feature does
not support Page Break Preview. Use the
G/L Statement Designer instead.

"There are no printers installed. One is required when

print destination is Printer or Preview."

You must install a printer before you can view
output or choose a print destination.
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Message Description

"FileSystemObject object model cannot be initiated.
Please make sure that Scripting type library is
properly installed in Windows System."

Cannot find Microsoft Scripting Runtime
Object - required when starting FR.

Error Messages when Starting G/L Statement Designer or Running Print Financial Statements

Error Messages when Starting Financial Reporter

Message Description
"cmdStart: If you receive error messages that are in this format, you may need to reinstall
<error Microsoft Excel, or General Ledger, or System Manager. After reinstalling, restart
message>" the system, and then check to see if the problem has been resolved.
If the problem cannot be resolved by reinstalling these programs, contact your
system administrator.
Tip: Before reinstalling Microsoft Excel, confirm that Microsoft Office is installed
correctly. From the Programs and Features screen of Windows' Control Panel,
right-click Microsoft Office, and then click Change. Select the option to add or
remove features, and then confirm that Visual Basic for Applications is installed
as part of Office Shared Features.
"Initializing FR Failure to start Statement Designer.

Error (< error
id>J): Failure in
starting
Statement
Designer."

"Initializing FR
Error (<error
id>): Failure in
starting Print
Financial
Statements."

Failure to start Print Financial Statements.

"Internal error,"
"Insufficient
memory," or
"System error."

Write down the message, exit applications and Windows, restart your computer,
and then try the task again.
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Message Description

"Incorrect Most error messages pertaining to incorrect procedures arise when other tasks
procedure." have locked the system or company database. Wait for the other task to complete,
and then try again.

Error Messages when Starting Financial Reporter

Sage 300 2023 Financial Reporter User's Guide 174



Index

- (in statements) 54

%

% (in statements) 54

%% (in statements) 54

\ (in statements) 41

\\ (in statements) 41, 44,47

_ (in statements) 54

| (in statements) 47, 54

~ (in statements) 47, 54

A

A (column in statements) 36, 63

Sage 300 2023 Financial Reporter User's Guide

account consolidation in statements 50
account data
verifying 34
account master fields 164
account numbers in formulas 54, 56
account optional fields
printing on FR reports 35
account ordering in statements 47, 54-56, 60

account processing in statements 47, 54-56,
60

account ranges
in statements 47, 54, 60
overriding 27

account references
examples 91
symbols 91
syntax 91

account segment description in
statements 139

account selection in statements 57-58
account sorted group 54

account structures 55-56, 60
ACSEGVALnN 47

adding rows to a financial report 17

amounts in statements 125



B multiple statements 68

optional field amounts 35
B (column in statements) 36 i )
transaction details 36-37, 134
balance sheets . ) .
creating two-column financial reports 15
about rounding on 31
currency exchange rates 41

balances in statements 104, 111, 118, 125
custom fields See optional fields

c D

C (column in statements) 36 i
D (column in statements) 36, 50

calculations in statements 40 )
dates in statements 132

cell formulas in statements 41, 46
default column specifications 41, 44

column A in statements 36, 38, 63
default lines

column B in statements 36 o
overriding 27

column C in statements 36-37 )
design of statements 24

column D in statements 36, 50

drilldown 29
column specifications in statements 35, 40-
41
column A 36 E
column B 36 error messages 171
column C 36 Excel
columnD 36 and the Statement Designer 3
column E 38 printing statements 3, 28
default information for 43 setting up 28
sample defaults 44 exchange rates in statements 137
column totals in statements 30 expression syntax
columns, hiding on statements 63 brackets 59
comments in statements 63 LIKE 60
consolidating on FR reports optional fields 60
account ranges 50 quotation marks 59
account segments 37 spaces 59
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fields, retrieved in statements 104
G/L account masters 164
filtering accounts in statements 57-58

financial analysis reports 79, See
also financial statements

financial report specification
tutorial on creating 14

Financial Reporter
overview 3, 28
troubleshooting 168
tutorial 7

Financial Reporter functions See FR
Functions

Financial Reporter menu commands 85
FR Clear 85
FR Drilldown 85
FR Help 85
FR Options 85
FR Paste 86, 90
FR View 86
Financial Reporter screens
Print Financial Statements 73
Statement Designer 28
Financial Reporter spreadsheet
Excel 7
financial statements
accounts in 47, 54

columnsin 35
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consolidating 50, 68
formatting 62, 64
how to produce 7, 26
launching from Sage 300 7
printing 71, 74
selection criteria for 57, 60
Specrange 67
specifications for 24
Statement Designer 28
title lines 62
Fiscal Designator 89
fiscal period dates in statements 132
fiscal set field names in statements 104
footers in statements 64
forecasting 84
formatting financial statements
grid lines 63
page layout 64
formulas in statements
about using 54
overview 8, 11
FR Clear menu command 85
FR Drilldown menu command 85-86
FR error messages 171
FR functions 46, 54-56, 60, 94
criteria 58
FR 96
FRACCT 100
FRAMT 104
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FRAMTA 111
compared with FRAMT 104

FRCREDIT 118
FRDEBIT 125
FRFISCAL 132
FRPOST 134
FRRATE 137
FRSDESC 139
FRTRN 140
FRTRNA 146
FRTRNCR 152
FRTRNDR 158
overview 94
text parameters 59
FR Help menu command 85
FR Options menu command 85
FR Paste menu command 86, 88-89
rolled up amounts 88
using 90
FR View menu command 29, 73, 86
Frequently Asked Questions 168

functions (in FR statements) See FR

hiding rows and columns 63

Income Statement summaries 81
invalid account reference in cell 171
invalid detail level in cell 172

invalid formula or expression in cell 172
invalid selection criteria in cell 171
invalid specification line type in cell 172

invalid zero-suppression formula in cell 171

L

line criteria, overriding in statements 26

long date formats 170

N

net amounts in statements 104, 111, 118,
125

O

Functions
G
grid lines 63
H

headers in statements 64
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optional fields
printing on FR reports 35
retrieving for FR reports 35
ordering in statements 47, 54-56, 60
overriding account ranges 27
overriding default lines 27

overriding line criteria 27
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page layout in statements 64
headers and footers 64
page breaks 64
page numbers 65
pasting functions 90
period dates in statements 132
print destinations
for Financial Reporter statements 73
Print Financial Statements screen 73
using 71
printing

consolidating optional field amounts on
FR reports 35

optional field values on FR reports 35
ranges in statements 26, 67
statements 29, 71,73

processing order in statements 47, 54-56, 60

R

formatting 62, 64

functions used in 90, 94, 96, 100, 104,
111, 118, 125, 132, 137, 139

sample 35, 44

selection criteria used in 57

tutorial on creating 7, 14
reports See also financial statements

printing financial statements 73, 79
retrieving detail optional fields 134
retrieving net amounts and quantities 146
rounding on balance sheets 31
rows

adding to a financial report 17

hiding 63

S

ranges in statements 47, 54-56, 60
report columns 35
report generation 26
report range in statements 26, 67
report specifications 3
account information 47, 50, 54, 60
columns and rows 35, 63

designing 24, 26, 28, 46, 67
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sample report specification 35
segment description in statements 47, 139
selecting accounts in statements 57-58
selection criteria expression 58
sort by account group 54
sorting 47, 54-56, 60
sorting order 37
spec range 67

in statements 26, 67

setting 67
specification files

definition 7

specifying account numbers in
statements 54-56, 60
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standard account references 91
statement columns

column A 36

column B 36

column C 36

columnD 36

columnE 38
statement footers 64
statement headers 64
statements 4, 28, 79

financial 79
structure 55-56, 60
subtotals in statements 30
suppressing zero values 58

syntax for account selection criteria 58

T

testing information in statements 34
text parameters 59
title lines in financial statements 62
totals in statements 30
transaction details
consolidating by 37
transaction fields 166
transaction optional Fields
printing on FR reports 35

troubleshooting Financial Reporter 168

U

Use Budget Opening Balance 85
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Use Quantity Opening Balance 85

\Y

verifying account data 34

W

what-if analyses 84

y4

Z in statements 58
zero suppression in statements 41, 58

usingZand N 41
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